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Po co ta ksigzka zostata napisana?

Bo zawsze chciatem stworzy¢ model samolotu w komputerze. A gdy juz to zrobitem — stwierdzitem, ze to dobra
zabawa, i ze warto tym doswiadczeniem podzieli¢ sie z innymi.

Dawno temu bytem zwyktym modelarzem i robitem redukcyjne modele samolotéw. To hobby dos¢ specyficzne.
Sleczymy miesigcami nad naszym dzietem, starajgc sie nanie$¢ na kawatek materiatu malenkie nity, ztgcza
blach, czy drobne detale tablic przyrzadéw. Sadze, ze postronnym obserwatorom zajecia wedkarzy wydadza w
poréwnaniu z modelarzami mniej meczace, cho¢ podobnie monotonne. W dodatku, zamiast tworzy¢ tadne,
btyszczace miniaturki, nanosimy na ich powierzchnie (o zgrozo!) zabrudzenia i przetarcia, jakie powstawaty
podczas intensywnego uzywania. Szpecimy je, aby wygladaty jak rzeczywiste, zuzyte i gdzieniegdzie pordze-
wiate maszyny. Calg naszg nagrodg jest pokazanie naszych dziet komus, kto potrafi doceni¢ ich finezje. Zdarza
sie to raz na jakis czas. Méwigc szczerze, dziwnym trafem sg to zazwyczaj inni modelarze. A moze ukrytg na-
grodg jest mozliwos¢ nawigzania dyskusji na tak ezoteryczne tematy, jak wyzszos¢ Spitfire’a IX nad FW 190
A47? Albo palagca kwestia, jak byt pomalowany P-40, na ktérym Witold Urbanowicz latat nad Chinami w 1943r?

Otéz chciatbym teraz zaoferowaé kolegom modelarzom (i nielicznych kolezankom — jako$ tak sie te proporcje
uktadajg) zupetnie nowy materiat i narzedzia. Zamiast wlasnego, czasami nieco pobrudzonego aerografem
biurka — okno na inny $wiat, w gtebi ekranu.

Jest tu niezwykle plastyczny materiat, ktéry mozna "wyttacza¢" w dowolne powtoki, bez obawy Zze go zabraknie.
Sg tu farby, dla ktérych mozna doktadnie ustali¢ odcien i zasady nakfadania. Jest tu mozliwa do osiggniecia
doktadnosé¢, ktérej nie uzyskasz nigdzie indziej, ani w skali 1:24, ani w 1:18. Tu, gdy stwierdzisz, ze okapotowa-
nie silnika samolotu, ktéry zrobite$s rok temu, powinno mie¢ inny ksztalt, zawsze mozesz ten bitad poprawic. | to
nie raz! Tu nigdy Twéj model nie obro$nie kurzem. Nie bedziesz wystuchiwat narzekan domownikéw na to, ze
nie ma juz gdzie zmiesci¢ Twojej kolekcji. Mozesz tu powieli¢ swoje dzieto — chocby po to, by odwzorowaé je w
kilku réznych wersjach malowania. | mozesz przesta¢ swdj model innym hobbystom, takim jak Ty, bez obawy ze
cos$ sie z nim stanie podczas transportu. Z obiektow, ktére w ten sposéb stworzysz, mozna szybko budowac
cate sceny.

Jedyne, do czego trzeba sie przyzwyczai¢, to to, Ze niczego w tym Swiecie nie mozna dotkng¢. Mozesz tylko
patrze¢, i tapa¢ wszystko myszka. Przynajmniej na obecnym etapie rozwoju technologii, urzadzenia dotykowe
(ang. haptic devices) sg nadal drogie i prymitywne. Za to mozemy obserwowaé szybki rozwdj drukarek 3D.
Przypuszczam ze za dwa — trzy lata bedziemy mogli na nich ,drukowaé” np. doktadne czesci modeli.

Ten Swiat wirtualnego modelarstwa stat niepostrzezenie dostepny. W istocie kazdy komputer, kupiony po 2005r,
to silna stacja graficzna, o ktérej w latach 90-tych mozna byto tylko pomarzyé. Okoto 15 lat temu ,ruszyt z miej-
sca” nowy model matematyczny, stuzgcy do odwzorowania powierzchni. Mam na mysli powierzchnie podziato-
we (ang. subdivision surfaces). Pozwolity stworzy¢ Shreka i dziesiatki innych postaci z filméw animowanych za
pomocg komputera. Ten nowy model matematyczny skierowat do lamusa powierzchnie NURBS, wykorzystywa-
ne od lat 70-tych. Powierzchnie podziatowe pozwalajg fatwo uzyskiwa¢ naprawde ztozone ksztalty. W miare
dobrze radzg sobie ze zmorg NURBS - otworami i wycieciami.

Co wiecej — odpowiednie programy, ktére potrafig to wszystko wykorzystac, staty sie dostepne za darmo! Stwo-
rzyty je dziesiagtki programistéw Open Source. Ludzie ci chcg pokazacd, ze stac¢ ich co najmniej na to samo, co
tworcow najlepszych programoéw komercyjnych. | to zaczeto im sie udawac! By¢ moze, troche w tym zdrowej
ambicji (,ja to zrobie lepiej!”), oraz innego rytmu powstawania takich produktéw. Podczas pracy nad nimi nie ma,
typowego dla komercyjnych projektéw pospiechu, zwigzanego z napietymi terminami. (A pospiech rodzi btedy).
W efekcie pracy odpowiednio duzej grupy entuzjastéw powstaje dobry, stabilny program.

Podsumowujgc — kupujgc do domu komputer do gier, kupites wszystko, co potrzeba do wejscia w swiat wirtual-
nego modelarstwa. Nie bede oszukiwat, Ze nie ma tu tego, co jest nieodtgczng cechg pracy kazdego modelarza:

© Witold Jaworski, 2009 - 2015.



8 Budowa modelu

wielotygodniowego wysitku. Mam jednak nadzieje, ze ta ksigzka utatwi Ci, drogi Czytelniku, jak najszybsze
osiggniecie pozadanych rezultatow. Potem mozesz pojS¢ dalej i zrobi¢ to samo jeszcze lepiej, niz tu proponuije.
Przeczytanie dalszych stron, oszczedzi Ci duzo czasu i — niekiedy — frustracji. Ta ostatnia bywa nieodtgcznym
sktadnikiem pracy z ,tg glupig maszyng” — komputerem. Postaram si¢ nie zanudza¢ i pokazywa¢ duzo obraz-
kéw, wiec mam nadzieje, ze "Wirtualne modelarstwo" Cie zainteresuje.

Witold Jaworski

Wirtualne modelarstwo — wydanie trzecie www.samoloty3d.pl
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Co zawiera ta publikacja?

Wirtualne Modelarstwo” uczy ,od zera”, jak tworzy¢ takie modele samolotow, jak pokazany na oktadce. Aby
szybciej udostepnia¢ Czytelnikom uaktualnione fragmenty tej ksigzki, zdecydowatem sie stworzy¢ i opublikowac
wyciagi z jej tekstu, zwigzane z okreslong dziedzing. Sg to: ,Tom I Przygotowania”, ,Tom Il: Modelowanie”,
.jom lll: Materiaty i tekstury”, oraz ,Tom IV: Detale i renderowanie”. Przebieg pracy prezentuje na przyktadzie
modelu mysliwca Curtiss P-40B. Maszyna ta zawiera klasyczne rozwigzania, stosowane w wiekszo$ci samolo-
tow tego okresu. Z catym rozmystem nie wybratem Spitfire, Mustanga, Thunerbolta, Focke-Wulfa czy Messer-
schmita. Nie chciatem zabiera¢ Ci przyjemnosci samodzielnego odwzorowania tych stynnych samolotow.

e Mozesz tworzy¢ model kazdego mysliwca z okresu Il wojny $wiatowej!, czytajgc jednoczesnie kolejne
rozdziaty z tej ksigzki. To wcale nie musi by¢ P-40. Wszystkie te samoloty wykonuje sie podobnie. W trak-
cie pracy na pewno zetkniesz sie ze wszystkimi zagadnieniami, ktére sg tu opis ane.

Ta ksigzka ma stuzy¢ zaréwno tym, ktérzy dopiero zaczynajg swojg przygode ,w 3D, jak i tym, ktorzy maja juz
w tej dziedzinie pewne doswiadczenie. W zwigzku z tym zdecydowatem sie jg podzieli¢ na dwie czesci:
- czes¢ pierwsza ("Budowa modelu") to tekst podstawowy, ktéry koncentruje sie na tym, co trzeba zrobic¢;
- czes$¢ druga ("Szczegdly obstugi programow") to szczegdtowe opisy, jak postuzyé sie odpowiednim
programem, by osiggng¢ efekt, pokazany w czesci pierwsze;.

Caly tekst ma duzo stron, z czego "Szczegdty obstugi programéw" zajmujg ok. 40%. Uktad tej czesci przypomi-
na tekst systemu pomocy (Help) do programu. To krétkie (na jedng lub dwie strony), nie zawierajgce wiecej niz
kilka ilustracji, opisy pojedynczych polecen.

Dzielgc materiat na czesé podstawowg i ,szczegdtowq”, staratem sie unikng¢ niepotrzebnych, wydluzajacych
niezmiernie tekst, wskazéwek w rodzaju "kliknij tu, a potem nacisnij tamto". W odpowiednich miejscach czesci
pierwszej umiescitem odnosniki do czesci drugiej. Jezeli nie znasz programu, o ktérym akurat pisze, korzystaj z
tych odno$nikéw i czytaj umieszczone w nich informacje szczegdtowe?. Przygotowatem je tak, aby$ nauczyt sie
postugiwaé wszystkimi narzedziami "od zera", w trakcie czytania gldwnego tekstu. Gdy juz bedziesz wiedziat,
jak zrobi¢ to, co opisuje — po prostu przestaniesz do nich zagladac¢.

Ksigzka zawiera jeszcze jedng czes¢: "Dodatki". To materiaty, ktére mogg by¢ ciekawe dla co dociekliwszych
Czytelnikow. Tematyka "Dodatkéw" przypomina troche "groch z kapustg": od pewnych zagadnieh optyki (defor-
macja obrazu na fotografii), do odwzorowania profili lotniczych. A oprécz tego: metody zaawansowanej weryfi-
kacja rysunkéw samolotu (na poziomie tworzenia planéw modelarskich), oraz szczegdtowy opis wiasciwosci
powierzchni podziatowych. Nie musisz do ,Dodatkéw” zaglada¢, cho¢ sadze, ze niektérzy mogg w tych materia-
tach znalez¢ dla siebie co$ interesujgcego.

' No, moze tych z silnikami rzedow ymi. Nie opisatem tu, jak modelow aé w idoczne z zew natrz elementy chfodzonych pow ietrzem silnikow
gw iazdow ych — cylindry, popychacze, karter, przew ody. Moze w kolejnym w ydaniu ksigzki podjatbym sie modelu P-367?

2 7akladam, ze korzystanie z cze$ci drugiej bedzie zawsze wyrywkow e. Stad w iekszo$¢ z zagadnien, ktore tam sig znajduja, jest omow ione
bez dalszych odnosnikéw . Takie podej$cie pow oduje, ze np. opis skalow ania w edytorze siatki Blendera jest niemal dostow ng kopig opisu z
edytora obiektow . Rdznig sie tylko ilustracjami i paroma zdaniami. Po prostu nie w iem, ktéry z tych tematéw otw orzysz jako pierw szy, a w
kazdym chciatbym dostarczy¢ peing informacje.

© Witold Jaworski, 2009 - 2015.




10 Budowa modelu

Konwencje zapisu

Wskazowki dotyczace klawiatury i myszki opartem na zatozeniu, ze masz standardowe:
e klawiature — w normalnym ukfadzie amerykanskim, 102 klawisze (dodam takze pare uwag o kla-
wiaturze notebooka, bo sam na takiej pracuje);
e myszke — wyposazong w dwa przyciski i kotko przewijania (ktére daje sie takze naciskaé: wtedy
dziata jak trzeci, Srodkowy przycisk).

Wywotanie polecenia programu bede zaznaczat nastepujaco:

Menu >Polecenie - taki zapis oznacza wywotanie z menu ,Menu” polecenia ,Polecenie”. W przypadku
bardziej zagniezdzonych menu moze wystapi¢ wiecej strzatek!
Panel:Przycisk - taki zapis oznacza nacisniecie w oknie dialogowym lub panelu "Panel" przycisku

.Przycisk”. Czasami moge takze w ten sposéb napisa¢ o przetgczniku lub liscie rozwi-
jalnej. ("Panel" to pojecie zwigzane z ekranem Blendera, wyjasnienia — patrz ,Tom Il
Modelowanie”)

Nacisnigcie klawisza na klawiaturze:
[artHK] - my$lnik pomiedzy znakami klawiszy oznacza jednoczesne naci$niecie obydwu kla-

wiszy na klawiaturze. W tym przykladzie trzymajac wcisniety [Alt], naciskasz [};

- przecinek pomiedzy znakami klawiszy oznacza, ze je naciskasz (i zwalniasz!) po

—
)|
L
—

kolei. W tym przyktadzie najpierw |G|, a potem [X] (tak, jak gdyby$ chciat napisac wy-
raz ,gx”).

Nacisniecie klawisza myszki:
PM - lewy przycisk myszy
- prawy przycisk myszy
- Srodkowy przycisk myszy (nacisniete kétko przewijania)
- kétko przewijania (petni te role, gdy jest obracane)

HEHE

Na koniec — ,w kwestii formalnej”: jak mam sie do Ciebie zwracaé? Zazwyczaj w poradnikach uzywa sie formy
bezosobowej (,teraz nalezy zrobi¢”). To jednak, méwigc szczerze, czyni czytany tekst mniej zrozumiatym. Aby ta
ksigzka byta jak najbardziej czytelna, zwracam sie do Czytelnika w krotkiej, drugiej osobie (,teraz zréb”). Cz a-
sami uzywam takze osoby pierwszej (,teraz zrobitem”, ,teraz zrobimy”). Tak jest mi tatwiej'.

' Podczas pracy nad modelem traktow alem nas — czyli Ciebie, drogi Czytelniku, i siebie, piszacego te stow a — jako jeden zespdt. Moze
troche wyimaginow any, ale w jaki§ sposob praw dziwy. Przeciez piszac te ksigzke ja takze w iele sie ucz ytem, bo w iedziatem, ze kazde
zagadnienie mam Ci porzadnie przedstaw i¢!

Wirtualne modelarstwo — wydanie trzecie www.samoloty3d.pl



Rozdziat 1 Przygotowanie ,warsztatu pracy”’ 11

Jak czytaé te ksiazke?

Starajac sie, by ta publikacja elektroniczna byta bardziej czytelna niz typowe ,papierowe” poradniki, przeniostem
tu wiekszos¢ szczegotowych opisdw z gtownego tekstu do podrozdziatéw. W ich miejscu pozostawitem odsyta-
cze (,linki”, takie same jak w systemach podpowiedzi czy stronach internetowych). Aby nie ,zasmieca¢” tekstu
nie wyrozniatem specjalnie w tych miejsc kolorem lub podkresleniem. Mozesz je jednak rozpozna¢ na podsta-
wie kontekstu (,por. str. ...”) a takze po zmianie ksztattu kursor myszki na ,wskazujgcg dtor’” (Rysunek 1.1.1):

Przy ciski Previous/Next —
jak na stronie internetowe;j

B

-tlu # |61% I Ustaw ,ciagte” wy $wietlanie stron

1

>

Struktura ksigzki: czesci,

rozdzialy , sekcje 1 Powrét z

hipertekstowego

=

Rozdzisd 4 Teksfurowsnie modelu 185

s - ol [ Sl baulinls Snliutatey
A | Zwrdc uwage, g uZylem teraz inn: rozwinizcie UV powierzchni kadiuba przed kabing (per. str. 184, Rysunek
m Po co ta ksiszka zostata e 1 44942 sir. 173, Rysunek 4.3.21). To alternatywna mapa UV Decals, kttra dodalem do siathi kadiuba aby
“‘P napigana? 1 - aniotih /" poprawnie uloiyly sie na modelu.
= LN S\ = = e e e = =
Co zawiera ta publikacia? o &M 13 przedstawia probny render ze zmieniona teksturg colorpng i uzupeiniona tekstura decals.png:
Pl N

[E korwencie zapisu
m Jak czytac te ksigzke?
=5 Budowa modely

D Fozdziat 1.
Przygotowanie
“warsztatu pracy”

— B Rogdzial 2. Kompoz:

Zwrod uwage, Ze uzylem teraz inneg

41012 i str(123) Rysunek 4.3.21)

5'_|||r|weﬂ{i anio '%p[aw Wazne: hipertekstowe odsyfacze.
" Kursor myszki zmienia si¢ nad nimi

| A S —— we ,wskazujgca dion”.

Rysunek 1.1.1 Czytanie ksigzki w przegladarce (Adobe Reader)

Gdy klikniesz w taki skrét, przejdziesz na strone, na ktérg odsyta Cie tekst. Aby powrdci¢é w poprzednie miejsce
ksigzki, wykorzystaj przycisk Previous umieszczony u goéry ekranu (Rysunek 1.1.1). Dziatajg tak samo, jak w
przegladarce internetowej. Aby podziat stron nie stanowit przeszkody w czytaniu, mozesz dodatkowo przetgczyc¢
wyswietlanie w tryb ,ciggty” (Rysunek 1.1.1). Wydaje mi sie, ze tak wygodniej jest czyta¢ ,online”.

Aby ten dokument PDF mozna byto poprawnie odczyta¢ na réznych urzgdzeniach, jest zapisany w standardzie
PDF/A. Jezeli przegladasz go za pomocg popularnego programu Adobe Reader, zwr6¢ uwage ze domysinie
wszystkie hipertekstowe odsytacze sg w nim wytgczone (Rysunek 1.1.2):

i Wirtualne modelarstwo (materiaty i tekstury) - Adobe Reader

File Edit Wiew Document Tools ‘window Help

Ha G #esls @

e ‘fou are wiewing this document in PDFA mode.,

AN

E Bookmarks

W tym trybie odsytacze sg nieaktywne!
- ' Kursor myszy ma ksztatt pionowej kreski,
jak w edytorze tekstu.

m Po co ta ksigzka zostata
napisana?

ze uzylem teraz innego rozwiniecie UV powierzchni
Rysunek 4.3.21). To alternatywna mapa UV D
ROwW™ poprawnie utozyly sie na modelu.

Zwroc uwage
41012 1 st
sylwetki ,anio

X o zawiera ta publikacja?

E komwencje zapisu
] 3ak czytac te ksigeke?

Rysunek 1.1.2 Nieaktyw ne odsytacze w trybie PDF/A (Adobe Reader)

© Witold Jaworski, 2009 - 2015.



12 Budowa modelu

Aby uaktywni¢ hipertekstowe odsytacze w dokumencie PDF/A, musisz zmieni¢ pewien domys$iny szczegdt w
konfiguracji Adobe Reader (Rysunek 1.1.3):

w\ﬁew Document  Tools  Window  Help

E j i Preferences
Cakegaries: Open Sektings
Documents | [CIRestare last view settings when reopening documents
Full Scree Open cross-document links in same window
3 |
P:gn:r;isplay Allow laver state to be set by user information
Allow documents to hide the menu bar, toolbars, and window co
3D & Multimedia
accessibility Documents in recently used lisk: |3 :
Select All Cerl+A Acrohat.com :
Deselect Al Shift-+Crl-+A Farms 2. Wy bierz
Identity kategorie
Check Speling 4 International Docurrents |3
Ink k -
JI;\:Sn:ript Automatically save document chy 3. Wytgcz try b wy Swietla-|
) nia PDF/A, wy bierajac tu
Eind CtrI+F’ Measuring (20} Sawve As optimizes For Fast Web | Never:
Search i [13 Cf)tworz okno Measuring (307}
references Measuring (Geo) :
POFEA A Miod
Search Results Multimedia (legacy) I8 View Mode l
| Preferences... Chrl+K Multimedia Trust {legacy) Wiew documents in PDFA mode: w
= £ Reading
Search

Rysunek 1.1.3 Uaktywnienie wewnetrznych odsytaczy dla dokumentéw PDF/A (Adobe Reader, w ersja 9.0)

Z menu Edit otworz okno dialogowe Preferences. Z listy kategorii wybierz Documents. Spowoduje to pojawie-
nie sie po prawej stronie okna kontrolek, jak na ilustracji (Rysunek 1.1.3). Wytacz tryb PDF/A View Mode wybie-
rajgc Never z jego listy rozwijalnej.

Kolejne wersje Adobe Reader moga sie od siebie rézni¢. Na przyktad pasek narzedzi moze sig¢ pojawi¢ u dotu
ekranu (jak to sie przydarzyto wersji 8.0). Co wiecej, w domysinej konfiguracji przyciski Previous/Next, przydat-
ne podczas postugiwania sie odsytaczami, mogg by¢ ukryte (Rysunek 1.1.4):

- Czasami tu moze brakowac
B WM-HD. pdf (SECURED) - Adobe Reader, przy ciskéw Previous/Next!
®
T

File Edit Yiew Document Tools ‘Window Help

i)

1. Kliknij na pasku
narzedzi, by otworzy¢
jego menu kontekstowe

1>

More Tools
e =] Page Mavigation Toolbar
W Button Labels »

[I& First Page
Mate Toals... % [||:| [Z]4 Previous Page
[#]¥ Hext Pags

Lock Taolbars

3. Wigcz widocznosé

2. Wybierz polecenie Previous/Next View:

More Tools...

1
1
1
IFiIe Edit View Document Tools ‘Window Help #

Ha G #(=lue|qe o] g

Przy ciski s widoczne Click to return to the previous page view|

Rysunek 1.1.4 Dodanie do paska narzedzi przyciskéow Previous/Next (Adobe Reader, w ersja 9.0)

Cho¢ zawsze mozna uzy¢ skrotow klawiszowych (Previous: [AltH<€], Next: -[3)) . to jakos razniej jest mie¢
te przyciski ,pod reka”. Kliknij na pasku narzedzi, i z menu kontekstowego wywotaj polecenie More Tools....
Znajdz i zaznacz w oknie More Tools polecenia Previous View i Next View (Rysunek 1.1.4).

Wirtualne modelarstwo — wydanie trzecie www.samoloty3d.pl



Rozdziat 1 Przygotowanie ,warsztatu pracy”’ 13

W tej ksigzce bardzo wazne sg ilustracje — wypetniajg prawie kazdg strone. (Wtasciwie to mozna ten poradnik
okresli¢ jako ,pdotkomiks”). Niestety, takie obrazy istotnie zwiekszajg rozmiar pliku PDF. Aby nie byt zbyt duzy,
musiatem poddac ilustracje kompresji, ktéra pogarsza ich jakos¢. To, co widzisz, to wynik kompromisu pomie-
dzy rozmiarem publikacji a ostro$cig detali obrazéw. W przypadku przegladarki Adobe Reader chciatbym zasu-
gerowaé przestawienie paru parametrow, ktére mogg poprawi¢ dokfadnos¢ wyswietlania ilustracji. Nie sg to
ustawienia domysline, wiec powiniene$ je teraz zmieni¢ tak, jak pokazuje to Rysunek 1.1.5:

Cakegories: Default Lawout and Zoom

Documents Page Layout: | Aubamatic hd Opcjonalnie: przetacz|

Full Screen sie  na rozdzelczo$¢,
Wy bierz te Resolution systemu
kategorie... g8

30 & Mulbimedia 000 |  TTTTTTTTTTTTTTTTOTTTTOOOT Wybierz tu swéj typ

aecessibility Rendering / wy $wietlacza

Acrobat.com

Farms amooth Text; | | For Laptop/LCD screens w

Identity Ta opcja sprawdza sig dla wiekszo-
Inkernational [] Smooth line art [Y]Smooth images [ € Sci ilustracji. Jezeli jednak chciatby $
;nter;et. i [¥] Use local Fonts [¥] Enhance thin lines Efgglf%ﬁ %2:‘aazlowr::‘n” okk::\l‘i/gzzi bez
SRR SR . S
Measuring (20) [¥]Use page cache sprobuj J-El wyt.qc.:zyc, I'sam ocen, czy
Measuring (30 tak bedzie lepiej...

Rysunek 1.1.5 Parametry programu Adobe Reader (w ersji 9.0), odpowiednie dla ilustracji w tej ksiazce

Z listy kategorii okna Preferences wybierz Page Display. Spowoduje to pojawienie sie po prawej stronie okna
kontrolek, jak na ilustracji. W sekcji Resolution przetgcz sie na opcje Use system settings. (Domysinie jest
wybrana ta druga — a to moze pogarsza¢ jakos¢ wyswietlania obrazoéw. W razie czego nie przejmuj sie, jezeli
zobaczysz przy ustawieniach systemowych inng liczbe pikseli/cal niz ta, ktérg pokazuje Rysunek 1.1.5 — to
zalezy od tego, jak sobie ustawite$ rozmiar tekstow w systemie Windows).

Oprécz tego, mozesz zmieni¢ jeszcze dwa, mniej istotne ustawienia. Pierwsze z nich to metoda wygtadzania
tekstu (lista rozwijalna Smooth Text). Acrobat ma domysinie wybrany tryb Monitor. Zapewne uzywasz jakiego$
.cienkiego” ekranu LCD — wtedy warto jg zmieni¢ na For Laptop/LCD screens. | wreszcie przetgczniki
Smooth images i Enhance thin lines. W wiekszo$ci przypadkéw lepiej jest, gdy pozostang wigczone (usta-
wienie domysine). Jezeli jednak samolot na oktadce tej ksigzki ma lekko pofalowane krawedzie skrzydet, to
mozesz sprébowaé wytgczyé wygtadzanie obrazéw. Sam oceh, czy bez tej opcji wyglada lepiej, czy nie.

Zawsze mozesz wydrukowaé¢ egzemplarz ,Wirtualnego modelarstwa” dla swoich potrzeb!. Mozesz go takze nie
drukowac¢ i czyta¢ wprost z ekranu podczas pracy nad modelem. Oszczedzisz w tym przypadku troche papieru
— zawsze to o skrawek lasu wiecej. Co wiecej, mozesz wtedy korzystaé z hipertekstowych odsytaczy i widzie¢
ilustracje w petnym kolorze. Oczywiscie, jezeli wolisz czeste kartkowanie prawdziwego papieru — drukuj catosé.
Nawet jezeli Twoja drukarka obstuguje wydruk dwustronny, zuzyjesz catg ryze A4! Zapewniam, ze nie byto to
moim celem ©.

' Nie chciatemw tej elektronicznejksigzce rezygnowac z kolorow ych ilustracji. W zw igzku z tymw iele z nich na w ydruku w ydaije sie by¢
mato kontrastow a. Aby temu w jakim$s stopniu zaradzi¢, na niektorych ilustracjach zmieniatem kolory odnosnikéw (na ciemniejsze lub ja-
Sniejsze). Dzigki temu na w ydruku sg w miare czytelne.

© Witold Jaworski, 2009 - 2015.



14 Budowa modelu

~Wirtualne modelarstwo” jest takze dostepne w innych popularnych formatach ksigzek elektronicznych: EPUB i
MOBI. Jednak dla tabletow z systemem Android najlepszym formatem tej ksigzki jest PDF (w tej postaci jest
dostepna w Google Play)!. A jako program do czytania polecam tu takze Adobe Reader (Rysunek 1.1.6):

20 Budowa modelu

Teraz sprawdzimy, czy rysunek nie jest obrécony ani przekoszony. Umies¢ linie pomocnicze (guides: szczegoly
— patrz str. 59) na kluczowych liniach konstrukeyjnych, o ktérych wiesz, ze powinny byc pionowe lub poziome
(Rysunek 2.1.2):

- | Linie pomocnicze
(guides) — uwrywane

dao poréwnan

Rysunek 2.1.2 Przyklad i i linii p iczych

Zapewne zapytacie, skad wiem, ktére taczenia blach na kadiubie P-40 byty pionowe lub poziome. No c6z, nie
ma na to precyzyjnej odpowiedzi. Zacznijmy od poziomych. Na kazdym rysunku i wielu zdjeciach widaé na ka-
diubie diugi "szew", ciagnacy sie od ogona do okapotowania silnika (Rysunek 2.1.2). Jego linia przebiega odro-
bine ponizej osi $migta. W opisie technicznym samolotu mozna wyczytaé, ze kadiub P-40 byt sktadany z dwéch
potowek: gornej i dolnej. Co wiecej, na zachowanych zdjeciach z odbudowy pewnego nowozelandzkiego P-40N

Rysunek 1.1.6 Zawartos¢ ksiazki w systemie Android (Adobe Reader wersja 11)

W stosunku do wersji z komputerow PC, ten Adobe Reader ma uproszczony interfejs uzytkownika i minimalng
liczbe opcji (Rysunek 1.1.7):

Opcje programu

Tu takze przetagcz sposob

/ wy $wietlania stron ,ciggte”

Teraz sprawdzimy, czy rysunek nie jest obrécony ani przekoszony. U
—| Powiekszanie/pomniejszanie  trukeyjnych, o ktdrych wi

A strony : doty kowe —_——_—P -~ N
e Tryby widoku 'Ciggte @
| s|Aktualna i e S
! i ARy B Y .. A .
[ |stronalliczb L TT o
Haron 0 B Udostepnij il Pojedyncza strona
A B Drukuj Pon. wlew. tekstu
: - ;v"l-?;i:;"-l‘ . inii
: J o e Wtacz Tryb nocny

Rysunek 1.1.7 Interfejs uzytkownika programu Adobe Reader (Android)

Na szczescie nadal mozna tu ustawi¢ ciggte wyswietlanie stron (Tryb widoku 2 Ciagte, por. Rysunek 1.1.7). Ta
opcja przydaje sie szczegodlnie wkasnie na takich urzadzeniach jak tablety!

' Piiki MOBI to format Amazon.com. EPUB to otw arty format, w zasadzie obstugiw any przez wiekszo$¢ czytnikdw . Wiagnie: w zasadzie.
Gdy szukatem rozwigzania ktére bymmogt zarekomendow a¢ dla tabletow z systemem Android, spraw dzitem chyba w szystkie darmow e
czytnikiksigzek elektronicznych ktére znalaztemw Google Play. Zaden nie w y$wietlat popraw nie zaw artosci pliku *.epub z tg ksigzka. Dla-
czego? Dla EPUB typow ym uktadem jest tzw . ,tekst ciagly” (ang. flowable text), w ktdérym paragrafy dynamicznie dopasow ujg sie do do-
stepnego obszaru ekranu (tak jak zaw arto$¢ stronw przegladarce internetowej). W ,Wirtualnym modelarstw ie” w ystepuja ilustracje z duzg
iloscig objasnien. Te ksigzke czyta sie w ygodnie gdy rozmiar tektu w tych objasnieniach jest takisamw calym w ,cigglym” tek$cie. Aby
uzyskac ten efekt, musiatlem dynamicznie dopasow ywac szerokos$¢ilustracijido ekranu czytnika. | cho¢ stosuje w tym celu udokumentow a-
ne metody (style) ze specyfikacji EPUB 3.0, to okazuije sie ze wiele czytnikdw , zw taszcza te dla systemu Android, nie radzi sobie z tym
efektem. W tej sytuacjizdecydow atemsie ograniczy¢ zastosowanie formatu EPUB tylko do IPad (z dostarczanym przez Apple Store popu-
larnym czytnikiem iBooks) i PC. (Nie chce dostarcza¢ czego$, co moze nie dziata¢ popraw nie na innych urzgadzeniach).

Wirtualne modelarstwo — wydanie trzecie www.samoloty3d.pl
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W tym Adobe Reader takze mozesz korzysta¢ z hipertekstowych odsytaczy. Niestety, urzgdzenia z systemem
Android majg ekrany dotykowe, wiec nie ma tu kursora ktory zmienia ksztat ponad takim potgczeniem. Wystar-
czy jednak pamieta¢ ze takim odsytaczem jest kazda referencja do numeru strony, ilustracji lub rozdziatu. Po
prostu kliknij w odpowiedni tekst (Rysunek 1.1.8):

%

ound px v 13% v IBackground (26.7 ME)

,Stuknij” w
numer strony ...

1czego rzutu z lewej (w GIMP)

e
@y | I} s

58 Szczegdly obstugi programéw

3.5 Kadrowanie obrazu
rz z menu polecenie Tools = 1 Tools = gle Select, (lub naci$nij na klawiaturze EI) Prze-

jac myszke z weidnigtym [IE]T], zaznacz obszar dookola rzutu z boku (Rysunek 3.5.1).

- RPN €I CEP A ve . 151-1.0 (grayscale, 1 layer) 2480x3... [ (B
nig przeniesiony! & yew Image Layer Cors Mggg;ﬁm F”T

[

Rysunek 1.1.8 Korzystanie z hipertekstowych odsylaczy

Aby powréci¢ z takiego ,skoku” w poprzednie potozenie w tekscie ksigzki, skorzystaj z przycisku ,<”, ktéry poja-
wi sie z prawej (przy numerze strony — Rysunek 1.1.9):

35 Kadrowanie obrazu

Whybierz z menu polecenie Tools ion Tools gle Select, (lub naci$nij na klawiaturze iEI) Prze- =
suwajac myszke z weisnigtym [I]], zaznacz obszar dookota rzutu z boku (Rysunek 3.5.1). (.

B *P40-0rg.ver.tif-1.0 (grayscale, 1 layer) 2480x3... [ |E)[X]

Klk m . k b Fle Bt Jelect Yiew [mage Loyer Cokors Tooks [islogs  Fiters

Inl’j‘v’vtenprzy(:ls,‘ay I TN [ WA . - BT |
powréci¢ do poprzedniego | — -~
miejsca w ksigzce g Larp 1L afily
)
g == -

obszar

R Q

| jestes z powrotem tam,
gdzie kliknate$ odsytacz!

1czego rzutu z lewej (w GINIP) v

z boku (szczegdty — patrz str. 58).

Rysunek 1.1.9 Powroét do poprzedniego miejsca

e Adobe Reader dla iOS (IPad) nie ma przycisku ,<”, co czyni go praktycznie bezuzytecznym dla tej ksigzki.

© Witold Jaworski, 2009 - 2015.
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Budowa modelu

W tej czesci stworzymy model P-40B. Zakfadam, ze dla wielu Czytelnikéw bedzie to wprowadzenie w $wiat
grafiki komputerowej. Nie znaczy to jednak, ze nasz samolot bedzie jaki$ uproszczony! (Choé, przyznam, gdy
zaczynatem pisanie tej ksigzki, chciatem pare zagadnien pomingé). Wykonamy go ,w petnej wersji”: z chowa-
nym podwoziem i wiekszoscig detali kabiny pilota. W trakcie pracy postaram sie przekaza¢ Wam catg wiedze,

jaka do tej pory na ten temat zgromadzitem.

Wirtualne modelarstwo — wydanie trzecie www.samoloty3d.pl
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Rozdziat 1. Przygotowanie ,warsztatu pracy”

W tym rozdziale oméwimy pokroétce instalacje oprogramowania, z ktérego bedziemy korzystaé. W tym tomie to:
- GIMP: pomocniczy, do edycji obrazéw rastrowych;
- Inkscape: pomocniczy, do edycji obrazéw wektorowych;

To oprogramowanie jest udostepniane w zasadach licencji GPL. Oznacza to m.in., ze nie mozna pobiera¢ za
nie zadnych optat. (Oczywiscie, jezeli masz gest, a program Ci sie bardzo spodoba, mozesz wspoméc tworcow
dotacjg — ale na zasadzie zupetnej dobrowolnosci. Szczegdtowy opis, jak to zrobi¢, znajdziesz na stronie inter-
netowej kazdego z tych projektéw.)

Przypuszczam, ze wiekszo$¢ czytelnikow tej ksigzki uzywa komputera z Windows. Podczas opisu instalaciji
koncentruje sie wytacznie na tym Srodowisku. Sam go uzywam. Nie mam Zzadnych doswiadczen z Linuksem,
ani z Mac OS, wiec nie bede pisat o instalacjach, ktérych nie wykonatem. Jezeli uzywasz systemoéw innych niz
Windows — poszukaj wskazéwek na stronach tych programéw (ich adresy sg w kolejnych sekcjach rozdziatu).

Przygotowatem takze troche materiatbw dodatkowych, i udostepnitem je jako spakowane pliki zip:

e Pliki towarzyszace tej ksigzce mozesz pobra¢ ze strony: http://samoloty3d.pl/wm3_p.xml. Utrzymuje tam
ich aktualne wersje’.

Nastepujgce pliki sg wazng czescig tej ksigzki:
- source.zip: zawiera skrypty Pythona, plany P-40B, udostepnione przez producenta fragmenty rysun-
kéw technicznych (P-40E), iinne pomocnicze materiaty;

Rozpakuj wszystkie pobrane pliki *.zip do tego samego folderu. W trakcie ich rozpakowania stworzg odpowied-
nie podkatalogii (pliki nie wymienione powyzej nalezg do innych czesci tej publikacji):

CI moj folder _ Rozpakuj wszy stkie pobrane pliki w tym
- folderze. Stworzy to odpowiednie

odkatalogi:
CI model P 9

:CI lab :‘—IZawartosc pliku /a5.zip I

|Zawartoé(': plikéw p40.zip | p40w.zip |

e Zawarto$¢ plikow texturesi.zip i
:CI textures |4 textures2.zip
et _____!
________________ .
:CI optional P — IZawartoéé pliku optional.zip |
e ____
:CI source | IZawartoéé pliku source.zip I
1 1

' Na tej stronie znajdziesz takze odpow iedzi na najczestsze pytania zadawane przez Czytelnikow, oraz informacje o zmianach w opisyw a-
nym oprogramow aniu, jakie sie pojaw ity po publikaciji tej ksigzki.

© Witold Jaworski, 2009 - 2015.
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18 Budowa modelu

1.1 Instalacja GIMP
Aby zainstalowa¢ GIMP, zajrzyj na strone tego projektu — http.//www.gimp.org. Od kilku lat plik do pobrania jest
dostepny pod adresem: http.//www.gimp.org/downloads (Rysunek 1.1.1):

et -

& GIMP - Downloads

The Windows installer packages by Jernej Simondic are distributed from the GIMP HTTP
server (| ) and its s

The installer contiiins both 32 bit and &4 bit versions of GIMP, and will install the appropriate

one.
Pobierz ten plik instalacy jny

Download GIMP 2.8.10
you may also try the

This installer package is known to run on:
Windows XP 5P3 and XP x64 5P2
windows vista
Windows 7
Windows 8 and Windows 8.1

download.gimp.org/pub/gimp/v2.8/windows/gimp-2.8.10-setup.exe SES:PY

Rysunek 1.1.1 Strona, z ktérej mozna pobra¢ program instalacyjny GIMP

Ten uniwersalny program instalacyjny zawiera obydwie wersje GIMPA: 32-bitowg i 64-bitowa. Po uruchomieniu
rozpoznaje typ systemu operacyjnego, i, gdy jest to mozliwe, instaluje wersje 64-bitowg’.

W procesie instalacji Gimpa nie ma zadnych "haczykoéw". Po jej zakohczeniu warto zmieni¢ jezyk interfejsu na
angielski i przetgczy¢ program w tryb pojedynczego okna (Windows ->Single-Window Mode). Szczegdtowy opis,

jak to zrobi¢, znajdziesz na str. 51.

Podczas pracy nad tg edycja ksigzki uzywatem GIMP v. 2.8.10.

' W 64-bitow ych systemach Window's 7 i Window s 8 aplikacje 32-bitow e mozesz poznaé po tym, ze ich pliki znajdujg sie¢ w katalogu
C:\Program Files (x86)\, podczas gdy pliki aplikacji 64-bitow ych — w C:\Program Files\.

Wirtualne modelarstwo — wydanie trzecie www.samoloty3d.pl


http://www.gimp.org/
http://www.gimp.org/downloads

Rozdziat 1 Przygotowanie ,warsztatu pracy”’ 19

1.2 Instalacja Inkscape

Zajrzyj na strone projektu Inkscape — http://wwinkscape.org (Rysunek 1.2.1):

(— > : inkscape.org/en/) [& g" Google P E- ¥+ & N
English Log in / Register

Follow us on: , G

INKSCAPE

Draw Freely.

Search

ABOUT DOWNLOAD NEWS COMMUNITY LEARN CONTRIBUTE DEVELOP

Inkscape is a professional vector graphics
editor For Windows, IMac OS X and Linux.
It's free and open source.

Kliknij tutaj, by przejs¢
na strone z programami
instalacy jny mi

Current 8®ble version: 0.48.4

Overview Features Gallery Learning Resources

‘What iz Inkscape and how ' Find oukt what Inkscape is ™™ Showcase of creations from @ Resources to help you get
can you get it? =| capable of. the Inkscape community. the most out of Inkscape.

Rysunek 1.2.1 Strona projektu Inkscape

Obecnie pliki instalacyjne sg udostepnione na http.//www.ink scape.org/downloads/ (Rysunek 1.2.2):

ABOUT DOWNLOAD NEWS COMMUNITY LEARN CONTRIBUTE DEVELOP

Home » Download

Download

Download Inkscape for free and let your creativity Fly!

Official Release Packages

Stable release 0.48.4 intended for production use is a|Dla Windows 7 i 8 proponuje
uzy¢ wersji 64-bitowej. Nie
* Sou[To jest domysiny fDME toinstall, or C jest to kompilacja ,oficjalna”, looting help.
rogram  instalacyjny be README to i lwn(-;c portal odsyta do innego bleshooting hel

* Souy|Prodra 32-bitowei Fe AEtoinstal} hortalu, gdzie ktos inny tenfDl€shooting help.
+ Opg (wersji 32-bitowe) Fall. program skompilowat i teraz
« Ubuntu Softwark Centre has a one-click install Fo[9° Udostepnia

o Mac 05 X 10.6, $now Leopard — Universal .dmg (requires Apple's X11/Xquartz 2.3.4 or hidger,
« Windows portable, 7zjp , builds of the 64-bit application are currently found on
e 055-Marketplace.com Aﬁ

downloads.sourceforge.net/inkscape/inkscape-0.48.4-1-win32.7z

Rysunek 1.2.2 Strona z plikami instalacyjnymi Inkscape

LOficjalny” pakiet instalacyjny zawiera Inkscape w wersji 32-bitowej. Ja jednak sugeruje zainstalowa¢ odmiane
64-bitowg, ktéra nam obstuzy o wiele bardziej ztozone rysunki (np. obraz detali poszycia samolotu).
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W chwili gdy pisze ten rozdziat, wyglada na to, ze 64-bitowy Inkscape jest kompilowany nie przez samych twér-
cow, a przez kogos$ innego (to i tak dobrze — dawniej byta dostepna wytgcznie odmiana 32-bitowa). Gdy klik-
niesz w odpowiedni link na stronie Inkscape (na stronie pokazywanej przez Rysunek 1.2.2 jest to
www.pratha.com), mozesz sie znalez¢ na takim portalu jak ten pokazywany przez Rysunek 1.2.3:

(' 0 www.partha.com c V Google » n' ‘ ‘ﬁ \

GIMP & Related Musings

Instructions

Downloads Update — December 15, 2013
Gimp 2.8.10 Gimp Installation
David released GMIC 1.5.8.0 just after our builds were uploaded. We have now
updated our bulds to include GMIC version 1.5.8.0. Also, under Windows, you
should now be able to nght click on a supported 1mage to open with Gimp -
2.8.10. The 32-bit builds have been uploaded as well. Useful Links

) Inkscape Official Site
Gimp 2.8.10 — December 7, 2013 Inkscape Tutorials

Mac 0SX
McGimp 64-bit

Windows
- - .. Open Source Cli
Gimp 64-bit o Gimp 2.8.10 was released a few days ago. This is a bugfix release GIMP OFf ite

Gimp 32-bit 4 only and no new features have been added to this build. T —

Gimp Chat

Gimp 2.9 Experimental 64-bit vo T S L T GIMP Plugin Registry
only = GIMPUSERS
(October 25, 2013) .| - . GIMP Nightly Tarballs

o X GIMP Tutorials
HDR Labs
Photomatix
Photography Tutorials
G'MIC Homepage
G'MIC Tutorials

McGimp 2.9 (Mac Snow

Leopard or above) z T

Gimp 2.9 (Windows XP Kliknij tutaj, aby pobraé¢

64-bit or above) program instalacy jny
wersji 64-bitowej

I Inkscape 0.48.4 (Window 2o Required to build Gimp
I 64-bit)
g )

Rysunek 1.2.3 Pobieranie 64-bitowej odmiany Inkscape

Na pierwszy rzut oka wydaj sie by¢ to portal poswiecony GIMP, a nie Inkscape! Jezeli jednak przyjrzysz sie
uwazniej jego zawartosci, znajdziesz odpowiedni skrét (w lewym dolnym rogu — por. Rysunek 1.2.3).

Mozesz pobra¢ stgd program instalacyjny, a nastepnie uruchomi¢ go na swoim komputerze. Proces instalacji
Inkscape jest prosty, wystarczy abys naciskat wszystkie przyciski domysine. Gdyby$ miat jakies watpliwosci —
szczegbtowy opis instalacji znajdziesz na str. 90.

e  64-bitowa wersja Inkscape pobrana ze strony wwwpratha.com ma pewng wade: niestandardowy, zbyt
ciemny kolor okien (por. str. 93). Mozna sobie z tym problemem poradzi¢ tak, jak to opisuje w szczegoto-
wym opisie instalacji.

Proponuje jednak prostsze rozwigzanie: przygotowatem gotowy do rozpakowania plik *.zip, zawierajgcy odpo-
wiednio skonfigurowang 64-bitowg wersje 0.48.10 Inkscape dla Windows 7 i 8. Aby jej uzy¢ wystarczy:

1. pobrac plik http://airplanes3d.net/downloads/wm3/ink scape-048-64.zip;

2. rozpakowac¢ jego zawartos¢ (czyli przenies¢ folder Inkscape) do katalogu C:\Program Files\;

Potem dodaj skrét do C:\Program Files\Ink scape\ink scape.exe na pulpit lub do menu Start, i juz mozesz zaczg¢
uzywac ten program.

W tej edycji ksigzki uzywatem witasnie tego Inkscape (0.48.10, 64bit).
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Rozdziat 2. Przygotowanie rysunkow samolotu

W tym rozdziale przedstawie metode przygotowania rysunkéw samolotu, ktére wykorzystamy jako wzorzec w
Blenderze. Zrobie to tu na przyktadzie mysliwca P-40, ale tok postepowania jest taki sam dla kazdego innego
samolotu. W tym rozdziale bede sie postugiwat wytacznie GIMP. Przy okazji mozesz sie tu nauczy¢ podstaw
jego obstugi.

Model cyfrowy powstaje na podstawie rysunkéw wzorcowych — rzutu z boku, gory, dotu, przodu, ewentualnie
takze z tytu. Rysunki takie muszg by¢ doktadne. Inaczej tylko utrudnig nam prace’.
Na szczescie mamy w Polsce co najmniej dwa dobre plany modelarskie P-40, opracowane przez dwoch roz-
nych autorow:
- Jacka Jackiewicza — rysunki opublikowane w monografii "Curtiss P-40", wydanej w latach 2000-2001
przez AJ Press, w ramach serii "Monografie lotnicze" (zeszyty nr 64, 65, 66);
- Mariusza tukasika — rysunki opublikowane w monografii "Curtiss P-40", wydanej w latach 2008-2009
przez Kagero, w ramach serii "Monografie" (zeszyty nr 36, 40)

Jezeli chcesz samodzielnie wykona¢ model P-40, gorgco polecam zakup co najmniej jednej z podanych powy-
zej publikacji. W materiatach zatgczonych do tej ksigzki nie ma rysunkéw (bytoby to naruszenie praw ich auto-
réw). Rysunki to zresztg nie wszystko - podczas pracy nieodzowne sg takze bliskie zdjecia réznych czesci sa-
molotu. Takie fotografie znajdziesz w Internecie, sg takze publikowane w specjalnych wydawnictwach dla mode-
larzy, nazywanych po angielsku "walk around". Na przyktad, na potrzeby tej pracy kupitem zeszyt "Kittyhawk
I/IA", wydawnictwa Model Detail Photo Monograph (zeszyt nr 14). Zawiera ponad 100 fotografii i szkicow frag-
mentéw P-40E. Wtasciwie im bardziej szczegdtowy zamierzasz zbudowa¢ model, tym wiecej takich materiatow
powinienes zgromadzi¢. Na pewno sie przydadzg!

Wré¢my jednak do naszych rysunkéw: nalezy je zamieni¢ na obrazy komputerowe, wiec muszg by¢ zeskano-
wane. W sumie jest to jedyny moment, gdy potrzebujesz skorzysta¢ ze skanera. Nie stosuj jakich$ wysokich
rozdzielczosci - obraz zeskanowany w trybie 300x300 dpi jest zupetnie dobry.

Przy okazji przygotowywania rysunkéw, bede sie starat doktadnie zweryfikowa¢ poprawnos¢ ksztattu samolotu.
Moze i czasami bedziemy cos$ upraszczac, ale to uproszczenie ma polega¢ na rezygnacji z jakiego$ szczegotu.
Stad nie ma tu miejsca na jaka$ "taryfe ulgowg". Sam sie przekonasz, ile i jakiego rodzaju btedéw potrafig z a-
wieraC¢ nawet szczegotowe plany.

W tym rozdziale pokaze podstawowy proces przygotowania rysunkéw. Trzeba je wyprostowac, sprawdzi¢ po-
prawnos¢ proporcji i zapisaé w plikach o ujednoliconych wymiarach. Uzyjemy do tego Gimpa. Po zapoznaniu
sie z tymi sekcjami bedziesz w stanie sam przygotowac zestaw rysunkow, ktérych uzyjesz w Blenderze.

Jezeli chciatbys dowiedzie¢ sie, jak mozna doktadniej zweryfikowa¢ plany?2 — polecam Rozdziat 5
("Szczegdtowa weryfikacja planéw samolotu”, str. 126). Poréwnuje tam rysunek, jaki przygotowalismy, z frag-
mentami rysunkoéw fabrycznych P-40, a takze ze zdjeciami. Korekty ksztaltu nanosze w Inkscape. Tam osta-
tecznie mozesz sprawdzi¢, na ile nasze rysunki nie ktamig! Metody, ktére stosuje, moga byé wykorzystane na-
wet do opracowywania nowych planéw modelarskich.

' Gdy plat na rysunku z géry wypada w innym miejscu kadiuba niz na rysunku z boku - zaczyna sie problem. Podobnie, gdy na planach
statecznik lew y ma nieco inny obrys niz statecznik prawy. Iktéry jest popraw ny? Takie btedy do$¢ czesto sg popetniane, naw et na planach
modelarskich. Myli¢ sie jest rzeczg ludzka, a nie darmo stare pow iedzeniem kreslarzy brzmi: "papier zniesie w szystko".

2 Gratuluje — to cecha praw dziw ego modelarzal!
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21 Przygotowanie rzutu z lewej

Rysunki po zeskanowaniu nie nadajg sie do natychmiastowego uzycia. Zazwyczaj sg mniej lub bardziej znie-
ksztalcone — na przyktad osie samolotu nie sg idealnie poziome lub pionowe. Mogg im sie takze przytrafi¢ pro-
blemy z wzajemng prostopadtoscig. Takie rzeczy trzeba sprawdzi¢ i skorygowaé. Stworzymy w ten sposob ich
poprawione wersje: kazdy rzut w oddzielnym pliku. Najtatwiej jest to zrobi¢ w Gimpie. (Jezeli zupetnie nie znasz
tego programu — patrz "Wprowadzenie", str. 55).

Wczytaj do Gimpa jeden z zeskanowanych arkuszy, zawierajgcy rzut z boku (szczegoéty — str. 60). Zazwyczaj
najlepiej jest uzy¢ w tym celu jednego z gtéwnych arkuszy planéw. Raczej nie korzystaj z zestawienia réznych
wersji samolotu. (Na rysunkach robionych metodg tradycyjng — w tuszu — zestawienie sylwetek wersji jest
zawsze narysowane mniej starannie.) W tym konkretnym przypadku (publikacji AJ-Press) byt z tym problem.
Rzut z lewej znajduje sie w niej poblizu szwu zeszytu. W takim miejscu podczas skanowania kartka jest nieco
wygieta, i rzut z boku wychodzit zdeformowany. Nie chciatem rozcina¢ stron, i w ten sposéb niszczy¢é mojego
egzemplarza monografii. Przyjrzatem sie wiec doktadnie innym arkuszom planéw. Na rysunkach Jacka Jackie-
wicza zestawienie wersji samolotu wydawato sie tak samo doktadne, jak gtéwny rzut. Zdecydowatem sie wiec z
nich skorzystaé, bo byly najmniej znieksztatcone przez wygiecie strony.

Rysunek 2.1.1 pokazuje, jak w Gimpie moze wyglagda¢ materiat "wejSciowy" — zeskanowany arkusz plandw
modelarskich.

"Surowy ", zeskanowany

1 T ﬁ arkusz planéw modelarskich

"Wy ciety" fragment
obrazu, z pojedynczg
sy lwetkg

1606, 1048 | pxcv 125% v {7} Click-Drag to subtract from the current selection (tr...

Rysunek 2.1.1 Wyciecie z planéw modelarskich pojedynczego rzutu z lewej (w GIMP)

Wytnij z tego obrazu fragment, zawierajgcy pojedynczy rzut z boku (szczegoty — patrz str. 63).
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Teraz sprawdzimy, czy rysunek nie jest obrécony ani przekoszony. Umiesc¢ linie pomocnicze (guides: szczegoty
— patrz str. 64) na kluczowych liniach konstrukcyjnych, o ktérych wiesz, ze powinny by¢ pionowe lub poziome
(Rysunek 2.1.2):

Linie pomocnicze
(guides) — uzywane

i == :
— | I
le—| do poréwnan "
Curtiss Tomahawk Il A :
wirsja rozpdznawcza, w kadiubie kamera |
F 24 o ogniskowej 356 mm,maszt arteny 7 = ——T i
1
?:(w:'ﬂ]"'f__‘_ 1 i

i P
AT c::rffi :
> L - — o i
= T it |
S Em—— :
@\g:-_' :
~ Tl I
— — I
T l 1

Rysunek 2.1.2 Przykladowe rozmieszczenie linii pomocniczych

Zapewne zapytacie, skad wiem, ktére tgczenia blach na kadtubie P-40 byty pionowe lub poziome. No c6z, nie
ma na to precyzyjnej odpowiedzi. Zacznijmy od poziomych. Na kazdym rysunku i wielu zdjeciach wida¢ na k a-
diubie dtugi "szew", ciggnacy sie od ogona do okapotowania silnika (Rysunek 2.1.2). Jego linia przebiega odro-
bine ponizej osi Smigta. W opisie technicznym samolotu mozna wyczytaé, ze kadtub P-40 byt sktadany z dwoch
potowek: gornej i dolnej. Co wiecej, na zachowanych zdjeciach z odbudowy pewnego nowozelandzkiego P-40N
widaé, ze granica podziatu biegnie wtasnie wzdtuz tego szwu. Wydaje sie to tym bardziej prawdopodobne, Ze
blachy w P-40 byty taczone "na zaktadke". Krawedz dolnej potéwki kadtuba — ta niewidoczna, schowana "pod
zaktadkg" — znajduje sie jakies 2 cm powyzej szwu. Wyglada na to, ze lezy na osi smigta. To prawdopodobnie
slad po oryginalnej osi samolotu, jaka wystepowata na jego rysunkach konstrukcyjnych. Linie pionowe, ktére
sprawdzam — sg to po prostu linie gtéwnych wreg. Krawedz steru kierunku — zaktadam, ze jest prostopadta do
osi, bo na takg wyglada. (Zazwyczaj technolodzy, gdy robig juz cos ukosnego, to jest to pochylone o jakis zna-
czacy kat, a nie o utamek stopnia).

W duzym pomniejszeniu szwy na rysunku zdajg sie doskonale przylega¢ do linii pomocniczych. Czy tak jest
jednak na pewno? Trzeba to sprawdzi¢ w wiekszym zblizeniu. (Zmiana widoku w GIMP — patrz str. 65.) Przej-
rzyj rysunek fragment po fragmencie, w powiekszeniu. W strefie silnika i wokét kabiny wszystkie linie wydajg sie
by¢ w porzadku. (Nie wida¢ odchylen narysowanych linii szwéw od linii pomocniczych). Ktopot zaczyna sie na
ogonie (Rysunek 2.1.3). Linia gtéwnego szwu, biegngca poziomo przez caty kadtub, w tym obszarze wyraznie
jest zagieta w dot. Nie jest to duze odchylenie, ale wykracza poza tolerancje "zamiany linii na piksele", dokony-
wanej przez skaner. Co wiecej, linia szwu biegngcego powyzej jest odchylona w podobny sposéb.

- : \ \
I ey /
— 77170
fes

Kat zaklinowania usterzenia - J: eses
poziomego: + 2°. Zgodne z ] f ! %@)
opisem konstrukcji — i-

§::3

R

s Y A

Odchylenia linii szwéw od L ) §
poziomu w cze$ci ogonowej

.| .
— to deformacja? \ \‘\_‘_ “ : i
’ - - - - -4~ HLinia nitéw, biegngca tuz powy zej,
: : / nie jest znieksztatconal!
3 . H -‘ Iy =

T

Rysunek 2.1.3 Szczegotowe sprawdzanie rownolegtosci linii rysunku - odchylenia na ogonie
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To mogtoby wskazywaé na deformacje rysunku w tylnej czesci, wywotang np. nieznacznym wygieciem strony
podczas skanowania. W takim jednak przypadku wszystkie linie w tym obszarze bytyby zdeformowane w ten
sam sposob. A tak nie jest. Natozylem dodatkowg linie pomocniczg na rzad nitéw, biegngcych tuz powyzej jed-
nej ze zdeformowanych linii. Nie ma odchylen! Zmierzytem kat zaklinowania statecznika poziomego — zgodnie
z opisem technicznym samolotu powinien wynosi¢ +2° — i tak jest! Wiec co o tym sgdzi¢?

Przyjrzyjmy sie dokfadniej. Rysunek Jacka Jackiewicza, ktéry tu analizujemy, wyglagda na wykonywany metodg
tradycyjng. (Kreslony najpierw otéwkiem, potem — poprzez kalke — tuszem.) Sgdze tak, gdyz poszczegodline
linie wydajg sie by¢ odrobine nieréwne. Takie odstepy pomiedzy kropkami nitéw sg rézne w réznych miejscach’.
Wyglada na to, ze odchylenia, znalezione na tym rysunku to drobna pomyika, wynikajgca z recznego wykona-
nia. Widac¢ linijka podczas kreslenia zostata przytozona odrobine nieréwno do kalki. Pozostaje tylko pamietac,
podczas korzystania z rysunku, ze na ogonie dwie linie sg narysowane z drobnym btedem.

No dobrze, rzut z boku jest juz przyciety i sprawdzony. Korekty w postaci drobnego obrotu nie potrzebuje, bo
odpowiednie linie sg poziome i pionowe. Teraz pozostaje usungé z niego niepotrzebne resztki innych sylwetek,
a potem zapisac¢ na dysk jako oddzielny plik.

Do usuniecia z rysunku pozostatosci innych sylwetek uzyj "gumki" (Rysunek 2.1.4, szczegoty — str. 77):

|D|I|I|I|I||2$q|lul|I||SpQ|I|I|I||?5q|lululul1pqqI|I|I||12$D|I|I|I||15QD|I|I|I||1?$D|I|I|I||2pqqu||||||22$nululul

Curtiss Tomahawk Il A
WETSHE rOZpOLnawcea, W kadhubse kamara
F 24 o ogniskowej 336 mm,maszt anteny

____________________________________________________ "Gumka" (Eraser) — usuwal
z  obrazu niepotrzebne
elementy

Rysunek 2.1.4 Wymazyw anie z rysunku niepotrzebnych elementéw

Gdy oczyscimy obraz z ,naleciatos$ci”, czas go zapisa¢ do oddzielnego pliku (szczegdly — patrz str. 61). Propo-
nuje nada¢ obrazowi nazwe sktadajaca sie z:

- krétkiego oznaczenia typu,

- inicjalow autora (bo bedziemy korzysta¢ z obydwu),

- nazwy rzutu ("Left", "Top", "Bottom", "Right", "Front", "Back").

Proponuje takze nada¢ mu rozszerzenie .tif. (GIMP wybiera format zapisu na podstawie rozszerzenia nazwy
pliku — ,.tif" oznacza zapis w popularnym formacie TIFF).

Ostatecznie przygotowany plik bedzie nosit nazwe: P40B-JJ-Left.tif. Bedzie tak nazywany w catej ksigzce. Przy-
znam, ze upro$citem nieco oznaczenie tego samolotu. Sciéle rzecz biorgc, to sylwetka Curtiss Tomahawk IIA
dostosowanego do celéw rozpoznania. (Posiada kamere w luku kadtuba i dodatkowg antene.) W istocie jednak
ten typ (oznaczenie fabryczne Hawk 81-A2) byt eksportowg wersjg P-40B, produkowanych réwnolegle dla
USAAC. Antene i kamere podczas tworzenia modelu P-40B zignoruje, i wszystko bedzie w porzadku.

' Poréw najgo z rysunkiem Mariusza tukasika, ktéry - dam sobie reke ucigé — byt robiony na komputerze. Inaczej nie miaiby tylu identycz-
nych "pow tarzalnych" szczegdtow , jak nity.
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Podsumowanie

e  Przygotowanie zestawu rysunkéw, potrzebnych do stworzenia modelu, zawsze zaczynaj od rzutu z lewe;.
Ten rzut jest najczesciej najdoktadniejszy!. Staraj sie unika¢ pobierania rzutu z lewej z mniej waznych
fragmentéw plandw, np. zestawienia réznych wersji samolotu (str. 22).

e Kazdy rzut kadrujemy z zeskanowanego arkusza planéw modelarskich do oddzielnego pliku (str. 22). (Za-
zwyczaj kazdy arkusz planéw zawiera wiecej niz jeden rzut).

e  Sprawdzamy, czy uzyskany obraz nie ma deformacji (str. 23). (Gdyby byly, nalezatoby je skorygowaé -
patrz nastepna sekcja tego rozdziatu).

e Usuwamy niepotrzebne fragmenty obrazu (zazwyczaj resztki innych rysunkéw — str. 24).

e Gotowy rysunek zapisujemy na dysk pod nowag nazwa. Warto tu przyjg¢ jakg$ zasade nazewnictwa —
utatwi nam to pdzniej prace (str. 24).

" Wynika to stad, ze najw iecej zdje¢ samolotéw to zdjecia poziome - z boku lub z przodu. Zresztg wielu kreslarzy czesto zupetie odrucho-
w 0 zaczyna tworzenie rysunku wiasnie od rzutu z lew ej. Uzyw a pdzniej tej sylw etki jako odniesienia przy rysow aniu pozostaty ch rzutow
samolotu

© Witold Jaworski, 2009 - 2015.




26 Budowa modelu

2.2 Przygotowanie rzutu z prawej

Przygotujmy teraz — w podobny sposéb jak rzut z lewej — rysunek prawej strony. Zazwyczaj wybieram na ten
rzut jakg$ wersje z otwartym podwoziem. Podobnie jak rzut z lewej, odpowiednio jg kadrujemy (Rysunek 2.2.1):

B P40-0rg-RB.1if-5.0 (indexed, 1 layer) 2480x3437 [= |[B][X] == *P40-0rg-RB. 1if-5.0 (indexed, 1 layer) 2480x864 [= |[0)[X]
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Rysunek 2.2.1 Wykadrow anie rzutu z prawej

Teraz powinnismy rysunek obrécié, aby ustawi¢ sylwetke poziomo. Wcze$niej dodaj poziomg linie pomocnicza.
Ustaw jg tak, by przechodzita przez czubek kotpaka $migta (Rysunek 2.2.2). (W tym punkcie umiescimy o$ ob-
rotu):

== *D4()-org-RB.tif-5.0 {indexed, 1 layer) 24B0xB64

File Edit Select Wew Image Layer Colors Tools Djalogs  Filkers
B |1 QDD Lo |20p0 | T IR T |21 DD Lo |22p0 | I I NI VPSDD | T I N |24DD | —— | Q:
M A
W tym miejscu
umie$¢ o$ obrotu
.| rysunku
- v
= > %
|px v || 150% |[Background (32,3 MB)

Rysunek 2.2.2 Umieszczenie poziomej linii odniesienia
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Rozdziat 2 Przygotowanie rysunkoéw samolotu 27

Trzeba jeszcze zwigkszy¢ rozmiar obrazu w kierunku pionowym o jakie$ 70%, aby zmieScit sie¢ w nim "wypro-
stowany" (obrotem) rzut z boku (szczegdty — str. 82). Inaczej statecznik pionowy znajdzie sie poza rysunkiem.

Przygotowania do obrotu zakonczone — linia pomocnicza jest na miejscu, rozmiar obrazu odpowiednio powiek-
szony. Rozpocznij obrét. Zacznij od przesunigcia srodka tam, gdzie linia pomocnicza przecina kotpak $migta

(Rysunek 2.2.3 — szczegoty str. 82):

| 0orgRBALSO (ndoxed, 1tayer) 240064 g

File Edit Select Yiew Image Layer Colors Tools Dialogs — Filters
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Rysunek 2.2.3 Sylwetka samolotu przed obrotem

Podczas obracania staraj sie doprowadzi¢ do sytuacji, gdy lina pomocnicza bedzie réwnolegta do gtéwnego
szwu kadtuba (Rysunek 2.2.4). Wartos¢, przy ktorej to osiggneliSmy — 13.43° — jest niemal idealnie zgodna z

rysunkami gabarytowymi Curtiss (13.30°).

File Edit Zelect iew Colors  Tools  Dialogs  Filkers

L |25|DI

Image Layer

B
"

= Rotate

Obré¢ obraz tak, by linia
pomocnicza i gtéwny szew|
kadtuba staty sig réwnolegte

==

|»
<

L) B.ackground-10 (P40-org-RE Lif)
angle: 13.43 [
; 1
ot
Center %! |2436.00 =
Center Y: | 568,00 | p= w
[ Help ] | Reset | [ Rotate ] [ Cancel ]

Rysunek 2.2.4 Sylwetka samolotu po obrocie

Po zatwierdzeniu obrotu przyjrzyjmy sie kluczowym liniom rzut z prawej i podobnym liniom na opracowanym
poprzednio rzucie z lewej (Rysunek 2.1.2).Sprawdz uwaznie o$ kadtuba. W widoku z lewej strony o$ biegnie od
czubka kotpaka smigta, ale niemal dotyka gtéwnego szwu kadtuba. A na naszym rzucie (Rysunek 2.2.4), jest od
niego zdecydowanie odsunieta. Wyglada na to, ze widok z prawej ma wyzej podniesiony nos samolotu!
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28 Budowa modelu

Popatrzmy uwazniej na ten obszar (Rysunek 2.2.5):

== *P40-org-RB.1if-5.0 (indexed, 1 layer) 2480x1300

Fle Edt Select Wiew Image Layer Colors Tools Dialgs Fiters

\\ll Lo beop 0y TOD )y S0P PR L R - TIPSO . NI .. AT O =2
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Rysunek 2.2.5 Znieksztalcenie nosa samolotu (rzut z prawej)

Tym razem to nie jest btgd autora — wyglada na to, ze przdéd samolotu jest wygiety do gory. Przyczyng byto
najprawdopodobniej wygiecie w tym miejscu strony podczas skanowania. (Ten fragment byt niedaleko od szwu
zeszytu monografii, takie wygiecia mogg sie zdarzy¢).

W sumie — nie wiadomo, czy rysunek nie zawiera innych, mniej rzucajgcych sie w oczy réznic. Najlepiej bytoby
natozy¢ na siebie obydwa rzuty — z prawej i lewej, i sprawdzié¢, gdzie ich linie sie "rozjezdzajg". (Takie natoze-
nie to bardzo wymagajacy test dla rysunkéw kreslonych recznie. Cztowiek praktycznie nie jest w stanie naryso-
wacé w sposoéb identyczny dwoch tak ztozonych ksztattow).

GIMP umozliwia takg operacje. Dodamy rzut z lewej jako oddzielng warstwe rysunku. Nastepnie zwiekszymy
przejrzysto$¢ tej warstwy, by wida¢ byto jednoczes$nie linie obydwu sylwetek.

Na razie zapisz te sylwetke z boku do nowego pliku: P40B-JJ-Right.tif. Aby poréwnac ten rysunek z rzutem z
lewej, wykonaj lustrzane odbicie aktualnego obrazu (Layer— Transform >Filp Horizontally). (Nie martw sie,
na koniec wykonamy je znowu, aby powréci¢ "na wlasciwg strone").

Teraz wczytaj plik P40B-JJ-Left.tif jako nowg warstwe (File->Open as Layers), i zwieksz jej przejrzystosc
(szczegdty — str. 68). Rysunek 2.2.6 pokazuije, jak takie ztozenie moze poczgtkowo wygladaé:

BN *P40B-JJ-Right.tif-23.0 (grayscale, 2 layers) 2480x1300

File Edit Select Wiew Image Laver Colors Tools Dialogs  Filkers
E.I:I:lonlulul|I||50|DI|I|I|I||1D|DD||I|I|I||15|DD||I| I|Q:
D_

=

1]

o

]

0 - v

P W 25% W [P4DB-JJ—LeFt.tiF (27.9 ME)

Rysunek 2.2.6 Efekt wiaczenia przejrzystosci na gérnej warstwie obrazu

Warstwa z wezytanym rzutem z lewej nazywa sie tak jak plik — P40B-JJ-Left.tif. Nasun jg na rysunek przeswi-
tujgcy "spod spodu" (szczegdty — str. 83). Podczas dopasowywania potozenia rzutéw najwiekszg uwage zwra-
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Rozdziat 2 Przygotowanie rysunkoéw samolotu 29

caj na takie linie charakterystyczne, jak gtéwne szwy oraz krawedzie steréw. (Wszystko to, co jest narys owane
prostymi liniami i wyznacza wazne miejsca konstrukcyjne.) Pamietaj, ze na rysunkach kreslonych recznie rézni-
ce moga wystgpi¢ na wszelkich krzywiznach. (Na przyktad — obrysy kadtuba lub steru kierunku mogg sie réz-
ni¢.) Natéz na siebie sylwetki tak, aby giéwny szew kadtuba oraz ostatnia wrega byly w tym samym miejscu.

Przyjrzyjmy sie rezultatom. Wyglada na to, Zze Srodek kadtuba jest narysowany na obydwu sylwetkach doktadnie
tak samo. Réznice pojawity sie z przodu (Rysunek 2.2.7) i na ogonie (Rysunek 2.2.8).

W *PA0B-JJ-Right.tif-23.0 (grayscale, 2 layers) 2480x1300 =13
File Edit Select YWiew Image Laver Colors Tools Diaslogs  Filkers
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s

|px A ” B7% W |[P4DB-JJ-LeFt.tiF (27,9 ME)

Rysunek 2.2.8 Poréwnanie dwéch sylwetek z tych samych planéw - czes¢ tylna

Widoczne sg wyrazne odchylenia ksztattu statecznika i steru kierunku. Sgdze, ze jest to przekoszenie. (Linie
zeber i inne linie, ktére powinny by¢ poziome, sg poziome. Linie pionowe za to sg pochylone. A to swiadczy o
tym, Ze nie jest to obrot).
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1 Layers =
Mode: Normal W

Cpacity 50.0
001
1
1
1

Leck D

2. Zmien jej Opacity|
ze 100 na 50.

=~ P4D-1)-Righttif

—11. Przesun warstwe P40B-
|JJ-Right.tif w gore. =

P @

Rysunek 2.2.9 Zmiana kolejnosci warstw iich "przejrzystosci”

Nim zaczniemy korygowaé znalezione réznice, musimy
zmieni¢ kolejnos¢ warstw. W zaktadce sterujgcej war-
stwami (okno przybornika — Rysunek 2.2.9):

1. Wiacz petng nieprzejrzystos¢ warstwy P40B-
JJ-Left.tif (Opacity na 100%);

2. Przesun na liscie warstwe P40B-JJ-Right.tif
tak, by znalazta sie u samej gory;

3. Zmieh nieprzejrzystos¢ warstwy P40B-JJ-

Right.tif (Opacity na 50%);

Zaczniemy od skorygowania przekoszania ogona. Ustaw linie pomocniczg tak, by wyznaczata prawidtowe poto-
zenie koncowej krawedzi kadtuba (Rysunek 2.2.10). (Jest to jednoczes$nie miejsce, gdzie zaczyna sie ster kie-
runku). To nasz wzér, na ktérym bedziemy sprawdzac¢, czy krawedz steru stata sie juz pionowa.

Zaznacz na rysunku prostokatny obszar (szczegdly — str. 78). Te deformacje poprawimy takze przekoszeniem

(Tools=>Transform Tools=>Shear — szczegdty na str. 85), tylko w drugg strone.
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File Edit Select Wiew lmage- Laver Colors Tools Dialogs  Filkers
B j. L L L |1 ?Up il L L |1 309 il L L |.1 $Dp il L L |2Q0p il L L |21 Dp il L L |220p il L L |2$Dp il L L |2‘}Dp L L Q:
] o T e T »~
] E 3 Linia pomocnicza I |
] | — pionowa.

1 |Obszar, zaznaczony —
J do deformac;ji ﬁ<
7] \ =
0] ——
e _

Te dwie linie majg sie
sta¢ rownolegte

'
— i
] = '
1= ,
= : -
, f
] 14 . ' s
] ' 7
Fu : F,
0] :
: \
1 ¢
] £ ] Niewielki przekoszenie| *
i1 i najlepiej zmieniaé w
g polu numery czny m
. Shear

* Background-55 (PB-1)-Right tif)
A 4

Shear magnitude 5: |

P

Dolna granica zaznaczenia biegnie

Shear magnitude ¥

o
4 4>
: ;
+ Ll g

doktadnie wzdtuz linii szwu (aby jak
v
najmniej "popsué" ry sunek) é'

’ Help ” Reset H Shear

Rysunek 2.2.10 Prostowanie (przez przekoszenie) obszaru usterzenia

Zwr6¢ uwage na wybor deformowanego obszaru (Rysunek 2.2.10). Linie pionowe sg w tej transformacji podda-

ne niewielkiemu obrotowi. Pionowe granice zaznaczonego obszaru poprowadzitem wiec przez kadiub tam,

gdzie przecinajg same poziome fgczenia blach kadtuba. Z kolei linie poziome ulegng tylko przesunieciu. Popro-

wadzitem je wiec wzdtuz linii szwu na kadtubie. W ten sposéb przesuniecie tych pikseli nie zepsuje zbytnio ry-

sunku.
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Rozdziat 2 Przygotowanie rysunkow samolotu 31

Rysunek 2.2.11 przedstawia uzyskany efekt — uzgodniony obrys usterzenia pionowego.

Rysunek 2.2.11 Obrys statecznika po korekcie

Przy takich transformacjach, dokonywanych na obrazach rastrowych, zawsze wystgpig efekty uboczne. W oknie
gtébwnym zmien nieprzejrzystos¢ aktualnej warstwy z powrotem na 100. Teraz zobaczymy, co nam na rysunku
sie popsuto (Rysunek 2.2.12):

Przesuniete do/ > C._.h\
przodu trzy linie nitéw / i __"" ' !

/r/

_|Przesunieta do dotu {3
linia szwu

Zanikt $lad po
najnizszy m zebrze

Wygieta krawedz
kadtuba

Rysunek 2.2.12 Niedoktadnosci, o ktorych trzeba pamigtac (aby ich nie przenies¢ na model)

Przygladajac sie efektom, z ulgg mozna stwierdzi¢, ze defekty sg stosunkowo niewielkie (Rysunek 2.2.12):
- przesunely sie trzy linie nitow (ale, dzieki pozostatosciom u dotu, wida¢ gdzie by¢ powinny),
- fragment gtéwnego szwu kadtuba jest odrobine przesuniety do dotu (ale wida¢, gdzie powinna przebie-
gac);
- tylna krawedz kadtuba jest lekko wykrzywiona;
- zanika najnizsze zebro steru kierunku.

Moglibysmy jeszcze raz uzy¢ narzedzi Gimpa, aby poprawi¢ te btedy. Naszym ostatecznym celem nie jest jed-
nak naprawa planéw P-40. Korygujemy rysunki tylko w takim zakresie, by wystarczyty do stworzenia jak najdo-
ktadniejszego modelu. Najwazniejszg rzeczg jest zgodnos¢ ksztattu. W przypadku drobnych nieprawidtowosci w
liniach nitéw lub szwéw wystarczy pamietaé, ze ten obraz byt w tym miejscu poprawiany. Podczas modelowania
zignorujemy te réznice, traktujac rzut z lewej jako wzor.
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32 Budowa modelu

Otwartg sprawg pozostaje kwestia, skad wzieta sie ta poprawiona deformacja. Przypuszczam, ze moze byé¢
efektem odksztatcenia podczas druku. Inng mozliwoscig jest pomytka autora planow. W kazdym razie takie
réznice pozwalajg nam oceni¢ granice mozliwego btedu przygotowywanych rysunkow.

Do prostowania przodu samolotu uzyjemy obrotu (Rysunek 2.2.13):
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Rysunek 2.2.13 Prostowanie przodu samolotu

Zwrd¢ uwage, ze linie fgczen blach pod skrzydiem sg zgodne, a kabiny, potozonej ponad nimi - nie. Tego obsza-
ru nie mozna "wybra¢ prostokatem". Zastosuj inng metode selekcji: dowolnym obrysem (szczegdty — str. 79).
Wazne jest takze takie dobranie punktu obrotu, aby wiatrochron kabiny nie unidst sie do gory. Jednoczesnie
linie tgczenia blach przed wiatrochronem powinny przesung¢ sie do przodu. Rysunek 2.2.13 pokazuje potozenie
osi obrotu, dla ktérej efekt koncowy wydaje sie catkiem zadowalajgcy (por. Rysunek 2.2.14 - z Rysunek 2.2.7,
str. 29):
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Rysunek 2.2.14 Wyprostowany nos samolotu (obydwie sylwetki sg na siebie nalozone)
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W wyniku obrotu nosa obydwie sylwetki niemal idealnie sie pokryty (Rysunek 2.2.15). Jedynie celownik przed
kabing jest odrobine wyzej. Wtasciwie tylko po réznicy w pozycji odsunietej owiewki mozna poznac, ze sg tu
natozone na siebie dwa rysunki. Niemal udato sie unikngé "ubocznych" deformaciji:

E -:.f-—-‘)//

| | . b eeerapiaeipesmeatagiias i i i | To taczenie blach jest

| \| 1" ml l— | __—|lekko odchylone od

| /l { - - o g e . ———
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: ~ H ) r
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: ,'T S~ ;
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lekko odchylone od

1 pionu
| Y,

i S|
1 __.—o—""-—‘-.
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Rysunek 2.2.15 Niedoktadnosci, pozostale po wyprostowaniu nosa samolotu

Koncowki smigta lezg (w zakresie akceptowalnej tolerancji) na tej samej linii pionowej. Wiekszos$¢ tgczen blach
przyjeta poprawne potozenia, za wyjgtkiem dwoéch (Rysunek 2.2.15). (Bedzie trzeba o nich pamietac).

Gotowy obraz przerzu¢ z powrotem w poziomie w przeciwng strone (Image-> Transform >Filp Horizontally).

Na koniec usun warstwe z rzutem z lewej (szczegdty — str. 74) — nie bedziemy jej wiecej uzywaé. Oczys$¢ ry-
sunek z niepotrzebnych linii (str. 77) i zapisz (jako P40B-JJ-Right.ti).

Podsumowanie

e  Sprawdzanie rysunku rozpocznij od poréwnania z liniami pomocniczymi (str. 28);

e Nastepnie poréwnaj go z rzutem z przeciwnej strony (str. 29);

o Woykryte deformacje mozna skorygowa¢ za pomocg roznych transformaciji: obrotu (pamietaj, wazne jest
potozenie srodka tej transformacji! — str. 28), przekoszenia (Shear — str. 30), przesunigcia, i zmiany skali
w jednym kierunku (ta ostatnia jest opisana w nastepnej sekcji);

e Podczas korygowania uzywaj linii pomocniczych, ktére pozwolg Ci w trakcie transformacji na biezgco
sprawdzac, czy osiggnates juz cel (str. 30).
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23

Przygotowanie rzutu z géry

W sylwetkach bocznych samolotu, ktére do tej pory opracowalismy, koncentrowaliSmy przede wszystkim na
odchyleniach od osi poziomej. To dlatego, ze wysokos¢ rzutu z boku jest o wiele mniejsza od jego diugosci.
Pewne deformacje wzdtuz osi Y, nawet jezeli istnieja, powodujg odchylenia mieszczace sie w granicach tole-

rancji.

Zupetnie inaczej jest z rzutem z géry lub z dotu. Tutaj wazne sg obydwa kierunki, i kazdy z nich musi by¢ sta-

rannie sprawdzony. Pokaze to na przyktadzie przygotowywania rzutu z géry z rysunkéw Jacka Jackiewicza.
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Rysunek 2.3.1 "Wyprostowanie" rzutu z goéry, poprzez obrét calego arkusza

Rysunek 2.3.1 ilustruje przeksztatcenia, jakim nalezy poddac¢ obraz po zatadowaniu:
obro¢ obraz o 90° (Image 2 Transform 2>Rotate 90° counter-clockwise) ;

dodaj pionowa linii pomocniczej. Umies¢ jg tak, by przechodzita przez czubek kotpaka smigta. (To dla-
tego, ze punkt ten lezy mniej wiecej w srodku rysunku, w poblizu gérnej krawedzi);
obro¢ caty obraz (Tools »Transform Tools 2Rotate), tak, by o$ kadtuba znalazta sie doktadnie pod linig

pomocniczg.

Po tym wstepnym "wyprostowaniu" nalezy sprawdzi¢, czy skrzydta nie sg przekoszone. (Od tej pory wszelkie
btedy obrazu bedziemy poprawiali transformacjg Shear w kierunku réwnolegtym do osi samolotu. Przyczyna jest
prosta — wszystkie linie réwnolegte do osi wzdtuznej sg juz wyprostowane. Dalsze obroty mogtyby tylko co$
popsuc).

Zgodnie z przyjetg konwencjg, zapisz ten obraz pod nazwa P40B-JJ-Top.tif.
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Rozdziat 2 Przygotowanie rysunkoéw samolotu 35

Zweryfikujmy, czy konce krawedzi ptata lezg w tym samym miejscu (Rysunek 2.3.2):

W *P40-org L T.tif-3.0 (indexed, 1 layer) 3437x2480
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Rysunek 2.3.2 Sprawdzanie deformacji ptata

Natéz na rysunek kilka poziomych linii pomocniczych, umieszczajgc je w punktach charakterystycznych lewej
koncowki ptata. Gdyby skrzydta nie byly zdeformowane, linie powinny przej$¢ przez analogiczne punkty na pra-
wej koncowce. Tak sie jednak nie dzieje — wida¢ wyrazng roznice (Rysunek 2.3.2).

Skoryguj przekoszenie w kierunku osi Y (Tool = Transform Tools=>Shear). Nie zaznaczaj zadnego obszaru, by
deformowany byt caty obraz. (Taka deformacja dotyczy zazwyczaj catego zeskanowanego arkusza.) GIMP sam
ustala Srodek (punkt neutralny) transformacji — jest to Srodek obrazu, a wigc punkt w poblizu osi podtuznej
kadtuba. W przypadku, jaki pokazuje Rysunek 2.3.2, konieczne sie stato skorygowanie przekoszenia w kierunku
osi Y o -19 pikseli (przy rozmiarach obrazu rzedu 2400 x 2900 px).

Teraz piat jest juz poprawny. Przy przegladaniu rysunku znajdujemy kolejng deformacje — statecznika pozio-
mego (Rysunek 2.3.3):

Statecznik pionowy
byt skrecony o 2°
— to jest poprawne

Usterzenie
poziome jest
przekoszone o te

réznice

Rysunek 2.3.3 Kolejny problem - wykrzywiony statecznik poziomy

Wyglada na to, ze po wyprostowaniu skrzydia powiekszyta sie deformacja usterzenia poziomego. (Stato sie
jeszcze bardziej przekoszone). Przynajmniej kadtub i skrzydto mamy juz wyprostowane.
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36 Budowa modelu

Tym razem musimy to poprawi¢, ograniczajgc transformacje do obszaru usterzenia. Jak pokazuje Rysunek
2.3.4, zrobitem to obszarem prostokgtnym (szczegdty — str. 78):
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4 M
Sheat magnitude l:l: i J y =
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] : i.bl R
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e f
%_ : 15 3...,._..{,-. i
E ]
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0 ! \
i |
1 .E
1 ) H
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Rysunek 2.3.4 Prostowanie statecznika poziomego

Przy wtasciwym doborze obszaru deformacji, mozliwe jest, w tym przypadku, unikniecie "popsucia" innych linii

na planach (Rysunek 2.3.5):

Poziomg krawedz obszaru
prowadze tam, gdzie nie ma

zadnej innej linii poziomej

Pozostate deformacje
sg minimalne

Krawedz  statecznikaf=...
zostata wy prostowana

Rysunek 2.3.5 Wyprostowane usterzenie poziome

Pomijam w tej sekcji nastepny sprawdzian — poréwnanie sylwetek rzutu z géry z rzutem z dotu. Nalezy je po-
rowna¢ w ten sam sposob (poprzez natozenie), w jaki pordwnywaliSmy rzuty z lewej i z prawej (str. 28). W tym
przypadku trudniej jest mi poradzi¢, ktory rzut jest wazniejszy. Gdy znajdziesz roznice — pozostaje poréwnanie
ze zdjeciami, aby okresli¢ ktéra wersja jest blizsza rzeczywistosci. Ja traktuje rzut z gory jako "wazniejszy".
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Rozdziat 2 Przygotowanie rysunkow samolotu 37

Na koniec pozostaje sprawdzi¢, czy rysunek ma wtasciwe proporcje. Chodzi o prostg sprawe: stosunek diugosci
i rozpietosci powinien by¢ taki sam, jak w rzeczywistym samolocie.

Znalaztem w Internecie (http://www p40warhawk.com) oryginalne rysunki gabarytowe P-40B/C, zaakceptowane
przez USAAC w kwietniu 1939 (Rysunek 2.3.6). Zostaly opublikowane (odtajnione) przez firme Curtiss w 1941,
ponad dwa lata po oblocie prototypu. Nie oszatamiajg doktadnoscia linii, ale zawierajg rzecz cenng: kilka dodat-
kowych wymiaréw poza rozpietoscig i diugoscig. Zwymiarowano na nich np. trapez skrzydta (poprzez podanie
cieciwy u nasady, na koncu, i kata pochylenia krawedzi natarcia). Podano takze rozpietos¢ usterzenia poziome-
go. Wymiary, naniesione w sposob tak jednoznaczny przez producenta — to dobre narzedzie weryfikacji.

@'ACT.

1y’

Rysunek 2.3.6 Gabaryty P-40B/C — w stopach i calach (Curtiss, 1941)
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38 Budowa modelu

Zmierzmy dtugos¢ i rozpietos¢ rysunku, uzywajgc pikseli jako jednostki. GIMP wyswietla aktualne wspétrzedne
kursora w lewym dolnym narozniku ekranu (Rysunek 2.3.7):

Il *P40B-JJ-Top.tif-1.0 (grayscale, 1 layer) 3437x2480
/

File Edit Select \View Image Layer Colors Tools  Dialogs  Filkers
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pozy cji kursora
(w pikselach)

|

150% ' |[Backaround (67.7 MB) |

Rysunek 2.3.7 Odczytyw anie wspoirzednych poczatku kadtuba

Wystarczy ustawi¢ kursor myszki na poczatku kadtuba, i odczyta¢ wspédirzedng Y aktualnej pozycji. Podobnie —
ustawiajgc kursor — mozna odczyta¢ pozostate trzy wymiary, potrzebne do okreslenia dtugosci i rozpietosci

rysunku. Tabela 2.3.1 pokazuje wyniki pomiaru:

Wymiar Poczatek (px) Koniec (px) Réznica (px)
Kadtub Y: 124 Y: 2476 2352
Ptat X 328 X 3126 2798

Tabela 2.3.1 Zmierzone wymiary rysunku (piksele — px)

Zgodnie z fabrycznymi rysunkami P-40B miat dlugosé 967 cm (31 stdp i 8 9/16 cala). Rozpieto$¢ wynosita - 1137
cm (37 stop i 3 /2 cala). Daje to stosunek dtugosci do rozpietosci = 967 / 1137 = 0.85048. Jezeli zmierzona
rozpietos¢ rysunku to 2798 px (Tabela 2.3.1), to dtugo$¢ powinna wynosi¢ 2798 px * 0.85048 = 2379 px.

Rézni sie to od wartosci zmierzonej (2352 px). Wynikatoby z tego, ze kadtub w rzucie z gory jest za krotki o 27
pikseli. Czy na pewno? Réwnie dobrze mozna przyja¢, ze diugos¢ rysunku Jacka Jackiewicza jest poprawna, a
rozpietos¢ wymaga matego "scisniecia" (o0 2798 - (2352 / 0.85048) = 32 piksele).

Zatézmy, ze dlugos¢ kadtuba jest poprawna. Daje to skale 2.43 pikseli / cal. Stosujgc te wartos¢, mozna okresli¢

inne wymiary, ktére warto sprawdzic:
cieciwa najwiekszego zebra skrzydta (lezy w osi kadtuba) powinna mierzy¢ na rysunku 667 pikseli (wg

planéw Curtissa miata dokfadnie 9 stop, czyli 108 cali);
rozpietos¢ usterzenia poziomego powinna wynosi¢ na rysunku 949 pikseli (wg planéw Curtissa wynos i-

ta 12 stop i 9 5/s cala).

Przedluzmy na planach Jacka Jackiewicza linie krawedzi natarcia i krawedz sptywu skrzydta (Rysunek 2.3.8).
Ich przeciecie z osig kadtuba wyznacza poczagtek i koniec "Zzebra kadtubowego". Ten odcinek powinien mie¢
diugos¢ 667 pikseli, a ma 676 — o0 9 za duzo. Wyglada wiec na to, ze pfat jest za duzy w stosunku do kadtuba.
(Ma wieksze obydwa podstawowe wymiary: cieciwe i rozpietosé).
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Podobnie za duza jest rozpietosS¢ statecznika poziomego. Powinna wynosi¢ 949 pikseli, a wynosi 960 — o 11
pikseli za duzo (Rysunek 2.3.8):

Czy ptat jest
zbyt duzy ?

Czy usterzenie
pionowe nie jest
takze zbyt duze?

Przyjatem, ze dtugosé
kadtuba w rzucie z gory
jest poprawna

5 px

Rysunek 2.3.8 Réznice pomigdzy planami a rzeczywistymi wymiarami samolotu.

W ktérym kierunku skorygowa¢ rysunek? Aby to ostatecznie rozstrzygng¢, sprawdzmy, jak pasuje rzut z lewej
do widoku kadtuba z géry. Czy dtugosci poszczegdlnych elementéw sie zgadzajg? Przygotujmy rysunek do

poréwnania:
- dokonaj konwersji obrazu na odcienie szarosci (o ile nie zrobite§ tego wczes$niej):
Image >Mode > Grayscale,

- obré¢ rysunek o 90° w lewo: Image > Transform > Rotate 90° counter-clockwise;

Zataduj jako nowg warstwe plik P40B-JJ-Left.tif (File>Open as Layers) . W przyborniku, w zaktadce Layers,
zmniejsz nieprzejrzystos¢ (Opacity) warstwy P40B-JJ-Left.tif ze 100 na 50;

Na koniec sprébuj nasunag¢ rzut z lewej na kadtub rzutu z gory. Zréb to tak, aby linie kotpaka $migta jak najlepiej
sie pokryty (Rysunek 2.3.9):
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Rysunek 2.3.9 Ztozenie — kadtub, rzutu z lewej i rzutu z gory
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Na pierwszy rzut oka wyglada to jak platanina linii. Jednak w zblizeniu na obydwu rzutach dostrzezesz wspdlne
punkty charakterystyczne. Diugo$¢ kadtuba na obu rysunkach jest idealnie zgodna. Obrys kotpaka - réwniez.
Nie mozna znalez¢ wiekszej réznicy w pozycjach poszczegdlnych linii w okolicach usterzenia. (Krawedzie ste-

row sg w tym samym miejscu).

Za to $rodek kadtuba — tu mamy roznice! (Rysunek 2.3.10) Krawedz natarcia skrzydia w rzucie z gory jest
przesunieta do przodu o 12 pikseli. (W stosunku do krawedzi natarcia w rzucie z boku.) Z kolei caty obszar ka-

biny, zaczynajgc od przedniej krawedzi skrzydta, wydaje sie by¢ przesuniety do tytu o 4-5 pikseli.
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Rysunek 2.3.10 Réznice w potozeniu szczegétéw kadtuba i skrzydta

Zatozmy (co$ trzeba zatozyc), ze rzut z lewej jest poprawny?’. Bedziemy go traktowaé jako wzor. W tej sytuaciji

wyglada na to, ze nalezy dokona¢ jeszcze nastepujgcych poprawek:

nalnie — usterzenia poziomego);

w przyblizeniu) zmniejszeniu.2

przeskalowaé caty rysunek wzdtuz osi Y, aby zmniejszy¢ rozpietos¢ ptata o 32 piksele (i — proporcjo-

"Scisng¢" skrzydto, wraz z fragmentem kadtuba, o 9 pikseli wzdtuz osi X. (Krawedz sptywu pozostaje,
mniej wigcej, w dotychczasowym miejscu). W ten sposob ptat ulegnie proporcjonalnemu (przynajmniej

rozciggng¢ sam kadtub w kierunku osi X, od statecznika pionowego do okapotowaniu silnika. Przy oka-

potowaniu silnika powinna nastgpi¢ najwicksza deformacja — o 5 pikseli do przodu;

' Mimo pozoréw nie podejmuje tej decyzji zupetnie "w ciemno”. W chw ili, gdy to pisze, w ykonatemjuz poréw nania syl etkibocznej ze zdje-
ciami (patrz "Szczegdtow a weryfikacja plandw samolotu”, str. 126). Poréw nania rzutu z boku w yszly zadow alajgco, w odréznieniu od po-

réw nan rzutu z gory. Stad wiem, Ze na rzucie z lew ej moge polegac.

2 Swiadomie zgadzamsie, ze obszar $rodku kadiuba zostanie w raz ze skrzydtem "$ci$niety". To jeszcze bardziej oddali jego szczegdly od
popraw nych pozycji, zgodnych z rzutemz boku. Wynika to z obserwacji deformaciji kadtuba, ktérg chce w yprostow a¢ w kroku 3. Najw ieksze
réznice w kierunku osi X w ystepujg za kabing pilota, a przy zblizaniu sie do okapotow ania silnika nieco malejg. Gdy najpierw , wraz ze
skrzydtem, "scisne" fragment od silnika do konca kabiny, a potem "rozciggne" fragment kadtuba od usterzenia do silnika, to uz godnie je z

rzutem z boku. Gdyby deformacja kadtuba byta inna, musiatbym popraw ia¢ to innymi transformacjami.
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Rozdziat 2 Przygotowanie rysunkoéw samolotu 41

Nim wykonamy krok 1, przytnij obraz tak, by zawierat wytgcznie rzut z goéry (szczegodty — str. 63). Zréb to tak, by
jego krawedzie — goérna i dolna — byty jak najblizej koncowek skrzydet.

Przygotowujgc rysunek do poprawek, zmien kolejno$¢ warstw:

: ETE E
= Layer-> Stack > Reverse Layer Order.
Mode: Mormal W
" Nastepnie, zaktadce Layer.
Josacty A .
T - zmieh nieprzejrzystos¢ (Opacity) warstwy z rzutem z
Lock 4
lewej (P40B-JJ-Left.tif) na 100 (kompletnie nieprzej-
rzysta).
- =Pm_”_L et - zmien nieprzejrzystos¢ (Opacity) warstwy z rzutem z

gory (P40B-JJ-Top.tif) ze 100 na 75;

(Szczegodly zarzgdzania warstwami znajdziesz na str. 68).
B & 3 5 & a8 Rysunek 2.3.11 pokazuje, jak powinno wyglada¢ utozenie
warstw przed dalszymi transformacjami. Zwr6¢ uwage, aby
podswietlona (aktywna) byta warstwa z rzutem z gory.

Rysunek 2.3.11 Przygotowane warstwy

Teraz wykonaj pierwszy z zaplanowanych krokéw: zmniejsz rozmiaru catosci wzdluz osi Y (rozpietos¢) o 32
piksele (szczegdty — str. 87). Przeksztat¢ w ten sposéb calg aktywng warstwe (tzn. nie zaznaczaj wczesniej
zadnego obszaru).

Nastepnie wykonamy krok drugi: "$cisniecie" obszaru skrzydta, wraz z kadtubem, o 9 pikseli. Obramuj skrzydto
prostokatnym obszarem selekcji (Rysunek 2.3.12), a nastepnie wybierz znéw polecenie zmiany skali.
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Rysunek 2.3.12 "Sci$nigcie" skrzydta w kierunku X

Po zakonczeniu zmiany skali znéw nalezy - podobnie jak poprzednim razem - odrobine przesunaé przeskalo-
wany obszar. Tym razem trzeba dosung¢ go do tylu. (Gdy wpisujesz nowy rozmiar w pola Width lub Height,
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Srodkiem skalowania jest w GIMP zawsze lewy gbérny naroznik obszaru selekcji. W zwigzku z tym, w wyniku
zmiany skali, przesuneta sie¢ w lewo krawedz sptywu pfata, a nie jego krawedz natarcia — por. Rysunek 2.3.13.)
Luke po skalowaniu poprawimy przesunieciem o 9 pikseli w prawo. Wywota to efekt "krotkiej kotderki" z przodu
selekcji. Luka pojawi sie teraz w obszarze okapotowania silnika, pomiedzy rurami wydechowymi a poczagtkiem
skrzydia. (Spokojnie, skorygujemy jg wykonujac trzeci, ostatni krok zaplanowanej transformaciji.)
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Rysunek 2.3.13 Po skalowaniu: przerwe z tylu zamieniamy na przerwe z przodu

Ostatni krok transformacji ma polega¢ na wyciggnieciu w kierunku silnika samego kadtuba, bez skrzydta. Zadna
z metody selekciji, ktére dotychczas poznaliSmy, nie jest do tego odpowiednia. Zaznaczenie prostokatem o bjeto-
by i przesuneto nie tylko kadtub, ale takze fragment skrzydta. Z kolei Free Select zbyt zalezy od losowych
drgnie¢ reki. Jak mozesz sie przekonac¢, nie mam jej zbyt pewnej (Rysunek 2.2.14, str. 32).

Pozostaje mi skorzysta¢ z innej mozliwosci Gimpa: narysowania obszaru selekcji. Opisujgc rzecz w skrdcie,
robi sie to w nastepujgcy sposob:

- tworzysz na chwile nowa, (przejrzysta) warstwe (patrz str. 73);

- rysujesz na niej ksztalt selekcji (patrz str. 75);

- wywolujesz polecenie Layer—=>Transparency>Alpha to Selection (por. 80);

- "sprzatasz" po operacji: usuwasz niepotrzebng juz warstwe z ksztattem selekcji (patrz str. 74);

Nim zamienisz narysowany ksztalt w selekcje, wprowadz pewng poprawke. Wykonaj za pomocag ,gumki”
(Eraser — patrz str. 77) niewielkie wgtebienia wszedzie tam, gdzie z kadtubem styka sie jakas linia skrzydia
(Rysunek 2.3.14):
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Rysunek 2.3.14 Przygotow anie obszaru selekcji — wymazanie "naddatkow", wykonanie wglebien

Takie wgtebienia pozwolg unikng¢ pozostatosci po transformacji w postaci brzydkich, krétkich, poprzecznych
linii. Teraz mozesz przeksztatci¢ narysowany ksztalt na selekcje: Layer=> Transparency>Alpha to Selection.
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Nastepnie przeskaluj zaznaczony obszar. Tym razem, po wywotaniu polecenia Scale, nie wpisuj wartosci w
oknie dialogowym. Zamiast tego uzyj jednego z uchwytéw obszaru selekcji, by dopasowac potozenie kabiny do
zaznaczonych na rysunku linii pomocniczych (Rysunek 2.3.15). (Linie te nanie$ na podstawie rzutu z lewej —
patrz Rysunek 2.3.10, str.40)
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Rysunek 2.3.15 Zmiana skali za pomocg uchwytéw obszaru selekc;ji

Po przeskalowaniu nie zapomnij o wywotaniu Layer=>Anchor Layer, by zatwierdzi¢ transformacje! Rysunek
2.3.16 pokazuje efekt rozciggniecia kadtuba. Udato sie dopasowaé do rzutu z lewej linie kabiny i dalsze szwy, w
kierunku ogona.

To, co pozostato po tej transformaciji, to nieco wysuniete do przodu (w stosunku do wzoru) fgczenia blach przed
kabing. Réznice sg jednak niezbyt duze. W dodatku potozenie tych szwdw w rzucie z géry nie wydaje sie godne
zaufania — nawet nie sg pionowe! Wyglada to na niedoktadno$¢ podczas kreslenia. Po oryginalnych "wgtebie-
niach" w okolicach taczenia linii skrzydta i kadtuba pozostaty teraz przesuniete przerwy (Rysunek 2.3.16). W
wykorzystaniu rysunku do naszych celéw nie bedzie to przeszkadzac¢. Zapewniam, ze to wyglada o wiele lepiej,
niz gdybysmy takich wgtebien w ksztatcie selekcji nie zrobili.

wgtebieniu
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R | ’
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Rysunek 2.3.16 Efekt trzeciego kroku - kadlub w rzucie z gory jest "dociaggniety"” do rzutu z lewej

Mamy wiec ostatecznie "wyprostowany" rzut z gory, uzgodniony z rzutem z boku. Na koniec:
- usun wszystkie warstwy pomocnicze, pozostawiajgc tylko rzut z géry (P40B-JJ-Top.tif);
- obré¢ rysunek o kolejne 90° (Image 2 Transform 2Rotate 90° counter-clockwise);

- wymaz "gumkg" wszystkie niepotrzebne fragmenty ktére pozostaly ze skanowanego arkusza
(Tools 2Paint Tools >Eraser);

- przetacz tryb barw z powrotem na odcienie szarosci (Image >Mode >Grayscale);
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Dodatkowo mozesz "sptaszczy¢" rysunek (poleceniem Image >Flatten Image)'.

Rysunek 2.3.17 pokazuje ostateczng postac¢ rzutu z goéry z planéw Jacka Jackiewicza. Zapisz go (pod nazwg
P40B-JJ-Top. tif).

Rysunek 2.3.17 Ostateczna postac rzutu z goéry

' Ta operacja nigdy nie zaszkodzi, gdy mamy tylko jedng w arstwe. Moze za to oszczedzié stresu wywotanego komunikatem o niepow od ze-
niu zapisu obrazu do formatu *tif.
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Podsumowanie

e W rzutach z géry i z dotu wyszukaj i popraw ewentualne przekoszenia skrzydta i statecznika poziomego
(str. 35 - 36).

e Duze korekty ksztattu (np. catego skrzydta) powodujg pojawienie sie mniejszych, lokalnych deformaciji (str.
42 - 43). Od razu staraj sie je przewidzie¢, by potem skutecznie wykona¢ odpowiednie lokalne poprawki.

e  Poréwnaj z rzutem z lewej rzuty z goéry i z dotu. Sprawdz, czy pozycje elementéw kadtuba sg na nich takie
same (str. 39).

e  Sprawdz proporcje rysunku, przede wszystkim rozpietosci do dtugosci (por. str. 37 - 39). W miare mozliwo-
$ci, nalezy sprawdzi¢ takze inne wymiary (jezeli sg znane).! Whnioski z tej weryfikacji mogg prowadzi¢ do
dalszych korekt.

o Niektore z korekt — jak wydtuzenie w tej sekcji samego kadtuba, bez skrzydta — wymagajg uzycia selekciji
"przez narysowanie" (str. 42).

' Nie nalezy jednak bezkrytycznie wierzyéw kazdy podany w publikacjach wymiar. Na przyktad: w opisie technicznym P-40, opublikow anym
w monografii AJ Press (druga czes¢ monografii P-40, zeszyt nr 65) mozna przeczytac, ze:

- rozpigto$é ptata P-40 w ynosita 1135c¢m. To w yglada na jakie$ dziw ne zaokraglenie podczas przeliczaniaz 37 stép i 3'/2 cala. Blad
ten pow tarza sie zresztg w innych zrodtach.

- rozpietos¢ usterzenia poziomego w ynosita 341cm. (Wedtug rysunkéw wymiarowych Curtiss byto to 390cm, co znajduje potw ier-
dzenie w proporcjach plata i usterzenia na zdjeciach.). Wyglada to na prosty btgd edycji, gdyz inne w ymiary (np. cieciw y ptata) ta
monografia podaje popraw nie.

- dlugos¢ kadtuba P-40D/E w ynosita 949cm (czyli, ze byt w yraznie krétszy od P-40B/C, ktérego kadtub mierzyt 967cm). Okazuje
sie, ze w cale tak nie byto. (Zresztg nawet rysunkiw tym samym zeszycie nie pokazujg zadnej roznicy). Nie wida¢ tego takze na
zdjeciach. Wg rysunkéw Curtiss P-40D i nastepne byt tylko o /16 cala (pare milimetréw ) krétszy od P-40B/C. Ten biagd z diugo$cig
kadtuba jest pow tarzany w wielu zrédtach. Mogt sie w zigé stad, ze przektadnia stosowana od wersji P-40D byta faktycznie krotsza
o ponad 10 cm od tej z poprzednich w ersji. Skrécita sie diugos$¢ okapotow ania silnika, ale konstruktorzy powiekszyli jednocze$ nie
kotpak $migta — i ogdlna dtugosé kadiuba nie ulegta istotnej zmianie.

Czy w takim razie w ymiary podane na rysunkach w ymiarow ych przez producenta mozna traktow a¢ "jak w yrocznig"? W zasadzie tak to
robie, cho¢ natknatem sie na jedng sprzecznos¢, ktorej nie potrafie jednoznacznie w yjasni¢. Ry sunki gabarytow e poprzednika P-40 —
mys$liw ca Haw k P-36, opublikow ane przez Curtiss, réznig sie od rysunkéw P-40 w dw 6ch w ymiarach:

- rozpieto$ci usterzenia poziomego:13 stép w P-36 w obec 12 stdp 9 °/s calaw P-40 — oznacza to réznice 6 cm;

- rozstaw u kot podw ozia: 8 stép w P-36 w obec 8 stop 1 "/s calaw P-40) — oznacza to réznice 5 cm;

Réznice rozstaw u podw ozia mozna w yttumaczy¢ w igkszymi (i grubszymi) oponami uzytymi w P-40. Gorzej z usterzeniem. Staratem sie to
sprawdzi¢ na zdjeciach P-36. Rozpietos$¢ usterzenia na fotografiach w ychodzita mi ok. 390 cm — czyli taka sama jak w P-40. Obrys steru
w ysokosci P-40 takze pasowatdo zdje¢ P-36. Jednak granica toleranciji tego poréw nania (*/-2 cm) byta zbyt duza, by jednoznacznie stwier-
dzi¢ zgodnos¢. Na zdjeciach w ida¢ takze, ze ster wysokosciw P-36 miat dodatkow g kompensacje aerodynamiczng wzdiuz catejrozpietosci
Byt przymocow any do statecznika zew netrznymi okuciami. W P-40 zastosow ano inne rozw igzanie, pozostaw iajgc kompensacje tylko na
koncoéw cesteru. Okucia jego osi ukryto w ewngtrz statecznika. Niew ykluczone, ze ,przy okazji” zmieniono takze kilka zeber na koncéw ce,
redukujgc nieco rozpietos¢ usterzenia.
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46 Budowa modelu

24 Ztozenie rysunkéw

Do pracy nad modelem w Blenderze potrzebne sg nastepujgce rzuty samolotu (w nawiasach podaje nazwy,
jakie nadatem odpowiednim plikom):

widok z lewej (P40B-JJ-Letft.tif),

widok z prawej (P40B-JJ-Right.tif);

widok z gory (P40B-JJ-Top.tif);

widok z dotu (P40B-JJ-Bottom.tif);

widok z przodu (P40B-JJ-Front.tif).

o DD~

Oprécz tego, mozesz takze przygotowac¢ dodatkowo:
6. widok z tytu (czasami sie przydaje) (P40B-JJ-Rear.tif);

W poprzednich sekcjach pokazatem, jak przygotowywac rzuty w GIMP, uzyskujgc obrazy 1, 2, 3 (Rysunek
2.4.1). Teraz przygotuj w ten sam sposob pozostate elementy (4, 5, 6) z powyzszego zestawienia. Powiniene$
uzyskac ostatecznie szeS¢ rysunkéw:

Rysunek 2.4.1 Unifikacja rozmiaréw i polozenia sylwetek "podkiadow" dla Ble ndera

2Zwr6¢ uwage, ze odpowiednie wysokosci i szerokosci (wymiary A i B) poszczegdlnych rysunkéw zostaty ujed-
nolicone (Rysunek 2.4.1), podobnie jak potozenie sylwetki wewnagtrz obrazu (wymiary f,g,h). Rysunek 2.4.1
pokazuje rzut z dotu (4) obrécony o 90° w lewo. Ustawitem go w ten sposdb wytgcznie na tej ilustracji. Chciatem
w ten sposob pokazac, ze dtugos¢ boku A i odstep f sg takie same, jak na rzucie z boku.

o Odpowiednie odlegtosci A, B, f, g, h powinny mie¢ takg samg dlugo$¢ (mierzong w pikselach) na kazdym z
rysunkow
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Aby takie ujednolicenie uzyskaé, ostatnimi krokami, ktére wykonywatem w GIMP, byty:
- zmiana rozmiaru obrazu na "standardowy" (czyli taki z wymiarem A, B);
- zatadowanie, w charakterze wzorca, poprzednio przygotowanego rysunku (do nowej warstwy);
- dopasowanie sylwetki na obrazie do rozmiaréw i potozenia sylwetki — wzorca;
- usuniecie warstwy ze wzorcem;
- zapisanie sprawdzonego w ten sposdb obrazu do pliku.

Ujednolicone wymiary rysunkow, ktére pokazatem na przyktadowym zestawieniu (Rysunek 2.4.1), wynosza: A =
2390px, B = 2827px. Nie sg to zadne "magiczne" liczby. Po prostu szeroko$¢ pierwszego rysunku — rzutu z
lewej — zdeterminowata mi wymiar A. Podobnie szeroko$¢ rzutu z gory okre$lita wymiar B. Potozenie osi sa-
molotu wzgledem krawedzi tych rysunkéw podyktowato mi wymiary f,g,h, do ktérych dopasowatem pozostate
sylwetki.

e Ujednolicenie potozenia sylwetek wzgledem granic obrazu nie jest konieczne. Jednak narzucenie sobie tej
reguty bardzo utatwi pdzniejsze pozycjonowanie rysunkow jako "podkiadéw" w Blenderze

Do tej pory pokazywatem wszystkie operacje na przyktadzie rysunkow Jacka Jackiewicza. Na poczatku tego
rozdziatu wspomniatem, ze mamy do dyspozycji takze drugie plany - opracowane przez Mariusza tukasika'. W
istocie obydwa opracowania nie roznig sie specjalnie. Wydaje mi sie, ze Mariusz tukasik korzystat w szerokim
zakresie z rysunkéw Jacka Jackiewicza. (Nie ma w tym nic ztego, plany sg takze po to publikowane). Poréwnu-
jac te rysunki, dostrzegtem nastepujgce réznice:

- Kadtub na rysunkach M.t. jest o ok. 2% dtuzszy od rysunkéw J.J. Wyglada na to, ze zostat proporcjo-
nalnie rozciggniety wzdtuz osi X.

- Rzut z przodu na planach J.J. ma zbyt nisko narysowany kotpak i $migto, oraz zbyt waski rozstaw kot.
M.L. skorygowat te btedy. Co prawda z rozstawem kot podwozia nie do konca sie udato2. Dodatkowo li-
nie ptata w rzucie z tytu i z przodu na rysunkach M.L. nie pokrywajg sie.

- M.k zastosowat bardziej poprawny obrys steru wysokosci. (Na rysunkach J.J. krawedz sptywu steru jest
zbyt "wypukia").

Sadze, ze gdy Mariusz tukasik znalazt na rysunkach Jacka Jackiewicza niewtasciwe proporcje rozpietosci i
dtugoéci, zdecydowat sie je poprawi¢ przez wydtuzenie kadtuba. (My zmniejszyliSmy skrzydta i stateczniki —
por. str. 38). Aby te sylwetki uzgodni¢, na planach M.t. wydtuzytem rzut z boku i kadtub w rzucie z géry o 2%.
Natozytem tak przygotowane sylwetki na rysunki J.J. Okazato sie, ze doskonale do siebie pasujg. Mozna je
stosowa¢ zupetnie wymiennie! Na przyktad - zamierzam wykorzysta¢ rzut z prawej z rysunkéw M.k, gdyz ma
"odjete" skrzydto (Rysunek 2.4.2). (Takiego ujecia nie ma na rysunkach Jacka Jackiewicza).

Rysunek 2.4.2 Rzut z prawej — z planéw Mariusza tukasika

' Czasami, aby nie w ydiuzaé zdan, bede postugiw at sie skrétami, odpow iednio: "rysunek J.J." lub "rysunek M.t..".
2 Na rysunku J.J. (1:48) kofa gléw ne sgo 1.5 mm za w gsko, a na planach Mt. - 0 1.5 mm za szeroko. (Rozstaw podw ozia wg Curtiss wyno-
sit 8 stép, 1 '/s cala— por. Rysunek 2.3.6, str. 37. W skali 1:48 oznacza to 51.6 mm).
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Rysunki Mariusza tukasika zostaty wykonane za pomocg komputera. Tu juz sie nie zdarzajg "poslizgi linijki", jak
na rysunkach robionych recznie. Majg takze bardziej jednorodne, wyrazne linie. Przygotowatem drugi zestaw
szesciu rzutéw na podstawie tych planéw. Nadatem tym plikom nazwy zaczynajgce sie od "P40C-ML-". (Na
przyktad Rysunek 2.4.2 to P40C-ML-Right.tif).

Z rysunkami, ktére opracowaliSmy w tym rozdziale, mozna wykona¢ model P-40. Czy jednak bedzie naprawde
taki, jak oryginat? Jezeli jestes modelarzem, a nie tylko grafikiem komputerowym, zapewne bedziesz chciat to
sprawdzi¢. Zapraszam do zajrzenia do dodatkowych materiatéw, na konicu tej ksigzki (Rozdziat 5, "Szczegdtowa
weryfikacja planéw samolotu”, str. 126). Dla "pobudzenia apetytu" pokazuje rezultat weryfikacji rzutu z boku
(Rysunek 2.4.3):

Inny obrys H
statecznika | ———

A o) ‘ m
A B o U -

M

Nieco mniejsza
wy soko$¢é ogona
Krawedz steru jest

- _/ Poprawiony
Plytsza chtodnica profil ptata ok. 10 cm blizej

Rysunek 2.4.3 Korekty rzutu z boku, naniesione po doktadnej weryfikaciji

Czerwonymi liniami oznaczytem réznice. Jest ich sporo, nieprawdaz?

Podsumowanie

o  Warto jest ujednolici¢ szerokos¢ i wysokos¢ poszczegdlnych rysunkéw samolotu (str. 46). Takze potozenie
sylwetki samolotu wzgledem lewego gérnego naroznika rysunku powinno by¢ takie samo.

e Rysunki mozna podda¢ dalszej weryfikacji, polegajacej na doktadnym poréwnaniu ksztattu ze zdjeciami
(str. 126). Nie jest to jednak niezbedne.
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Szczegoly obstugi programoéw

Zawartos¢ tej czesci bardzo przypomina zawarto$é plikéw podpowiedzi do trzech programéw: GIMP, Inkscape i
Blendera. Sg tu zestawione opisy tych polecen, ktére zostaty wykorzystane w poprzednich czesciach ksigzki. Z
zalozenia bedziesz z nich korzystat wyrywkowo (por. ,Jak czyta¢ te ksigzke?”, str. 11). Nie doszukuj sie wiec w
kolejnosci rozdziatow i sekcji tej czesci jakiejs przemyslanej metody wprowadzania w obstuge programu. Do
tego stuzy czes¢ pierwsza — ,Budowa modelu”. To tam specjalnie dobratem kolejno$é prezentowanego mate-
rialtu w ten sposdb, by$s mogt stopniowo poznawa¢ wszystkie potrzebne zagadnienia.

Gdy zdecydujesz sie wydrukowaé te ksigzke dla wlasnych potrzeb, proponuje pozostawi¢ tg czes¢ w postaci

elektronicznej. W przeglagdarce PDF szybciej znajdziesz podang w czesci pierwszej strone, niz kartkujgc gruby
wydruk. (No i zuzyjesz mniej drzew z lasow...).

© Witold Jaworski, 2009 - 2015.



50 Szczegdty obstugi programoéw

Rozdziat 3. GIMP — szczegobly obsfugi

Nazwa GIMP pochodzi, jak sgdze, od pierwszych liter angielskiego Graphic Image Processor. Jest to jeden z
pierwszych, duzych i ukohczonych projektow Open Source.

Wirtualne modelarstwo — wydanie trzecie www.samoloty3d.pl



Rozdziat 3 GIMP — szczegdty obstugi 51

3.1 Instalacja

Pobierz ze strony http://www.gimp.org/downloads/ plik instalacyjny i uruchom go (do przeprowadzenia tej ope-
racji musisz mie¢ uprawnienia Administratora). Program instalacyjny wyswietla najpierw sie okno dialogowe
pozwalajgce ustali¢ jezyk w jakim bedg wyswietlane poszczegdlne ekrany (Rysunek 3.1.1a), a nastepnie ekran
startowy (Rysunek 3.1.1b):

a) b)
rInstaller Language u1
Q Please select a language.
f
[Engish -
[ ok | [ cancel |

Zmiana jezyka
programu
instalacy jnego

Zmiana domy$lnych

parametréw instalacji

Rysunek 3.1.1 Instalacja GIMP — pierwsze dwa ekrany

Jezeli chcesz np. zmieni¢ folder programu — przejdz do Customize. Na jednym z ekrandw, ktore sie woéwczas
pojawig, mozesz na przyktad zmieni¢ folder w ktérym zostang umieszczone pliki programu. Potem wrdcisz na
ekran startowy.

Ja jednak proponuje zainstalowa¢ GIMP bez jakiejkolwiek zmiany domysinych parametréow: nacisnij od razu
przycisk Install. Spowoduje to rozpoczecie catej operacji (Rysunek 3.1.2a):

Installing
Please wait while Setup installs GIMP on your computer.

Completing the GIMP Setup
Wizard

Setup has finished installing GIMP on your computer., The
application may be launched by selecting the installed icons.

Remember: GIMP is Free Software. Click Finish to exit Setup,

Please visit

http: //www.gimp.or
for free updates.

Extracting files...

L |
C:\....\share\gimp\2. 0\themes\Defaultjmagesipreferences\folders-tools-22.png

Rysunek 3.1.2 Dalsze ekrany programu instalacyjnego

Po zakonczeniu kopiowania plikow i rejestracji komponentéw program instalacyjny wyswietli ekran koncowy
(Rysunek 3.1.2b).

© Witold Jaworski, 2009 - 2015.
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Potem mozesz uruchomi¢ GIMP. Na poczatku pojawi sie okno startowe (Rysunek 3.1.3):

Ta operacja moze za
pierwszy m razem

Wyszukiwanie plikéw z danymi trwaé kilka minut
Czcionki {moze to zajaé kika minut

Rysunek 3.1.3 GIMP — okno startowe

Pierwsze uruchomienie GIMP trwa zazwyczaj najdtuzej — przez minute lub dwie program rozpoznaje swoje
komponenty. Gdy otworzg sie gtéwne okna, proponuje od razu zmieni¢ jezyk interfejsu z polskiego na angielski.

Dlaczego? Wiekszos¢ ,samouczkow” do GIMP, ktére mozesz znalez¢é w Internecie, opisuje ten program w jezy-
ku angielskim. W tym jezyku jest prowadzona jest takze wiekszo$¢ forow dyskusyjnych. Bedziesz mogt o wiele
tatwiej i szybciej przyswaja¢ sobie wszelkie wskazéwki na temat tego programu gdy bedziesz oswojony z jego
.miedzynarodowg” nomenklatura.

Jezyk przetacza sie bardzo tatwo (Rysunek 3.1.4):

a | Edytor obrazéw GIM b
Plik Edycja Zaznaczenie Widok Obraz Warstwa Kolory Nar 3. Otwérz Interfejs
" por sko
% Cof S B Interfes Interfejs uzytkownika
@ Panow Ctrlsy | Interfejs
@ Zanikanie. |1. Rozwin menu Edycjal EJM"W _—
— gzyk systemowy
o Wytnij Ctrl+X Opcje narzedzia
— . Podglady
i Skopiuj 2. Przejdz do ustawien ':[H]‘ [ Przybomik el kanaton et
Pt . o anatdw i war
SkUPf“J widocfne™ | programu (Preferencje) (ML [ Domysiny obraz =odglady
O Wkl Gl o Domyélny rozmiar podgladu warstwy i kanatu:
B Whlei do Domy:lna siatka
o J___ ) Rozmiar podgladu nawigacyjnego:
Wklej jako 4 = EI Okna z obrazami =]
Bufor L4
& Wyczyse Delete C
fypetnij Jolorem pierwszoplanowym Ctrl+,
[ Wypetnij kolorem ta Ctrl+. T
.- = i . Interfejs uzytk ik
I Wypetnijdeseniem Ctrl+; Interfejs i il
@' Rysuj wfdhuz zaznaczenia... ﬂl Motyw
& Rysuj wzdhuz Sciezki... .@. .
) System pomocy P
% Preferencie UA ) ) angielski [en_US]
Opcje narzedzia
'":ﬂ Urzadzenia wejsciowe Podglady
[ Skrty klawi Przybornik
roty klawiszowe .
P dt-"'- IG5 Domysiny abraz 4. Zmien jezyk GIMPJarstw
# Moduly na angielski adu warstwy i kanatu:
& Jednostki | Domyélna siatka
P Cne— Rozmiar podgladu nawigacyinege:

=] El Okna z obrazami

Rysunek 3.1.4 Ustalanie jezyka programu

1.
2.
3.
4,

Wirtualne modelarstwo — wydanie trzecie www.samoloty3d.pl

otworz okno Edycja=Preferencje (Rysunek 3.1.4a);

w oknie Preferencji przejdz do sekcji Interfejs (Rysunek 3.1.4b);

zmienh Jezyk z Jezyk systemowy na angielski (w wersji amerykanskiej: Rysunek 3.1.4c);
nacisnij OK aby zamkng¢ okno Preferencje, po czym zamknij GIMP i otw6rz go ponownie.
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Domyslnie GIMP otwiera trzy okna: jedno na obraz i dwa ,harzedziowe” (Rysunek 3.1.5):

&

ol Options WSl & GNU Image Manipulation [

File Edit Select View Image Layer Colors Tools Filters Windows Help

)

£

'

@
w/

e
L=

Okno obrazu

LI

& QPpE >
@Ef{
eESmB -

T N B N
BN @

L

Toal Options =

Airbrush

Okna przy bornikéw

Maode: Normal

Rysunek 3.1.5 Trzy domysine okna GIMP

Mysle, ze do srodowiska Windows bardziej pasuje program zawarty w pojedynczym oknie. Przetgczmy GIMP w
taki tryb opcjg Windows-=> Single-Window Mode (Rysunek 3.1.6):

File Edit Select View Image Layer Colors Tools Filters Windows Help |

Recently Closed Docks 4
Dockable Dialogs L4
Toolbox Ctrl+B

Toolbox - Tool Options
Kliknij tutaj aby Layers - Brushes

wigczy ¢ te opcje )
Hide Docks Tab

= Single-Window Mode

Rysunek 3.1.6 Przelaczenie GIMP w tryb pojedynczego okna

Gdy ta opcja jest wigczona, GIMP wyswietla wszystkie swoje panele w pojedynczym oknie (Rysunek 3.1.7):

4 GNU Tmage Manipulatio

=
E
]
B
a
&
Y
I

Recently Closed Docks ’
b= Dockable Dialogs v
: ______ B ~ 8 : Toolbex Curl+B !
; ~ 1 B
R s e Hide Docks Tab lml!
1 .
i& Py s,: v Single-Window Mode !
L ]
e A s, |
A E ~# S : !
1 t |
o(L)a & w! :
:@ G o o ' i
|
A T Obszar obrazu !
1 L] : |
Tool Options : 2 R4 8 & 8 :
irbrush T
ode: | Narmsl E = : Eﬁlﬁ‘ E:
1
] -
1 2 Hardness 050 (51 = 51)
Eamsn | - " :
=l - — —_—
i | Panele przy bornikéw Lov e g
==t Ee@x

1

|aspect | £ | _—
; |
dal |l LA R A
(Angle | oo & i \ B DI - P,
Dynamics | Basic - :
Pressure Opaciy [ 8 I ol
b _h Hmang mov|

I!T| Dvnamics Options I — —
&E 8 £ _ﬂwm enzbled GIMP is in a single-window mode. DS 8 & :ﬂ

Rysunek 3.1.7 GIMP w trybie pojedynczego okna
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Po zainstalowaniu GIMP, mozesz takze pobra¢ z tej samej stron (http://www gimp.org/downloads/) pakiet insta-
lacyjny rozbudowanego systemu podpowiedzi (Help). Rysunek 3.1.8a) pokazuje pierwszy ekran, jaki pojawia

sie po uruchomieniu tego instalatora:

| |5 Setup - GIMP Help 2.8 I | [ 15 Setup - GIMP Help 2.8 [
Select Destination Location
gh:lcoqu to Ehe GIMP Help 2.8.1 Where shouid GIMP Help 2.8, 1 be inctalled?
etup Wizar !
This will install GIMP Help 2-2.8.1 on your computer. ] Err T e A B A e 2 fold
etup willins elp 2.8.1into the following folder.
Itis recommended that you dose all other applications before
. continuing. To continue, dick Next. IF you would like to select a different folder, dick Browse.
. .
] -' - ~J Click Next to continue, or Cancel to exit Setup. =

Atleast 32.2 MB of free disk space is reguired.

P e =

Rysunek 3.1.8 Pierwsze dwa ekrany instalacji podpowiedzi
Na kolejnym ekranie (Rysunek 3.1.8b) mozna ustali¢ folder w ktérym zostang umieszczone pliki systemu pomo-
cy.

Na kolejnym ekranie (Ready to Install — Rysunek 3.1.9a) nacisnij przycisk Install aby rozpoczaé kopiowanie

plikéw:
a) (15! Setup - GIMP Help 2.8 ol =] | [ 1) Setup - GIMP Help 2.8
Ready to Install .
Setup is now ready to begin installing GIMP Help 2.8.1 on your computer, % Completl_ng the GIMP HEIp 2.8.1
Setup Wizard

Click Install to continue with the installation, or dick Back if you want to review or Setup has finished installing GIMP Help 2.8. 1.on your

change any settings. computer.,

Destination location: - Click Finish to exit Setup,

C:'Program Files\GIMP 2 A
‘

e 'J
.

[] b

l < Back ][ Install ] [ Cancel ]

Rysunek 3.1.9 Instalacja GIMP — ekrany: rozpoczecia operaciji i finalny

Instalacja systemu podpowiedzi konczy sie ekranem finalnym (Rysunek 3.1.9b).
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3.2

Wprowadzenie

tadowanie wszystkich komponentéw zajmuje Gimpowi pare sekund podczas uruchamiania. W tym czasie po-
kazywane jest "okno startowe" (Rysunek 3.2.1):

Starting Extensions
extension-script-fu

Rysunek 3.2.1 Okno startowe GIMP — pokazuje postep tadowania komponentéw

Po zakonczeniu fadowania, ujrzysz gtéwne okno programu (Rysunek 3.2.2):

File Edit Select View Image Layer Colors

Tool Options

Airbrush
Mode | Normal

—
Brush
|| 2 Hardness 050

=

ot |

e |

Dynamics

Pressure Opacity
Dynamics Options
[] appty Jitter

[[] smooth stroke

D Motion only

Tools Filters Windows Help 1

L Menu rozwijalne

Przy bornik z
narzedziami

Panel z
parametrami
aktualnego

Kilka paneli
dialogowy ch

narzedzia

Obszar na obrazy

|Pasek stanu | ﬂ
X

Rysunek 3.2.2 Domysiny ekran GIMP (2.8, tryb pojedynczego okna)

Obszar posrodku okna to miejsce na obrazy. Po jego obu stronach sg umieszczone panele dialogowe z przybo-
rami rysunkowymi lub innymi pomocami. Paneli dialogowych jest w programie duzo, i mogg by¢ tgczone w za-
ktadki (jak te z prawej strony przyktadowego okna).

Obszar paneli mozesz zawezi¢ (nawet do zera), jezeli bedzie Ci brakowaé miejsca na ekranie.

© Witold Jaworski, 2009 - 2015.
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Rysunek 3.2.3a) przedstawia wazniejsze elementy okna przybornika (Toolbox) i panelu z opcjami narzedzi (do-
mys$inie umieszczonego z lewej strony okna):

panelami dialogowy mi

Aktualnie wy brane

a) | b)
1
1
:
1
Narzgdzia do| @- - -
/ F ? ! Ten niepozorny przy cisk
|/ @% E edy cji obrazu e@ A: rozwija menu sterujgce
1
1
1
1
1
1

1
narzedzie jest tak|i = “ = = & & : &,
gggz;metl:lr;eé,wittlg - @ : = To polecenie usuwa
. - aktualng panel (zaktadke)
jego parametry u I

cale No .o =
¥&| Teol Options @ |:||:| |::> 74 Tool Options hMenu [
Add Tab >
¥ CloseTab I}‘
&% Detach Tab

L e Locl_cTabto?Ioc\ To polecenie ,wyjmuje’

aktualng panel w oddziel

Rectangle Select
Mode: | 8§ l_. E

Wybér  biezacej barwy
(barwa tfa jest pod spodem)

[T Cormers Tab Style ne okno (o ile nie jest to]
v Show Button Bar jedy na panel w obszarze)
D Expand from center -
[] Fieed: | Aspect ratio v B3] Move to Screen 3
1:1 (8] [
Position: pxv
Paosition: px v o

Rysunek 3.2.3 Przybornik i panel dialogowa

Przyjrzyj sie nagtéwkowi obszaru zaktadek w oknie Toolbox. Jest tam, po prawej stronie, taki niepozorny przy-
cisk ,strzatki”. Gdy w niego klikniesz — otworzysz menu rozwijalne sterowania panelami (Rysunek 3.2.3b).
Pierwszg jego pozycjg jest submenu, odpowiadajgce aktywnej zaktadce tego zestawu. (Na tej ilustracji zestaw
zawiera pozycje o nazwie Tool Options).

e Jezeli w obszarze masz wiecej niz jedng panel, mozesz kazdg z nich ,wyciggngé¢” w oddzielne okno ,pty-
wajgce” ponad ekranem. Stuzy do tego polecenie Detach Tab z menu panelu.

Polecenie Close Tab zamyka aktualng zakfadke (jezeli byta to ostatnia zaktadka — zniknie caty obszar).

Zajmijmy sie jednak innym poleceniem z tego menu: Add Tab. Jest to zagniezdzone menu, prezentujgce do
wyboru wszystkie dostepne zaktadki (Rysunek 3.2.4a). Gdy wybierzesz z tego menu jedng z zaktadek (np.
Layers — ksztatty narzedzi), GIMP doda jg do przybornika (Rysunek 3.2.4b):

% 4| Tool Options b) a,
il mll

Ay Device Status L0

PSR &| Tool Opti Layers (=
2 TooOtons ey v |2 Lo [|D|::> £ oo Optere| 5
F
Channgls Mede: Norma /

. AddTab ' ;

# CloseTab Paths ‘om / m:u:l:

a)

s
T
8

[ % Detach Tab Colormap
Lock Tab to Dock Histegram N\ Z menu Add Tab mozesz
[ ) ) wybraé  nowg  panel,
Tab Style > Selection Editor ktorej potrzebujesz do
[ v Show Button Bar &, Mayigation pracy
[ I S e |
El Move to Screen 3 Qj Undo History :Panel Layers wy$wietla Iiste:
. Iwarstw rysunku. Gdy 2aden:
N [y Pointer irysunek nie jest jeszcze
Pasttion: pxY Gy s | otwarty, ta lista jest pusta |
0 (o E || rmmmmmmmmmmmmmmme- !
B, Colors

=___ -

Rysunek 3.2.4 Dodawanie do przybornika dodatkow ej zaktadki
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Na ekranie mozesz mie¢ otwartych kilka obszaréw z panelami. Panele mozna przenosi¢ pomiedzy obszarami
metoda ,przeciagnij i upus¢”, tapiac” myszka (M) za zaktadke (Rysunek 3.2.5):

Y PONEXY
&%@@ﬁil’

G @%gii/ sop -

1 T 2 Hardness O75 (57 = 57)

JZtap” myszka (
zaktadke panelu, prze- + .- —
ciggnij ja w nowe miejsce,

i tam ,upusc’ . . j.*
ﬂ ;§*§
%%%@@

BB o+ @

Rysunek 3.2.5 Przenoszenie pojedynczego panelu pomigdzy obszarami dialogowymi

e Jezeli nie chcesz przez nieuwage przeciggng¢é myszkg jakiego$s panelu — mozesz wytgczy¢ mozliwosé
takiego przeciggania, wkgczajgc w jego menu (por. Rysunek 3.2.3b) opcje Lock Tab to Dock.

Postugujgc sie tymi poleceniami mozesz w skompletowaé zaktadki, ktére sg Ci potrzebne do pracy. Wydaje mi
sie, ze do naszych celéw na razie wystarczg trzy: Tool Options, Brushes i Layers (por. Rysunek 3.2.6):

File Edit 5Select View |mage Layer Colors Tools Filters Windows Help

Aby zmieni¢ szeroko$¢
obszaru z panelami, mozesz
JZtapaé” myszkg () ich
granice i przeciggngé w
prawo lub lewo

B M @ 3 2
BXND o

cARTE
ERNPEND
ﬁ‘?éﬂﬁa@/

I

Tool Options @Bmsm

2 Hardness 075 (51 x 5%)

Rysunek 3.2.6 Sugerowany uktad ekranu
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o Jezeli brakuje Ci miejsca na ekranie, mozna przenies¢ wszystkie potrzebne panele na jedng strone ekranu,
a potem szerokos$c¢ przeciwlegtego obszaru zmniejszy¢ do zera.

W centrum okna programu wyswietlany jest edytowany obraz. Rysunek 3.2.7 przedstawia kilka istotnych ele-
mentéw tego obszaru, ktore pojawiajg sie gdy wczytates$ istniejgcy plik lub stworzytes nowy:

= Llayer Colors Tools Filters Windows Help
B_)q M I BT |°. T R N |10'p°| L1 |M| PR I N T T |3°'|)0| & gLayers
°d [e— ) P i odd Ta opcja wigze zmiang)
- e " e, | rozmiaru  obrazu  ze
] Ts = ) ! zmiang rozmiaru okna
1 ==t 2 e Y| Llock ¥
] == :
4 N @
7] LLinijki": pozioma o [
En —|i pionowa : . |
&} |
o] :
0 1
1 |
1 |
1 |
= 7 |
01 1
(1] 1
o |
- 1
1 ! Alternaty wne okreslanie
\I:V?po:rzedne i Jednostki Iinijel; ’ | widocznego na ekranie|
ursora ] i kursora - i i obszaru obrazu
3 o HNCR !
1] b F! T - :hﬂ_ - n :
99 . Aktualne pomniejszenie /|, !
\ ] powiekszenie ry sunku !
] | (mozesz wybra¢ z listy|=~" "~ v
e lub wpisac
|l £ < wpi ) >[

-152, 2192 O

Rysunek 3.2.7 Hementy obszaru obrazu

W GIMP mozesz naraz otworzy¢ wiele obrazéw. Kazdy z nich zostanie umieszczony w odrebnej zaktadce
(Rysunek 3.2.8). Mozna takze ten sam obraz otworzy¢ w kilku zaktadkach (View > New View).

Zaktadki poszczegolny ch
obrazéw. W kazdej wida¢
miniaturke zawartosci

Layer Colors Tools Filters Windows Help

— 4

—=j Layers

Ten przy cisk zamyka

:.; %‘j 59 U@ﬂ gﬁ obraz Mode: Morm
AnseA+ - [
4 Lock g
,;:;_,, L B ﬁ B @
. s
<Ipogy - WON 10V
O £& a8
= IO 4
I
Tool Options @Bmshﬁ! =
Rectangle Select - .
Mode: Il EED
+f| Antizlizzing
M- .
Rysunek 3.2.8 Praca z wieloma obrazami naraz
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o Jezeli chcesz widzie¢ rézne obrazy lub fragmenty obrazu w oknach ustawionych obok siebie — wytgcz
opcje Windows 2Single-Window Mode.

Jednym z typowych elementéw interfejsu uzytkownika sg kontrolki umozliwiajgce okreslenie jakiej$ ograniczonej
wartosci (np. intensywnosc¢ jakiego$ efektu). Podstawowym problemem w przypadku takich elementéw jest po-
godzenie mozliwosci szybkiej i tatwej zmiany za pomocg myszki z mozliwo$cig wpisania doktadnej wartosci. We
wczesniejszych wersjach programu starano sie to umozliwi¢ za pomocg zespotu dwéch kontrolek: suwaka i pola
tekstowego (Rysunek 3.2.9a). W wersiji 2.8 GIMPa potgczono te dwa elementy w catos¢ (Rysunek 3.2.9b):

a) i’ Do okreslania % nieprzejrzy stosci stuzyt b) Kontrolka tgczaca funkcije
zespodt suwaka i pola tekstowego suwaka i pola tekstowego —
Lay = Layers =]
Mode: | Mormal v Meode: Mormal W
wapeeaininininininink 2inininininininininininininini= TP 1 | o]
Cpacity _] 100.0 || | Opacity ’ma =
___________________________________ L) \ I
Lo CTHE oo S oot |
= GMP26 | GIMP 2.8 |

Rysunek 3.2.9 Nowy rodzaj kontrolki — potaczenie suwaka i pola tekstowego

W takag kontrolke mozna wpisa¢ za pomocg klawiatury doktadng wartos¢ — podczas pisania zachowuje sie tak,
jak klasyczne pole liczbowe (Rysunek 3.2.10a). Alternatywnie mozesz takze przesunaé pasek wartosci klikajgc
myszka w gérng krawedz kontrolki (Rysunek 3.2.10b). Przeciggniecie granicy paska wzdiuz dolnej krawedzi
pozwala uzyskac drobniejsze zmiany (Rysunek 3.2.10c):

Mozesz tu wpisa¢ doktadng warto$é
(ciemniejszy pasek z lewej dopasuje sig do

niej gdy klikniesz w inng kontrolke) /_ Mozesz takze zmieniac
warto$¢ co 1, klikajac W
a) ; N te strzalki
Opacity 75
AEREN
! \
T 1
b) Opacity I’\ Gdy klikniesz w goérng krawedz, granica

paska (warto$¢) przesunie sie w to miejsce

Przeciggnij krawedz paska wzdiuz dolnej

krawedzi aby dokona¢ jakich$ drobniejszy ch,
©) |opsery A, 7 |Kaweda aby dokona oo

bardziej precy zyjny ch poprawek

Rysunek 3.2.10 Szczegoty obstugi nowej kontrolki zakresu

Dialogs  Filters W GIMP polecenia z palety narzedzi (przybornika) sg dostepne

EL | Rectangle Select N takze poprzez menu Tools (Rysunek 3.2.11). Twércy programu
Paint Tools e |y .. . . .
Transform Tools £ |Blipse Select E | pogrupowali je tam w kilka submenu: Selection Tools, Paint
—— ‘olar Tools & |Eree Select F| Tools, Transform Tools. W tek$cie ksigzki fatwiej i bardziej
I | Paths B @ . L . . . L. .
- . i |Fareground Select jednoznacznie jest mi podawac¢ polecenia z menu, niz umiesz-
a‘* Colar Picker O %, |Fuzay Select u , . vy e . . .
czac¢ obrazki ikon do naci$niecia. Bede wiec powotywat sie na
=y | Zoam Z || "8 |y Color Select Shift+0 | < Jezeli wolisz k tac bornik p
. naz olecen. Jezeli wolisz korzysta¢ z przybornika — otwoérz
£ | Measure Shift-+M 4 | mkeligent Scissars I wy p y przy
Betre{Te ikony znajdzesz| T 7._ ; tylko raz podane przez mnie menu, aby upewniC si¢ o ktorg
T tszew”rzyb””'k”*“ Fr--Eeo- ikone chodzi. (Sg zawsze widoczne obok napiséw) Gdy juz
Default Colors o rozpoznasz ten symbol — uzywaj przybornika.
| % | Swap Colors b

Rysunek 3.2.11 Menu Tools (okno obrazu)

e  Wszystkie programy w tej ksigzce pokazuje w wersji anglojezycznej. GIMP ma takze dobre ttumaczenie na
jezyk polski. Program instalacyjny domysinie wgrywa odp. wersje narodowa (patrz str. 51 i dalsze).
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3.3 Otwieranie pliku (obrazu)

Aby otworzy¢ obraz, wybierz z menu polecenie File=>Open
(Rysunek 3.3.1).

Spowoduje to pojawienie sie okna dialogowego wyboru pliku
(Rysunek 3.3.2). Okno to nie przypomina standardowego
okna Windows. Dzieje sie tak dlatego, ze GIMP uzywa do
obstugi okienek zestawu komponentéw o nazwie GTK+!. Tak
wiasnie wyglada w GTK+ komponent do wyboru plikow.

Tu mozesz|
wpisa¢ recznie
nazwe pliku

Lista folderow/
dy skow

File | Edit Select View [mage Layer Colors Tools
] New.. Ctrl+M
Create 4
|E’; Open... N Ctrl+O
= Openas Layers.!’.‘g Ctrl+Alt+0
@ Open Location...
Open Recent L4
Save Ctrl+5
Save As... Shift+Ctrl+5
Save a Copy...
Revert

Rysunek 3.3.1 Otwarcie istniejagcego obrazu

Documents | Model | P40 || Rysunki Mpfestsf/_ folderu

odpowiedni przy cisk

~
&} Recently Used
[ me
[ Desktop
<. SVSTEM (C3)
» LENOVO (D)
# Stacja dyskéw DV...
- USER (L)
[ Pictures

[ Documents

MName
) AT FSUDSDULLUITLLL

=] AJ-PADB-Front.tif
«f] AJ-PADB-Left tif
<] AJ-PADB-Left-2.tif
« AJ-PADB-Right.tif
«] AJ-PADB-Top.tif
«d] PA0-org-fre.tif

«] PA0-org-LT tif

«d] P40-org-RB.tif

*| P4D-org-ver.tif

Select File Type (Automatically Detected)

Help

Rysunek 3.3.2 GIMP — okno wyboru plikow

Aktualna $ciezka. Mozesz przej$¢ do
klikajac ~ w|

nadrzednego,

~ Size Modified 4 »

10, KD £ULG-Ue 1Y
188.7 kB 2008-08-19
229.4 kB 2008-08-18
196.0 kB 2008-08-21

Pliki w aktualnym
ffolderze

649.5 kB 2008-08-18
645.1 kB 2008-08-31
938.6 kB 2008-08-19
12MB  2008-08-21

All images

Open

Preview

Podglad
m— Zaznaczonego
P4g-org-ver.tif pliku

12 MB
2480 » 3437 pixe
Grayscale, 1 lzye

Cancel
L

GIMP rozpoznaje wiele réznych formatéw zapisu obrazu. Po nacisnieciu Open zataduje wskazany w oknie dia-

logowym plik.

o Istnieje takze prostsza metoda na zatadowanie obrazu. Gdy GIMP nie zawiera zadnego obrazu, mozesz
Jprzeciggna¢” myszka jakis plik z obrazem do okna GIMP, i tam go ,upuscic¢”.

e Pliki *tif, *jpg lub *.png nie przechowujg informacji o warstwach. Dlatego gdy GIMP importuje ich zawar-
tos¢ uzywajac polecenia File >Open, tworzy pojedynczg warstwe nazwang tak samo jak importowany plik.

! GTK+ jest bibliotekg procedur Open Source pozw alajgca na pisanie programéw , ktdre beda dziataly w w ielu réznych systemach operacyj-
nych, m. in. Linux, Window s, Mac OS. Posiada naw et polska w ersje jezykow g!
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3.4 Zapisanie pliku (obrazu)

W obecnej wersji GIMP polecenie File->Save As pozwala zapisa¢ obraz tylko we wlkasnym formacie programu
(*.xcf). Uzywaj go wtedy, gdy chcesz zapisa¢ obraz w tej postaci, i/albo jako plik o zmienionej nazwie. Jezeli
chcesz zachowa¢ obraz w innym formacie (np. *jpg, *png, *tif,...) nalezy uzyé polecenia File=>Export As
(Rysunek 3.4.1):

File | Edit 5Select View Image Layer Colors Tools Filters Windows Help

1 New.. Ctr|+Na-lululoulululululmlulul|I|
Create v L]
= Open... Ctrl+0 } ]
@? Open as Layers... Ctrl+AR+0 |1 - - —
- |Polecenia Save i Save As zapisujg
@ Open Location... 1 |obraz w wytgcznie w formacie GIMP
Open Recent v ] |(xeh)
:E Save Ctrl+5 || 1
\ -
. 1
:E Save As.. Shift+ Ctrl+S [ B Uzyj polecenia Overwrite... by
' _SaveaCopy.. _________ / i1l |zmodyfikowa¢ oryginalny plik z
r ] |ktoérego odczytano aktualny obraz
S -
Revert | | (traktuj je jako odpowiednik polecenial
:_ Overwrite P40-org-ver.tif : - | Save z poprzednich wersji programu) L—r:
W 1 1
P | -
Export As... Shift+Ctrl+E || | F
| P %‘\ | Uzyj polecenia Export As gdy[! ]
Create Template... | | chcesz zapisaé plik w innym formacie?—e_;‘_‘-,,?
— | |niz ten, w ktoérym go odczytate$ (to: T
- Page Setup - |odpowiednik Save As z poprzednich| |
= Print... Ctrl+P | 1 |wersji programu) T T

Rysunek 3.4.1 R6zne metody zapisywania pliku

Kazde z nich spowoduje to pojawienie si¢ okna (Rysunek 3.4.2), podobnego do tego, w ktérym wybierali§my
plik do zatadowania (por. Rysunek 3.3.2, str. 60):

Tu wpisz nazwe dla nowego pliku. GIMP rozpoznaje

Mame: PAOB-J)-Lefttif € A . . :
format zapisu po rozszerzeniu, ktére nadajesz!

Save in folder | 4 ||[Cime || Documents | Model || P40 || Rysunki| AlPress Create Folder

Places MName Modified Preview

, Search [ AJPress 16:34

& Recently Used [ Bates 2014-01-26

[ me [5) Cockpit 2014-01-26

[ Desktop 5 Cownding 2014-02-01

L SYSTEM (C:) [~ Engine 2014-01-26
- LENOVO (D%) [ Fuselage 2014-02-01
# Stacja dyskdéw DV... [ Gear 2014-02-0 Mo selection
- USER (U:) [~ Kagero 2014-01-26

[ Documents [ Raw poniedziatek

L

= T A AT N

All export images . Ustal za pomoca ty ch narzedzi folder

do ktérego chcesz zapisa¢ plik

Select File Type (By Extension)

Help Export % Cancel

Rysunek 3.4.2 Okno zapisywania do pliku

W oknie Export Image (Rysunek 3.4.2) wybieramy folder, do ktérego zapiszemy rysunek. Wpisujemy takze na-
zwe pliku. Bardzo wazne jest takze wpisanie wtasciwego rozszerzenia pliku — np. .png, .tif, albo .jpg. (GIMP
okresla sposob zapisu obrazu na podstawie rozszerzenia pliku, ktére podasz). Na koniec nacisnij na w oknie
Export Image przycisk Export.
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W zaleznosci od formatu zapisu, ktéry wybrates, GIMP
moze jeszcze pokaza¢ pomocnicze okno, z dodatkowy-
mi opcjami. Rysunek 3.4.3 pokazuje takie okno dla for-
matu TIFF. Mozna tu ustali¢ sposdb kompresji obrazu. kompresji obrazu
Wybieraj zawsze opcje LZW. (Nie sprawdzatem innych, '

Wybierz tg¢ opcje

Pack Bits

ale LZW jest bardzo popularng metodg, i poprawnie ) Deflate

wczytuje sie do Blendera).

) IPEG

CCITT Group 3 fax

Po nacisnieciu kolejnego przycisku Export, nasz rysu- CCITT Group 4 fax

nek zostanie ostatecznie zapisany na dysku.

Save color values from transparent pixels

o Gdyby GIMP wys$wietlit komunikat o braku mozli- Comment: | |

wosci zapisania informacji o przejrzystosci w pliku

TIFF, wywotaj polecenie Image->Flatten Image i Help LCancel

sprobuj jeszcze raz.

Cuality:

File size: 2429 kB : -
Im wyzsza jako$¢
obrazu, tym wigkszy
rozmiar pliku

Show preview in image window

Wigcz te opcjg, by w oknie
GIMP widzie¢ obraz — tak, jak
bedzie zapisany

Rysunek 3.4.4 Okno dodatkowe — zapis w formacie JPEG

W przypadku zapisu do pliku PNG (Rysunek 3.4.5) pozo-
stawiaj poziom Compression level na najwyzszej warto-
$ci (9). W odréznieniu od JPEG, PNG (podobnie jak TIFF)
jest tzw. formatem bezstratnym”: przechowuje oryginalne

Rysunek 3.4.3 Okno dodatkowe — zapis w formacie TIFF

Inne okno dialogowe wyswietla sie dla zapisu w postaci
pliku *jpg (Rysunek 3.4.4). Format JPEG pozwala uzy-
skac¢ pliki o najmniejszym rozmiarze, ale za pewng cene:
pogorszenia jakosci obrazu. W modelowaniu stosuj go
tylko wtedy, gdy pliki ktérych uzywasz — tekstury, rysunki
referencyjne — nie mogg by¢ zbyt duze. Podczas zapisu
do JPEG powiniene$ znalez¢ kompromis pomiedzy roz-
miarem pliku a jako$cig obrazu. Stuzg do tego kontrolki w
oknie Export Image as JPEG. Gdy je stosujesz, wigczaj
opcje Show preview in image window. Sprobuj zmnigj-
szy¢ wartos¢ Quality ponizej 90. W oknie dialogowym
bedziesz widziat jak zmniejsza to rozmiar pliku, a w oknie
gtéwnym GIMP — jaki ma to wptyw na obraz. W ten spo-
sob szybko dobierzesz odpowiednig wartos¢.

[] save background coloer

warto$ci kazdego piksela obrazu. W takim przypadku [ save gamma
najwyzszy poziom kompresji nie wptywa na jakos$é, a po- [] Save layer offset

zwala uzyskac najmniejsze pliki.

Save resolution

Save creation time

o W przypadku formatow PNG i JPEG mozesz uzyc¢ Pozostaw  najwy zszy

o K 4 _
przycisku Save Defaults by zapamieta¢ typowe pa- pocon o ranspent pixels
rametry zapisywania, jakie stosujesz. Od tej pory Bomp==sioalleset of ¢

GIMP bedzie je proponowat od razu.

Load Defaults Save Defaults

Wirtualne modelarstwo — wydanie trzecie
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3.5 Kadrowanie obrazu

Wybierz z menu polecenie Tools>Selection Tools>Rectangle Select, (lub nacisnij na klawiaturze E). Prze-

suwajgc myszke z wcisnietym , zaznacz obszar dookota rzutu z boku (Rysunek 3.5.1).

Ao

ooo—-l
| el

[=Y=T=T.¥

Rysunek 3.5.1 Zaznaczenie rzutu z boku

~

Zaznaczony
obszar

Nastepnie poleceniem Image=Crop to Selection ogranicz caly obraz do zaznaczonego obszaru (Rysunek

2

3.5.2):
Image | Layer Colors Tools Filkers Windows
&8 Duplicate Ctrl+D

Mode 3
Transform 4

Canvas Size...

[ Fit Canvas to Layers
Fit Canvas to Selection

! @ Print Size...
= Scale Image...

Ao ﬁ}p to Selection

tocrop Image
Zealous Crop

Merge Visible Layers... Ctrl+M
Elatten Image

Align Visible Layers...
Guides 4
| [F] Cenfigure Grid...

) Image Properties Alt+Return

I

g

|
2Ny

Rysunek 3.5.2 Odcigcie reszty obrazu

Layer Colors Teols Filters Windows Help
|0I|I|I|I|I|m|l|l|I|I|1Q:)plllll|I|1?:)pllllllllzwlllllll'|i-ﬁ
] A
s

0]

0

[l

[=T=TE)

[=Y=T=T

\4
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3.6 Linie pomocnicze (guides)

Linie pomocnicze (guides) stuzg do oznaczenia jakiego$ istotnego miejsca, a takze poréwnan.

Aby doda¢ do rysunku linie pomocnicza, "ztap" myszkg () za linijke, umieszczong ponad obrazem. Trzyma-
jac przez caty czas wcisniety przesuh jg do dotu. Zobaczysz wowczas, ze przesuwasz poziomg linie po-
mocniczg (Rysunek 3.6.1):

== PAQ)-]]-| eft.tif-1.0 {grayscale, 1 layer) 2472x728

File Edit Select View Image Layer Colors  Tools Dialogs Filters
|E||'3.|.|.|.|.|25'? 1509 50, _ 11350 v ML |.|1Tﬁ'3.|.|.|.|2W'3.|.|.|.|22$U.|.|.||3§5
. Tu wmsnu PM

EI Curtiss Tomahawk Il A

] '-'.era|c. [OZPOZNaweza, W kadlub=kcl1'=ra
5] F 24 o ogniskowe] 336 mm,
5] .. i trzy majac weisniety
0] przesuwaj

. my szke w dét.
£
D_
0
s 3
1577, 186 ||3x v” 35 v Hndd Guide: 186

Rysunek 3.6.1 "Pobranie” linii pomocniczej
Gdzie zwolnisz ("upuscisz" linie pomocniczg), tam zostanie. Nie jest czg$cig obrazu. Mozesz jg powtornie
ztapa¢ myszka i przesung¢ w inne miejsce. (Jezeli nie reaguje na myszke — nacis$nij na klawiaturze @ aby

przejs¢ w tryb przesuwania).

W podobny sposdb pobierz takze kolejne linie pomocnicze, tym razem pionowe, z linijki po lewej stronie obrazu.
Umies$¢ je na kluczowych liniach konstrukcyjnych, o ktérych wiesz, Zze powinny by¢ pionowe lub poziome
(Rysunek 3.6.2):

Linie pomocnicze, uzywane do

sprawdzania linii pionowy ch —

Cyrtiss Tomahawk Il A

wieisjs rozpgznawcza, w kadiubee kame

4 ¢ ognigkowe] 356 mm,maszt anier
[ g ——

ngfﬂ —
[
|

]

f-—

Rysunek 3.6.2 Przyktadowe rozmieszczenie linii pomocniczych

e Aby usung¢ linie pomocnicza, przesunh jg z powrotem tam, skad jg ,wyciagnates”: do linijki ponad obrazem
(linie poziome) lub z lewej strony (linie pionowe)
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3.7 Widok: powiekszanie, przesuwanie
W GIMP powiekszenie mozna zmieni¢ na dwa sposoby (Rysunek 3.7.1):
- szybko i mniej doktadnie: trzymajac wcisniety @ i obracajgc kotkiem myszKki (M);
- doktadnie, ale nie tak szybko: wybierajac z listy u dotu ekranu jedno z predefiniowanych powigekszen,
lub wpisujgc bezposrednio nowg wartos¢ w jej pole tekstowe;

800 %
400% —
200% [EHE
~ | 100% BT

T 503 [TTTTT T ] 7 O - =
] 2% Vetoda szy bka wy bierzz sty | S — T e .

189% jedng z  predefiniowanych
18.9% wartos$ci powiekszenia

[STSTE R
]

188%
< 125%

v i_ Es:rsE] PA0-org-ver4if (27.2 MB)
-0

— ]

1

[ 3
)

Tu mozesz wpisa¢ doktadng
warto$¢ powiekszenia

Rysunek 3.7.1 Trzy metody zmiany powiekszenia (Zoom)

Przesunigcie widoku to ruch myszki z weisnigtym SZI (Rysunek 3.7.2):

. I
[
- |
- |
H ' | ~
o 4
= / 6 o &
:E! Przesuwanie: J'x
1]
o T -
- - S
] - = :
iy S
B = Oczy wiscie, mozna takze f———
] - postuzyé sie paskami
przewijania Metoda
.2 15 /e alternaty wna
L v,
[N ¢ >
P 0% v PAD-org-ver.tif (27.2 MB) M

Rysunek 3.7.2 Przesuwanie widoku (Pan)

Oczywiscie, mozna sie takze postugiwaé paskami przewijania, ale w wiekszosci przypadkéw to najmniej wy-
godna metoda.
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Alternatywng metoda przesuniecia obrazu jest wykorzystanie kontrolki w prawym dolnym rogu obszaru obrazu
(Rysunek 3.7.2). Gdy nacisniesz ja myszkag (), otworzy sie miniaturka obrazu z zaznaczonym widocznym

obszarem (Rysunek 3.7.3):

Il

Przesuwajgc biaty obszar po
miniaturce, przesuwasz obraz,

w oknie gtéwny m

e 70% | v PAD-org-ver.tif B)
Rysunek 3.7.3 Alternatyw na metoda przesuwania widoku (Pan)

Wystarczy ruch myszki, by przesuna¢ obraz. Ta metoda jest szczegdlnie przydatna w przypadku pracy w duzym
powiekszeniu.
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3.8 Zmiana rozmiaru obrazu

Aby zmieni¢ rozmiar obrazu (np. powiekszyc¢), uzyj polecenia Image->Canvas size... W oknie dialogowym,
ktére sie pojawi (Rysunek 3.8.1), roztgcz powigzanie pomiedzy wysokoscig i szerokoscig (przycisk z "ogniwa-
mi"). Potem np. zwieksz wysokos¢ (Height).

€ Set Image Canvas Size E
- Set Image Canvas Size
2 pdn-orgRE GFE =

1. Kliknij tu, by rozlgczy ¢

Canvas Size zmiany  wysokos$ci i

wiidth: | 2480 © @ szerokos$ci
o ~ )
2. Tu wpisz nowag Height: 212000' == b I | pixels 4 |
. b pixels
wy sokosé 300 ppi

Offset
X
W |362 |3 | pixels v| [ Center

I | |3. Ztap i przesun () miniature
I rysunku, dopasowujgc do nowego
nowa =
wy soko$¢ stara ) obszaru
l wy soko$¢ =i T

Layers

Resize lavers: |AII layers v|
4. Wybierz z listy wartos¢
- All layers
Help Reset Resize

Rysunek 3.8.1 Okno zmiany rozmiaru obrazu

Nastepnie przesun ([55) miniature aktualnego obrazu, aby przestrzen, ktérg dodajemy, znalazta sie w odpo-
wiednim miejscu. Gdy skonczysz, nacisnij przycisk Resize.

Na koniec nie zaszkodzi wywota¢ polecenie Layer->Layer to Image Size.
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3.9 Warstwy — zarzadzanie

Warstwy w GIMP mozesz sobie wyobrazi¢, jako oddzielne powierzchnie przejrzystej folii. Kazda z nich moze
zawiera¢ oddzielny obraz. Obrazy te naktadajg sie na siebie (Rysunek 3.9.1). Do zarzgdzania warstwami stuzy
zaktadka Layers, dostepna w przyborniku.

Layer Colors Tools  Filters Windows Help

E! ooy oo 1599 1999 ) e g 509 290 [ Layers =
7 . s

i Mode: Mormal W
b Warstwa o nazwie |0 i 1|1u:{‘
] P40-JJ-Left.tif =
_ / Lx.cN

B - I

) / . & . - PADB-J)-Left.tif

@ PAD-JJ-Right.tif

Warstwa o nazwie
P40-JJ-Right.tif

Rysunek 3.9.1 Warstwy — na obrazie i w zaktadce Layers

Zaktadka Layers zawiera liste warstw, oraz kilka pomocniczych kontrolek. Rysunek 3.9.2 wyjasnia, jak sie nig
postugiwac:

Tryb ,mieszania”  Zz
Layers / pozostaty mi warstwami
Regulacja nieprzejrzy sto- / N\ Otwiera menu
$ci  (Opacity) aktualnej hode: Marmal W zarzadzania
warstwy ~ warstwami

-

e -~y
Opacity Warstwa pod$wietlona to 100.0
warstwa aktywna i

Tu kliknij, aby zablokowaé || Lock y g .

zmiany warstwy E—

Aby zmieni¢  kolejno$é
warstw, zlap () jedng
z nich i przesun w nowag
pozy cje

Tu kliknij, aby ukry¢ lub A PAD-1)-Right.tif

pokaza¢ warstwe

Znacznik ,powigzania” z
warstwg akty wna.
(Méwigc szczerze, nigdy
go nie wy korzy statem)

E ¢« &+ ® ¢ 8

Rysunek 3.9.2 Funkcje zaktadki Layers

Warstwy mogg zastania¢ sie wzajemnie. Jak w Swiecie rzeczywistym, obowigzuje zasada, ze warstwa lezgca
wyzej zastania warstwe lezgcg nizej. Stad, w przyktadzie na ilustracji (Rysunek 3.9.1), warstwa P40B-JJ-Left.tif
zastonita obraz na warstwie P40B-JJ-Right.tif. Te nieprzejrzystos¢ mozna jednak zmniejszy¢. Stuzy do tego
suwak Opacity, umieszczony powyzej listy warstw (Rysunek 3.9.2).

Kolejno$¢ warstw takze mozna zmieni¢ — wystarczy "ztapac¢" pojedynczy wiersz i przesung¢ w nowe poto-
zenie na liscie (Rysunek 3.9.2).

Na licie Layers zawsze jedna warstwa jest pod$wietlona na niebiesko. To warstwa aktywna.

e Prawie wszystkie polecenia, ktére wywotujesz w GIMP (rysowanie, usuwanie, transformacje, filtry, itp.)
dotyczg wytgcznie zawartosci warstwy aktywnej! Pozostate warstwy nie ulegajg zmianie.
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Warstwa moze by¢ powigzana (z warstwg aktywng). Takie powigzanie powoduje, ze mozna przesuwac (m,
por. str. 83) zawartos¢ kilku warstw naraz. Do wigczenia/wytgczenia blokady stuzy ikona "tancucha", po lewej

stronie nazwy warstwy (Rysunek 3.9.2). To powigzanie nie dziata jednak podczas innych transformacji — np.
obrotu, ani malowania. Osobiscie nigdy go nie uzywatem?.

Warstwe mozna ukryé. Stuzy do tego ikona "oka", umieszczona z lewej strony nazwy kazdej warstwy. Piksele
warstwy mozna takze zablokowac¢ przed zmianami. Stuzg do tego opcje Lock (w nagtéwku listy warstw — por.
Rysunek 3.9.2).

Aby zmieni¢ nazwe warstwy — kliknij w nig dwukrotnie. W wierszu pojawi sie chwilowe pole edycji, w ktérym
bedziesz mégt jg poprawic.

Na koniec moze wyjasnie, pochodzenie nazw warstw w przyktadzie pokazywanym przez Rysunek 3.9.2:
P40B-JJ-Right.tif — gdy wczytujesz plik obrazu w typowym formacie rastrowym: JPEG, PNG, TIFF,
GIMP umieszcza jego zawarto$¢ na pojedynczej warstwie. Nadaje jej takg nazwe, jak na-
zwa wczytanego pliku.
P40B-JJ-Left.tif — warstwa powstata poprzez wczytanie dodatkowego obrazu (File>Open As Layer,
por. str. 71). GIMP nadaje w takim przypadku nazwe wczytanego pliku.

Inng ciekawg funkcjg jest mozliwos¢ grupowania warstw, ktérg wprowadzono w wersji 2.8 GIMP. Aby dodaé

nowa grupe wywotaj polecenie Layer>New Layer Group., lub Kkliknij ikonke foldera u dotu okna warstw
(Rysunek 3.9.3a):

a) o Layers ] b) Layers = C) Layers
Mode: Normal W Maode: Maormal W Mode: Normal W
= I N Gdy grupa zawiera jakie$ N

mlﬁl. Grupy sg jak warstwy — 5140 warstwy, jej miniaturka poka- 142

mozna je przesuwaé i
zmieniac nazwe

zuje efekt ich ztozenia

<0 — Layer Group ; /-Linespng
[ o=
-t e ”U o — |
1&}5:_ Uvilines png s Reflectivity HU
7 | reftsmoke R £F-Smoke
Kliknij w te ikonke, by wstawi¢ Prze’n’n)'-,\s (p;zemz‘qg(?u‘ i
now: ust ru rzed upusc)  odpowiednie, adows —
owa (pusta) grupe p warstwy do wnetrza Ref-Shadaws Warstwa _przeniesiona
biezaca warstwg grupy do grupy Reflectivity
< H Color-concrete.jpg i B - Color-concrete.jpg a0 olor-concrete.jpg
= . Caolor-screws.png < . Caolor-screws png < . Color-screws.png
<3 - Color-Chips s - Celor-Chips - = - Color-Chips
"2 M
Color-Dirt " a0 Color-Dirt v >

¢ 4 I

o

B8

= i

2

=

& @

Rysunek 3.9.3 Grupow anie warstw

Spowoduje to wstawienie nowej grupy ponad warstwg aktywng. Taka pusta grupa jest reprezentowana przez
ikone folderu. Podobnie jak warstwy, mozesz jg przesuwacw gore i w dot, a takze zmienia¢ nazwe. W przykfa-
dzie pokazywanym przez Rysunek 3.9.3b) przesungtem jg do dotu i zmienitem nazwe na Reflectivity. Nastep-
nie przesungtem (metoda ,przeciggnij i upus¢”) do jej wnetrza odpowiednie warstwy (Rysunek 3.9.3c).

' Méw igc szczerze, przez diugi czas myslatem, ze w tgczenie tej ikonki ,taricucha” blokuje w arstwe przed zmianami! Jezeli naw et na jakich$
ilustracjach w tymrozdziale bedziesz w idziat wtgczong opcje pow igzania, to nic to nie znaczy.
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Grupy warstw mozna np. wykorzysta¢ do uporzgdkowania pliku skin.xcf, w ktérym przechowuje trzy zestawy
warstw: jeden dla tekstury odbi¢, drugi dla tekstury barwy, i trzecig — z plikami referencyjnymi (schemat barw,
rozwiniecia UV). Trzymam te warstwy razem, gdyz tekstury barwy i odbicia swiatta zalezg od siebie nawzajem
(np. namalowane zabrudzenia muszg by¢ bardziej matowe). Plik powstat we wczes$niejszych wersjach GIMP, w
ktorym grupowania jeszcze nie byto. Do tej pory musiatem pamietaé, jakie warstwy ukryé, aby wygenerowac
teksture barwy, a jakie — aby uzyskac teksture odbi¢. Pomagatem w tym sobie nadajgc nhazwom poszczegdl-
nych warstw przedrostki — Ref-* dla sktadnikow tekstury odbi¢, i Color-* dla sktadnikéw tekstury barwy. Teraz
mogtem stworzy¢ dla wszystkich sktadnikéw tekstury odbi¢ grupe Reflectivity, do ktérej poprzenositem odpo-
wiednie tekstury Ref-* (Rysunek 3.9.4a):

a) Layers b) Layers ]
Fr - - - =
Mede: Nermal v | Mode: Muttipty N vl
1
‘Opamy mml_ :|Opa|:ity b | 435':
Grupa rysunkow
oce & referencyjnych
— moze pozostac Zawarto$¢  grupy  jest
sr-ja | U¥-Linespng waczona traktowana jak warstwa —|

mozesz jej zmienia¢ tryb
Mode i nieprzejrzy sto$¢

UV-Linespng

V\(ylaczer)ieA i E UV-Color.png
widoczno$ci grupy
wylgcza jej calg
zawarto$¢ T\’[:] 27 | reectiy Widocznos$cig poszcze-
w ; gg’)lnych rysunkc'?W_ odpie—
jghr i ) sienia  wygodniej  jest
i ;{: Y Ref-Dirt sterowa¢ iny widualnie
|
1 1
:;Q{: Ref-Smoke
Przeno$ kolejne ! '
warstwy Ref-* " - { !
na koniec grupy Color-screwspng Z\Il(ra:'\el]e Chvw!/lvidgz I‘_?_{-: Ref-Shadows
Reflectivity zawartos¢ tekstuy
o 7 Caolor-Chips barwy —_— | = . Color
"% | &7 N 5 ¥
> >
B o+ & F & @ = ¢ 5 & 8
Rysunek 3.9.4 Przykiad potaczenia warstw w grupy
Zawartos¢ pliku GIMP podzielitem na trzy grupy (Rysunek 3.9.4b):
Reference Grupa zawiera warstwy z rysunkami referencyjnymi. Takie obraz powinny by¢é zawsze

widoczne, stad jest umieszczona u gory, i ma wigczony tryb (Mode) na Multiply. Jedno-
czesnie, aby zaden z rysunkéw referencyjnych nie byt za bardzo kontrastowy, zmniej-
szytem przejrzystos¢ (Opacity) tej grupy. Grupa jest zawsze widoczna, bo wtgczam w
jej srodku widoczno$¢ tej warstwy, ktora jest mi w danym momencie potrzebna;
Reflectivity Grupa zawiera warstwy z obrazem tekstury odbi¢.
Color Grupa zawiera warstwy z obrazem tekstury barwy;

Od tej chwili, gdy chce wyeksportowac z pliku teksture odbi¢, wystarczy ze wytgcze widocznos¢ grupy Color i
Reference. Podobnie w przypadku eksportu tekstury barwy. Nazwy grup pozwolg mi szybko zorientowaé sie w
strukturze, chocbym do tego pliku zajrzat po wielu latach.

Zwrd¢ uwage, ze nazwy grup sktadowych nadal majg przedrostki — Ref-* i Color-*. Przyczyna jest prosta:

e  Grupy warstw to nie foldery plikéw: nadal kazda warstwa GIMP musi mie¢ unikalng nazwe w obrebie cate-
go pliku, niezaleznie od tego do jakiej grupy nalezy.
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3.10 Dodanie warstwy (z innego pliku)

Wczytamy zawartos¢ drugiego pliku jako dodatkowy obraz, do nowej warstwy. Zazwyczaj chodzi o to, aby nato-
zy¢ na siebie dwa rysunki, i je poréwnac. Dlatego pokaze od razu, jak ustawi¢ czesciowa przejrzysto$é warstwy
z wczytanym obrazem.

e Aby efekt przejrzystosci byt mozliwy, aktualny rysunek nie moze zapisywaé barw jako tzw. indeksowanych
koloréw. Jezeli w menu Image->Mode zobaczysz, ze twdj rysunek ma wigczony tryb Indexed, musisz to
zmieni¢. Najlepiej bedzie, jezeli wywotasz polecenie Image>Mode > Grayscale, To zmieni odwzorowanie
barw na 256 odcieni szarosci. Mozesz takze przetgczy¢ sie w tryb barwny — Image >Mode > RGB, .

Zataduj drugi plik jako nowg warstwe: File=>Open as Layers. W oknie dialogowym wyboru pliku znajdz i wskaz
obraz — powiedzmy, ze nazywa sie P40B-JJ-Left.tif.

W efekcie zobaczysz w oknie obrazu obydwa rysunki. Wczytany obraz przykryt dotychczasowy (Rysunek
3.10.1):

= L |':'. [ [ NI I |5?3| PR I B |‘-D|DD| M . 2 |‘ﬁ':'3| PR I NI |1'Q:‘3| PR I N |2 et Layers =
o] iy T > — 2

74 Tu mozna zmniejszy ¢ Mode: Normal

L

4 W
] ; nieprzejrzy sto$¢ warstwy
b / = *Opac’lty 10&4_
i J fi J Zatadowany, obraz jest

. ) &
w warstwie dodanej ,na #
wierzchu” 3

a0 PAD-1)-Right.tif

[=1=10]

: ]
—_— —
== |

|
|
|
1
|
|
= |
=
1

|

|

|

1

|

|

Oryginalne  warstwy
sg pod spodem

Rysunek 3.10.1 Dodana do rysunku warstwa z nowym obrazem

Otworz w przyborniku zaktadke sterujgcg warstwami (Layers — Rysunek 3.10.1). Widac tu liste z dwoma wier-
szami. Kazdy z nich to jedna z warstw. Dotychczasowa zawarto$¢ rysunku znajduje sie na warstwie P40B-JJ-
Right.tif. Druga warstwa nosi nazwe obecnie wczytanego pliku. Efekt ,natozenia” obydwu rysunkéw na siebie
wzigt sie stad, ze warstwa P40B-JJ-Left.tif znajduje sie powyzej warstwy P-40B-JJ-Right.tif, i po prostu jg
zastania.

e Domysina nazwa warstwy to nazwa oryginalnego pliku *fif, *jpg lub *.png, ktéry otworzyliSmy w GIMP —
nie tylko poleceniem File>Open as Layers, ale takze zwyklym poleceniem File >Open. GIMP traktuje ob-
raz z takiego pliku jak obraz importowany z obcego formatu, ktéry zawiera jedng, domysing warstwe. Aby
ta warstwa nie byta ,bezimienna”, nadaje jej takg samg nazwe jak nazwa importowanego pliku

Teraz zmienimy przejrzystos¢ warstwy P40B-JJ-Left.tif. Upewnij sie, ze jest podswietlona na liScie Layers
(oznacza to, ze jest aktywna). Nastepnie zmieh wartos¢, ustawiong na suwaku Opacity, np. z 100 na 40
(Rysunek 3.10.1).
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Zobaczysz, ze spod spodu zaczng "przeswitywac" linie warstwy P40B-JJ_Right.tif (Rysunek 3.10.2).

AR R L= S

@
=
o
=]

=
=
| =
=)
=]

.JF?.UQ.l.l.l.PS.UDl.l

[ Y b |

] ~ )
0] L

Rysunek 3.10.2 Efekt zwiekszenia przejrzystosci gornej warstwy obrazu
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3.1 Dodanie warstwy (pustej)

ew Layer sune ST,
yer (Ry ) * Seme e e | ]
|

W polu Layer name wpisz nowg nazwe warstwy. Sposrdéd grupy opcji 7
Layer Fill Type wybierz sposdb wypetnienia tta warstwy. Zazwyczaj Laver name: |Mask| [
wybieram tto w pehni przejrzyste (Transparency). Widtht t
Height:  |2827 | | b v |

Po nacisnieciu OK nowa warstwa zostanie stworzona. :
Layer Fill Type

) Foreground colar Pozostaw wypeinieniel

() Background col transparentne
O white

@ Transparency

l Help l I oK ] [ Cancel

Rysunek 3.11.1 Tworzenie nowej warstwy
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3.12  Usuniecie warstwy

Warstwe mozesz usung¢ na dwa sposoby:

£ Layers

1. Poleceniem Layer>Delete Layer. Usuwa aktualng Moge: Norms!

warstwe (zawsze sie upewnij, ktora jest aktualna...) ‘OM ,,,ml‘

2. W zakladce Layers. Podswietl wiersz, odpowiadajacy

warstwie, ktorg chcesz usung¢. Nastepnie naciénij
przycisk z ikong kosza (Rysunek 3.12.1).

oce & B0

& =+ PADB-N Top.tif

Podswietl te warstwe

i nacisnij ten przy cisk
@ PAOB-J)-Left.tif

W B # L L] sl %

Rysunek 3.12.1 Usuwanie warstwy (zakladka Layers)
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3.13 Rysowanie

Rysowanie pokaze na przykfadzie "z zycia wzietym": na poétprzezroczystej warstwie narysujemy ksztatt kadtuba.
Linie rysunku wzorcowego, do ktérego mamy sie dopasowaé, sg widoczne na warstwie lezgcej pod spodem
(Rysunek 3.13.5 pokazuje, co ma by¢ narysowane).

Nim zaczniesz rysowaé, upewnij sie, ze tryb koloru twojego rysunku jest ustawiony na RGB. W razie czego —
przestaw go w ten tryb (Image=>Mode >RGB). Inaczej zamiast czerwonego bedzie szary!

Zacznijmy od momentu, gdy warstwy sg odpowiednio ustawione. Przed rozpoczeciem rysowania czesto zmie-
nia sig aktualny kolor. W tym przypadku wybierz czerwony (Rysunek 3.13.1):

AQR[[ATH([AN] [ [A]M] 2

e L

HTML notation: | 11818

-

&

2. Kiliknij tutaj,

by otjworzyjé — |} . . . .

okno  wyboru

barwy ... 3.... iwybrac kolor
czerwony

Beset oK

Rysunek 3.13.1 Ustalenie aktualnego koloru

Z palety narzedzi wybierz "pedzelek" (Tools=>Paint Tools=>Paintbrush z menu, albo E na klawiaturze). Na-

stepnie ustal forme narzedzia (Rysunek 3.13.2), oraz jego rozmiar (Rysunek 3.13.3):

Tool Opticns Brushes Tool Options Brush-E =
- Paintbrush
2 Hardness 100 (57 = 51) Mode: | Mormal w

Wy brany . - ™ |0pa|:ily lmcl‘
ksztatt d + + + * he
. ’ i . Brush
A + * s *’!‘E’+ 2. Hardn Wy brany @
. R e iar (40 -
5oe® P e
= § TRy . ry

+
R g& o g aspect Ratio 0007 §
L TR G MRL N +
LY e

o, A : Angle onf| §
&8 e e Iv — |
g 5 ; 5 3 . Pressure Opacity &
+ + *
Dynamics Options
~" gﬁ a ey [] appty Jter
A 'ﬁ; * @ % \:: [] smoocth stroke
i (s e ﬁ . gy, ‘ [] incremental
‘w %+ é.‘+ T T +
Rysunek 3.13.2 Wybor ksztattu "pedzelka” Rysunek 3.13.3 Ustalenie rozmiaru rys owania
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W trybie rysowania, gdzie tylko nacisniesz , na rysunku pojawi sie okragta "plama". Obrysowanie kadtuba
najwygodniej jest wykona¢ za pomocg krotkich odcinkéw linii prostych. Aby zaczagé takg sekwencje, kliknij
w naroznik obszaru, ktéry chcesz zaznaczy¢. Nastepnie przesun myszke trzymajgc wcisniety (Rysunek
3.13.4). Widzisz, ze ciggniesz koniec prostej linii? Gdy trzymasz wcisniety , GIMP zawsze tgczy aktualne

potozenie kursora z koncem ostatnio narysowanej linii. W ten sposéb mozesz szybko i doktadnie narysowac
ksztalt przysztej selekcji.

oA i} ] . . . ll@

208, 1301 ||3x w || 150%: W |I6?.3 pixels, Click to draw the line {(Ctl For constrained angles)

Rysunek 3.13.4 Rysowanie prostymi odcinkami

"Ciggnieta" w ten sposéb linia zakonczy sie tam, gdzie klikniesz . Po obrysowaniu ksztattu nalezy zamalo-
wacé wnetrze obszaru (Rysunek 3.13.5):

Rysunek 3.13.5 Do wypetniania wnetrza wygodniej jest zmieni¢ rozmiar narzedzia na wigkszy

Jezeli pomylisz sig i narysujesz cos, czego nie powiniene$ — uzyj polecenia Edit>Undo ([CtriHZ]).

e Jezeli na rysunku masz juz zaznaczony obszar selekcji — GIMP pozwoli Ci rysowac¢ tylko wewnatrz tego
obszaru. Mozesz go wiec wykorzystywa¢ do celowego naktadania ograniczen (np. aby na pewno zadna li-
nia nie wystawata poza zatozony obrys).
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3.14 Usuwanie fragmentéw obrazu

Do usuniecia czegos z obrazu stuzy "gumka": Tools=>Paint Tools=>Eraser . Znajdziesz jg takze w oknie przy-
bornika, pod odpowiednig ikong (Rysunek 3.14.1). Mozesz takze skorzysta¢ ze skrétu na klawiaturze: @-@
Po wybraniu narzedzia, wybierz jego ksztalt z zaktadki Brushes. (Rysunek 3.14.1). W zaktadce opcji narzedzia
ustal rozmiar (Size — Rysunek 3.14.2):

ﬂ

s ASE S
.28

&

, &
E4

LN
alb®

&

il

\ 1. Wigoz tryb §4| Tool Options Brushes =
usuwania Eraser
ol Mode: | Morma

¥ 0| Teol Options E-rusr'es ] Opacity 1

3. Dobierz odpowiedni
rozmiar narzedzia

1ire hd Brush
2 Hardness 100 (51 = 51) 2. Wybierz najwieksze| . 7 Tess 100

kok
— > iz 1T| "393?:
. . * ’ ﬁa@ ‘AspectRa‘lin | 000 f
£ & W R |Angle | 000 f
Rysunek 3.14.1 Wybér narzedzia ("gumki") i jej ksztattu Rysunek 3.14.2 Wybo6r rozmiaru gumki

-

[

L2

Teraz juz mozesz wymazac z rysunku to, czego nie ma na nim by¢ (Rysunek 3.14.3):

Curtiss Tomahawk Il A
wersja rozpoznawczs, w kadiubas kamera
bl F 24 o ogniskows] 156 mm maszl aneny

Tu  pojawiaja  sig GIMP zmienia kursor,
podpowiedzi do tego, .
w sy mbol gumki

co aktualnie robisz!
= W
i< >

2053.2, 689.9 | puv 304%|V D Click to erase (try Shift for a straight line, Ctrl to pick a background color)

Rysunek 3.14.3 Wymazywanie z rysunku niepotrzebnych elementow

Gumka $ciera, gdy trzymasz wcisniety . (Ta zasada obowigzuje w Gimpie dla kazdego narzedzia: pedzla,
aerografu, itd.). Jezeli pomylisz sie i zetrzesz cos, czego nie powiniene$ - uzyj polecenia Edit=>Undo (@]—E).

e Jezeli na rysunku masz juz zaznaczony obszar selekcji — GIMP pozwoli Ci usuwa¢ obraz tylko wewnatrz
tego obszaru. Mozesz go wiec wykorzystywa¢ do celowego naktadania ograniczen (np. aby na pewno nie
usunaé niczego wiecej).
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3.15 Zaznaczenie obszarem prostokatnym

Zaznaczanie obszaru wyboru za pomocg prostokata jest w GIMP najprostszg formg selekcji. Nacisnij na klawia-
turze klawisz E]l lub wybierz z menu polecenie Tools>Selection Tools>Rectangle Select:

1.Tu weisnij [, by
wskazac poczatek
prostokata

e
s

o2 Trzy méjac weisniety

, przesuwaj my szke

N

| A

R i R 3. Tu zwolni — by zazna- / B

PURPPS T ST, J

~yczy ¢ krance wy branego obszaru

Rysunek 3.15.1 Zaznaczenie obszaru selekgcji

Rysunek 3.15.2 pokazuje wybrany obszar. Nadal mozna go jeszcze zmieni¢ (powiekszy¢, pomniejszy¢). Stuzg
do tego uchwyty w naroznikach obszaru. (Sg tak duze, ze trudno ich nie zauwazy¢):

Za te uchwyty mozesz "zlapac"

(IS5 myszki i przeciagnaé. To
najszy bsza metoda zmiany
obszaru

Rysunek 3.15.2 Prostokatny obszar wyboru

Aby wytgczy¢ obszar selekcji — wystarczy wywotaé polecenie Select>None.
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3.16  Zaznaczenie obszarem nieregularnym

Narzedzie dla ludzi o pewnej rece! Wybierz polecenie Tools>Selection Tools>Free Select (lub El z klawiatu-
ry). Zacznij rysowa¢ zamkniety obszar (Rysunek 3.16.1):

i
\ 1. Tu zaczynasz
e

nacién (@] F—=—""_

2. Rysujesz, trzy majgc

I / wcisniety
: L

g:.;)

Rysunek 3.16.1 Rysowanie granic obszaru selekcji

Obszar po zamknieciu jest obrysowany linig przerywang (Rysunek 3.16.2):

Rysunek 3.16.2 Przyktad nieregularnego obszaru sele kcji

Aby wytaczy¢ obszar selekcji — wystarczy wywotaé polecenie Select>None.
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3.17  Zaznaczanie — narysowanym obszarem

W GIMP obszar selekcji moze by¢é dowolng plama/plamami. Moze takze mie¢ rozmyte krawedzie. Takie efekty
mozesz uzyskac tylko w jeden sposdb: malujgc obszar selekcji, tak jak maluje sie jakis ksztatt.

o Narysowanie obszaru selekcji nie zadziata, jezeli rysunek jest zapisany w trybie tzw. indeksowanych barw.
Aby mie¢ pewnosé, ze wszystko bedzie poprawnie, przetgcz go w tryb RGB (Image>Mode > RGB).

Pokaze, jak to zrobi¢ na przyktadzie opisanym w pierwszej czesci tej ksigzki (str. 42). Chodzi o objecie scisle
"przylegajacg” selekcjg rysunku tylnej czesci kadtuba samolotu. Linie rysunku znajdujg sie w tym przyktadzie na
warstwie o nazwie P40B-JJ-Top.tif.

Obszary selekcji bedziemy malowa¢ na oddzielnej warstwie, ktérg stworzymy wytgcznie dla tego celu. Wywotaj
polecenie Layer>>New Layer. Dodaj do rysunku na nowg warstwe, o nazwie Mask (szczegdty — str. 73). War-
stwa musi by¢ zupetnie przejrzysta. (Podczas tworzenia, w oknie dialogowym New Layer, okresl kolor tta jako

Transparency).
Rysunek 3.17.1 pokazuje, jak nalezy przygotowaé uktad Lavers ©
warstw (szczegoly - str. 68): Modis: Normal — Z\éagsbt,‘;vio\;zm:'z orem v
- Ukryj wszystkie inne warstwy poza Mask i P40B-JJ- |°F‘“"" / 1009
Top.tif; woe g8/
- Przesun warstwe ze wzorcem ksztattu do narysowania — @ 4 PADEB-1)-Top.tif

P40B-JJ-Top.tif — ponad Mask;
- Ustaw nieprzejrzystos¢ P40B-JJ-Top.tif na 50%, by wy-

ﬁ Mask Mask — aktywna

godniej dopasowac rysowany ksztatt do linii kadtuba; = PAOB-1J-Left.tif
- Podswietl Mask, aby stata sie warstwg aktywng. AN k] pomosialo
= |warstwy = s 5]

Rysunek 3.17.1 Zmienione uporzadkowanie warstw

Po ustaleniu stanu warstw nalezy na warstwie Mask obrysowac i wypetni¢ (szczegdty — str. 75) ksztatt kadtuba
(Rysunek 3.17.2):

el

| E =

Rysunek 3.17.2 Rysowanie ksztattu selekcji
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81

Na koniec zmien narzedzie na "gumke" (Tools=Paint Tools>Eraser, z klawiatury [Shift E]). Ksztatt narzedzia

pozostaw bez zmian, za to rozmiar przestaw na 1.0. Uzyjemy go do drobnych wygtadzen i korekt narysowanego

ksztattu, np. wymazania naddatku linii (Rysunek 3.17.3).

k.

-

1

1
" Wy mazany naddatek
-

S S N

Ik

Rysunek 3.17.3 Koncowe przygotowania - wymazanie "naddatkow"

Pozostaje zmieni¢ narysowany ksztatt w selekcje. Wywotaj polecenie: Layer> Transparency>Alpha to

Selection.

| to wszystko. Na koniec porzadkujemy warstwy (Rysunek
3.17.4):
- ukryj Mask (mozna by jg byto usunagé, ale moze sie
przydac przy nastepnym takim przypadku);
- odkryj inne warstwy (te, ktére sg potrzebne do dalszej
pracy);
- podswietl warstwe, na ktérej chcesz co$ zmieni¢, za
pomocg aktualnie wybranego obszaru (np. P40B-JJ-
Top.tif). (Stanie sie w ten sposéb warstwg aktywna)

=

Mede: Normal

@
[v]

ATF |

5000

Ukryj warstwe
Mask
Leck
ock /[ B P40B-JJ-Top.tif

dost d i
/ . Mask ostepne do zmian

= = P40B-J)-Left.tif

O B

Pozostate  warstwy

— widoczne o

Rysunek 3.17.4 Przygotow anie warstw

e W GIMP ksztatt selekcji "przenika" przez wszystkie warstwy. Nie jest zwigzany w szczegdlny sposoéb z
zadng z nich. Dzieki temu warstwa, na ktérej go rysowates, moze by¢ zaraz usunieta
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3.18  Obrét

Jezeli w GIMP jaki$ obszar jest wybrany (selekcjg) — obrot bedzie dotyczyt tylko tego obszaru. Jezeli jednak nic
nie jest wybrane, obracana jest cata zawarto$¢ warstwy aktywnej. Operacje pokaze na przyktadzie wiasnie ta-
kiej sytuacji.

W i Hrll Jezeli wykonujesz obrét po raz pierwszy, warto odpowiednio ustawic
opcje tego narzedzia.

[ Zaznacz je w przyborniku (Rysunek 3.18.1), aby w panelu Tool Options
V4 GIMP wyswietlit aktualne ustawienia operacji Rotate (Rysunek 3.18.2).
& Proponuje wytgczy¢ wyswietlanie siatki linii pomocniczych dla tej ope-
racji, bo jest na tyle gesta, Zze wydaje sie zastania¢ obracany obraz.
Wytgcza sie je wybierajgc z listy rozwijalnej Guides pozycje No guides
Rysunek 3.18.1 Wybér narzedzia Rotate (Rysunek 3.18.2):

-

Ll Przed rozpoczeciem obrotu
— PR l------ I
@ [ zawsze upewnij si¢ ze na obrazie
&i| Tool Options - . . . .
1 Toal Optian EB'”SWS jest odpowiednia przestrzen!
Rotate ]
Transfc:rm: = ﬂ"’:\ g
Directicn
(@) Normal {Fonward) ,:5, L
(") Comective {Backward) °_
Interpolation: _
Cubic W ]
Clipping: N
Adjust v || 0
8
Show image preview ]
Image opacity Wybierz opcje j 1
) — . A
= No guides 4
|Guides T
des £
Mo guide: L 2 o
15 degrees {Ctrl) Tu mozesz zapisaé tef| - > &
E‘Q ustawienie T v 182 % v|P40-org-RE.tif (66.3 ME)

Rysunek 3.18.2 Przygotow anie do obrotu (Rotate)

Przed kazdym obrotem upewnij sie, ze Twdj obraz jest dostatecznie duzy (Rysunek 3.18.2). Chodzi o to, ze
GIMP obraca zawarto$¢ obrazu, ale jego granice (,ramka”) pozostaje nieruchoma. Jezeli obrécisz zbyt niski
obraz, goérna czes¢ po obrocie moze zostaé obcieta, tak jak to pokazuje Rysunek 3.18.3:

b e Ta cze$¢ obrazu
zostata odcigtal!

Obracasz zawarto$¢ I
obrazu, ale jego ramki

pozostajg nieruchome r\
!

.

Rozmiar tego obrazu byt dobrany by obejmowac|- ‘
pochylong sylwetke samolotu. Jego wysokos$¢ jest) ) — i
zbyt mata, aby zmiescita sie na nim sylwetka po e
obrocie ek

Rysunek 3.18.3 Obciecie czesci obréconego obrazu
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e Jezeli chcesz obréci¢ tylko zaznaczony obszar rysunku (aktualng selekcje) — zacznij od wywotania pole-
cenia Select=>Float. W przeciwnym razie bedziesz obraca¢ catg zawartos¢ warstwy aktywnej.

Wywotaj polecenie Tools= Transform Tools>Rotate ([Shift|R|). Pojawi sie¢ dodatkowe okno Rotate (Rysunek
3.18.4). Zauwazysz takze pewne pogorszenie jakosci wyswietlanego obrazu. Linie staty sie mniej gtadkie, gdyz
GIMP przetgczyt sie na wyswietlanie "roboczej kopii" rysunku. Pokazuje teraz, jak bedzie wygladat obraz, gdy
zatwierdzisz ten obrét. (Czyli taki, jaki bytby, gdybys w tym momencie nacisnat przycisk Rotate. Jezeli naci-
$niesz Cancel — zrezygnujesz z calej operacji).

~

|I|I|!ﬂ|_llll|I|I||2W|I|I|I||5?:?|Il“||||?5qllll|I||1?qalllI|I||1g‘rrnll|I|I||1|5.:?3|I|I|I||1?ﬁolllllll\.|l?.qnllllll||1;50|I

el AT I i I T Bl BT

[=T=]

“r---1To jest znacznik $rodka obrotu.

Mozesz go przesuwaé |Hzl

el BT

‘3’ Rotate
Lo P40-org-RB.Aif-2 {[P40-org-RE] {(impored))

=
1l

Angle  [13.35 =

m—-l
| T

Center }; | 2440.37

[=1=)
1

Center ¥: | 791.00

Help

[ ENE

Rysunek 3.18.4 Obrot obrazu (Rotate)

Zwro¢ uwage, ze okno Rotate nie przeszkadza w zmianie powiekszania widoku, ani w przesuwaniu poziomym i
pionowym suwakiem. To bardzo wygodne, gdyz z wigkszg doktadnoscig mozesz obserwowaé zgodnosé linii
pomocniczej i linii na kadtubie samolotu. Podczas obrotu pokazywana jest takze o$ obrotu — kotko z krzyzy-
kiem, wygladajgce jak celownik (Rysunek 3.18.4). Mozesz w kazdym momencie jg ztapac () i przesung¢ w
nowe miejsce.

Obraz mozna obraca¢ przesuwajac myszke z wcisnietym (dobre na pierwsze przyblizenie). Mozna takze
zmieni¢ numeryczng wartos¢ kata obrotu w oknie Roftate, polu Angle (tak najwygodniej wprowadzac ostatnie,
drobne poprawki). Warto$¢ kata w polu Angle zmienia sie takze wtedy, gdy obracasz obraz myszka.

Obrot zatwierdzamy naciskajgc przycisk Rotate.

e Jezeli obracates tylko zaznaczony fragment obrazu (selekcje), po zakonczeniu obrotu wywotaj jeszcze
polecenie Layer=>Anchor Layer ([Ctril{H]).

(To scali "plywajacy" ponad rysunkiem, obrécony obszar z resztg obrazu, i zakonczy catg operacje).

© Witold Jaworski, 2009 - 2015.




84 Szczegdty obstugi programéw

3.19  Przesuniecie

o Jezeli chcesz przesung¢ tylko zaznaczony obszar rysunku (aktualng selekcje) — zacznij od wywofania
polecenia Select>Float. W przeciwnym razie bedziesz przesuwaé catg zawartoS¢ warstwy aktywnej.

Transformacje zademonstruje na przyktadzie, gdzie przesuwam obraz na jednej warstwie tak, by pokryt sie ze
wzorcem (umieszczonym na innej warstwie — Rysunek 3.19.1). Nacisnij na klawiaturze [ﬂ (jest to skrot pole-

cenia Tool 2> Transform Tools>Move). "Ztap" zmieniamy obszar () i przenie$ we wtasciwe miejsce:

o I B S S TR .. S S - TR, Layers [ Channeis
ol |~
- : : Mode Normal v
1 | |Opa|:i1y umzl:
1 | e 4
1 "Ztap" () za obraz i ! ok 4
1 Zary's obrazu przesun go w nowe miejsce ) i - 3 PADB-1J-Left.tif
i L. !
. E WZOrcowego ) Al :
i = |
ik ] | |
1 =T |
- : - |— 1
1! I — | Warstwa aktywna (to jej
; : T i zawartos¢ przesuwamy )
i |
o4, i
of, I
| 1
i i
d. |
1 :
| 1
Rysunek 3.19.1 Przesuwanie zawartosci warstwy
Przesuniecie konczysz, zwalniajac [E:1] (Rysunek 3.19.2):
ol I I - S L. P S S - T T Layers (¥ Channeis &
(1] 1 : s
— : : Mede: Normal W
41 !
4t ' ‘Onau'w “m‘l:
4 : 1
1! Kontury  po : leck g B
1 iaci —_— | o
ok przesunieciu i ST o | s P40B-))-Lefttif
1 |
; | ! an e PAO-1)-Right i
o] |
i !
] .- .
N | 1
| |
4! i
e Przesuwana sy lwetka |
0! | zostata dokfadnie i
g- : ,---"—--\\ umieszczona  ponad i
10 () sy lwetkg wzorcowg i
1 N i
- : — :
i i

Rysunek 3.19.2 Obraz po przesunieciu

o Jezeli przesuwates tylko zaznaczony fragment obrazu (selekcje), po zakonczeniu przesuwania wywotaj
jeszcze polecenie Layer=>Anchor Layer ([Ctril{H]).

(To scali "ptywajacy" ponad rysunkiem, deformowany obszar, z resztg obrazu, i zakonczy catg operacje).
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3.20 Przekoszenie (Shear)

e Jezeli chcesz zdeformowac tylko zaznaczony obszar rysunku (aktualng selekcje) — zacznij od wywotania

polecenia Select>Float. W przeciwnym razie deformacji ulegnie cata zawartos¢ warstwy aktywnej.

-

B 4 2
S o

» >,

3 A
X ] &,

& 8B o @ o

Jezeli wykonujesz przekoszenie po raz pierwszy, warto odpowiednio
ustawi¢ opcje tego narzedzia. Zaznacz je w przyborniku (Rysunek
3.20.1), aby w panelu Tool Options GIMP wyswietlit aktualne ustawienia
operacji Shear (Rysunek 3.20.2).

Proponuje wytgczy¢ wyswietlanie

rozwijalnej Guides pozycje No guides (Rysunek 3.20.2).

Rysunek 3.20.1 Wybor narzedzia Shear

obraz na jednej warstwie do wzorca na drugiej warstwie. Aby podczas
transformacji nie straci¢ ani przez chwile wzorcowego obrazu z oczu,
witgcz w panelu Tool Options opcje Show preview image, oraz zmniejsz
jego nieprzejrzystos¢ (Opacity) do 50% lub mniej (Rysunek 3.20.2). Aby
nie zmienia¢ tych ustawien za kazdym razem, mozesz potem je zapisaé
jako domysline (stuzy do tego ikona dyskietki u dotu tego panelu — por.

Tool Dptians Blushﬁ

Shear
Transform:

Directicn
(®) Normal (Forward)
(") Comective (Backward)

siatki linii pomocniczych dla tej operacji, bo jest na tyle gesta, ze wyda-
je sie zastania¢ deformowany obraz. Wytgcza sie je wybierajgc z listy

Czesto takie operacje jak przekoszenie wywotujemy, aby dopasowac

=

Interpolation:
Rysunek 3.20.2). Cubic v
Clipping: Tg mquszt ’Z{nniejbszyé
Przekoszenie pokaze na przyktadzie transformacji prostokgtnego frag- Adjust gffglz:éfys os¢ obrazy
mentu obrazu. Poniewaz deformujemy selekcje, wywotaj najpierw polece- Shew image preview 1
nie Image—>Float. Potem uzyj Tools=>Transform Tools=>Shear (lub Image opaciy | 387
[shift}{s]). Pojawi si¢ dodatkowe okno Shear (Rysunek 3.20.3). Zauwazysz ”H‘;-“‘gmm —— \;mzcciizgk* -
takze pewne pogorszenie jako$ci obrazu w zaznaczonym obszarze. Linie Tu zapisz te
staty sie mniej gtadkie, gdyz GIMP przetgczyt sie na wy$wietlanie "robo- H & |zmiany
czej kopii" tego fragmentu. Pokazuje teraz, jak bedzie wygladat obraz, gdy Rysunek 3.20.2 Parametry
zatwierdzisz te transformacje. (Czyli gdy nacisniesz przycisk Shear. Jezeli
nacisniesz Cancel — zrezygnujesz z catej operaciji).
B_nI|I|I||IW|I|I|I||IW|I|I|I||EW|I|I|I||Z]W|I|I| |I||Z40'I)|I
@ e o b i
@ I I I
® & 03 7 Q¢ i I
s . It i
ﬁb $ o £ B ] s Ii
Deformowany 4 I
E E @ §| g},’@ 7 |fragment obrazu ,n-" I
. 5] L~ y i
g o @ o ; r l.
l Przez cze$ciowo przejrzy sty obraz
= x ! roboczy widaé oryginalny kontur na

Flosting Selection

Shear magnitude ¥: |0

Help Reset

Show image preview

Shear magnitude X: ||p “\:

-
-

{Floated Layer)-10 {[PA0-JJ-Right] {imported]))

inny ch warstwach ry sunku

Przekoszenie najlepiej
zmienia¢ w
numery czny m

polu

Rysunek 3.20.3 Przekoszenie (poziome)

Cancel
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Polecenie Shear dziata podobnie do obrotu. (Zresztg wszystkie transformacje w GIMP dziatajg w taki sposaéb).
Obecnosé okna Shear nie przeszkadza w zmianie powiekszenia widoku, ani w przesuwaniu pionowy m i pozio-
mym suwakiem. Przekoszenie nie ma, niestety, widocznego $rodka, ktéry mozna by byto przesunaé. Punkt ten
jest staly i znajduje sie w $rodku obszaru selekcji.

Podswietlony na rysunku fragment mozna deformowacC przesuwajgc myszke z wcisnigtym (dobre na
pierwsze przyblizenie). Mozna takze zmieni¢ numeryczng wartos¢ transformacji w oknie Shear, polu Shear
magnitude X (Rysunek 3.20.3) (tak najwygodniej wprowadzaé ostatnie, drobne poprawki). Wartos¢ w polu
Shear magnitude X zmienia sie takze wtedy, gdy dokonujesz deformacji myszkg. Przekoszenie zatwierdzasz
naciskajgc przycisk Shear.

e W GIMP nie mozna wskaza¢ srodka tej transformaciji. Po jej zakonczeniu zmieniony fragment moze leze¢
niezupetnie tam, gdzie trzeba. Potem trzeba go wtedy przesungc (][ﬂ por. str. 83) we wtasciwe miejsce.

Jezeli deformujesz tylko fragment obrazu, wywotaj na koniec polecenie Layer=>>Anchor Layer ([CtriH{H]. To

| S |

scali "ptywajacy” ponad rysunkiem deformowany obszar z resztg obrazu, i zakonczy catg operacje.
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3.21 Skalowanie

Jezeli chcesz zdeformowac tylko zaznaczony obszar rysunku (aktualng selekcje) — zacznij od wywotania

polecenia Select>Float. W przeciwnym razie deformacji ulegnie cata zawartos¢ warstwy aktywnej.

&
.4

+
e Ja
i

:9@
y 4

opcje tego narzedzia.

YR

» P,
B % 2

A
.

L
@™ O

@ B

S 8By oo

Jezeli przeskalowujesz po raz pierwszy, warto odpowiednio ustawi¢

Zaznacz je w przyborniku (Rysunek 3.21.1), aby w panelu Tool Options
GIMP wyswietlit aktualne ustawienia operacji Scale (Rysunek 3.21.2).
Proponuje wylgczy¢ wyswietlanie siatki linii pomocniczych dla tej ope-
racji, bo jest na tyle gesta, ze wydaje sie zastania¢ deformowany obraz.

Wytgcza sie je wybierajgc z listy rozwijalnej Guides pozycje No guides

Rysunek 3.21.1 Wybor narzedzia Scale (Rysunek 3.21.2).

Czesto takie operacje jak skalowanie wywotujemy, aby dopasowac obraz
na jednej warstwie do wzorca na drugiej warstwie. Aby podczas transfor-
maciji nie straci¢ ani przez chwile wzorcowego obrazu z oczu, wigcz w pa-
nelu Tool Options opcje Show preview image, oraz zmniejsz jego nie-
przejrzystos¢ (Opacity) do 50% lub mniej (Rysunek 3.21.2). Aby nie zmie-
nia¢ tych ustawien za kazdym razem, mozesz potem je zapisa¢ jako do-
mysine (stuzy do tego ikona dyskietki u dotu tego panelu — por. Rysunek
3.21.2).

Wywotaj polecenie Tools=Transform Tools=Scale (lub [shiftH{T]). Pojawi

sie okno dialogowe Scale (Rysunek 3.21.3). Zauwazysz takze pewne po-
gorszenie jako$ci wyswietlanego obrazu. Linie staty sie mniej gtadkie, gdyz
GIMP przetgczyt sie na wyswietlanie ,roboczej kopii” rysunku. Pokazuje
teraz, jak bedzie wygladat obraz, gdy zatwierdzisz te zmiane skali. (Czyli
gdy nacisniesz przycisk Scale. Jezeli nacisniesz Cancel — zrezygnujesz z
catej operaciji).

Scale

Directicn

'Z:_.:Z' MNormal {Forward)
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Ustaw Transform na
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MNumber of lines

Interpolation:
Cubic W
Car Tp mozesz zmniejszy ¢
- nieprzejrzy stos¢  obrazu
Adjust
- podgladu
Show image preview l
Image ocpacity | 481 :
Guides

I:‘ Keep aspect {Ctrl)

=

/_

Wytgcz siatke
pomochniczg 15

Tu zapisz te
zmiany

Rysunek 3.21.2 Parametry skalowania
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Rysunek 3.21.3 Zmiana rozmiaru obrazu w kierunku pionowym
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Zwré¢ uwage, ze okno Scale nie przeszkadza w zmianie powiekszania widoku, ani w przesuwaniu poziomym i
pionowym suwakiem. To bardzo wygodne, gdyz z wiekszg doktadnoscia mozesz obserwowac¢ zgodnosc¢ linii
pomocniczej i linii na rysunku samolotu.

Jezeli nie zamierzasz zmienia¢ skali tak samo w obydwu kierunkach: upewnij sie, ze wysokos¢ i szerokos¢ sa
Jrozprzegniete”. (Ogniwa tancucha w oknie dialogowym Scale powinny by¢ przerwane). Nastepnie w polu
Height lub Width wpisz nowy rozmiar obiektu.

Transformacje zatwierdzamy naciskajgc przycisk Scale.

o Jezeli przeksztatcaliSmy tylko wybrany obszar, a nie catg warstwe — po zakonczeniu skalowania nalezy
dodatkowo wywotac¢ polecenie Layer->Anchor Layer. To ,zatwierdzi” rezultat operac;ji.
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Rozdziat4. Inkscape — szczegoly obstugi

Na Inkscape natkngtem sie przypadkiem. GIMP miat tylko marginalne mozliwosci rysowania linii wektorowych. A
ja szukatem wiec czegos, w czym mozna by byto wygodnie rysowac (i poprawiac) linie nitdw i tgczenia blach.
Gdy jednak wertowatem jego plik podpowiedzi, szukajgc szczegotow tej funkcji, natkngtem sig na zdanie:
-Rysowanie linii w GIMP nie jest tak wygodne, jak w wyspecjalizowanych programach, np. Inkscape”.

Co to jest to ,Inkscape”? Wystarczyto wpisa¢ to hasto w Google, by znalez¢ strone tego projektu. Jest to naj-
miodszy z programoéw, uzywanych w tej ksigzce. Nie osiggnat jeszcze "petnoletniosci" (aktualne wersje majg
nadal numer ponizej 1.00). W zwigzku z tym potrafi czasami sie zawiesi¢, lub zakonczy¢ sie nagle z jakims kry-
tycznym btedem. Na szczescie nie dzieje sie to zbyt czesto. W kazdym razie nie zapominaj o czestym zapisy-
waniu swojej pracy do pliku!
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4.1 Instalacja

Pobierz (z http://inkscape.org/en/download/) i uruchom program instalacyjny. Na poczatku pojawia sie ekran
"powitalny”, a nastepnie ekran z umowg licencyjng (Rysunek 4.1.1):

~ Open Sc
w_elcome to the Ink.spe Selup - Please review the license terms before installing Inkscape.
Wizard
This wizard will guide you through the installation of Press Page Down to see the rest of the agreement.
Inkscape.
GNU GENERAL PUBLIC LICENSE -
Itis recommended that you dose all other applications Version 2, June 1991 D
before starting Setup. This will make it possible to update
relevant system files without having to reboot your Copyright (C) 1989, 1991 Free Software Foundation, Inc.
computer, 58 Temple Place, Suite 330, Boston, MA 02111-1307 USA
Everyone is permitted to copy and distribute verbatim copies
Click Next to continue. of this license document, but changing it is ot alowed.
Preamble
_The licenses for most software are designed to take away your -
Inkscape is released under the GNU General Public License (GPL). The license is provided here
for information purposes only. Click Next to continue.
Inkscape 0.48.4
T T

Rysunek 4.1.1 Instalacja GIMP — pierwsze dwa ekrany

Po nacisnieciu przycisku Next > na ekranie License Agreement, przejdziemy do ekranu Choose Components
(Rysunek 4.1.2):

- Op o

» Choose Install Location
Choose which features of Inkscape you want to install. - Choose the folder in which to install Inkscape.
Mozesz tutaj dodaé
Check the components you want to install ang uncheck . . Setup will install Inkscape in the following folder, To install in a different folder, dick Browse
install. Click Next to continue. ttumaczenie na polski I and select another folder. Click Install to start the installation.
Select components to install: ¥ Inkscape 5VG Editor (required) P
GTK+ Runtime Environment {required) m
-[¥] tnstall for all users
- Shortcuts Destination Folder
B0 peronal prcfrences)
- [7) Additional Fies il rogram Files\Inksca Browse.
D‘Esmpvhun =
Space required: 183.6MB Pasition your mouse aver a component to see its Space required: 183.6MB
description, Space available: 337.9GB
Inkscape 0.46.4 Inkscape 0.46.4
[ <Back ][ mext> | [ cancel <Back | mnstal | [ cancel

Rysunek 4.1.2 Wybor opcji instalacji

Warto dopilnowaé¢, aby na ekranie Choose Components. wytgczy¢ z komponentéw wszelkie ttumaczenia poza
angielskim (obowigzkowe) i polskim. Na ekranie Choose Install Location mozna zmieni¢ domysiny folder pro-
gramu.

Po nacisnieciu przycisku Install wykonuje sie instalacja (Rysunek 4.1.3):

-Op o

Installing
Please wait while Inkscape is being installed.

Extract: inkview.exe... 100%
L

Show details

Inkscape has been installed on your computer.

Click Finish to dose this wizard,

Run Inkscape

Inkscape 0.48.4

< Back Next > Cancel

P e

Rysunek 4.1.3 Instalacja Inkscape - ekrany: postepu i finalny
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Kiedy otworzysz po raz pierwszy Inkscape, program moze by¢ w jezyku polskim (cho¢ nie zawsze — wydaje mi
sie ze to zalezy od wersji Windows, ktérej uzywasz). Proponuje przetgczy¢ sie na jezyk angielski (z tych samych
przyczyn, dla ktérych sugeruje uzywac jezyka angielskiego w GIMP — por. str. 52). Zacznij od otwarcia okna
ustawien programu (Plik 2 Ustawienia Inkscape’a — Rysunek 4.1.4):

"". dokument 1 - cm p gm |

Plik = Edycja Widok Warstwa Obiekt égiez'ka Tekst Filtry Efekty Pomoc

1 - == S

Howy ‘D @@Q@ Dew @& BPTaRE® @
= Otwérz.. Ctrl+0 |

Otwérz ostatnio uzywane y L E Y (0,000 5 Szer. (0001 S a Wys. |0.001 >
= ..
bl Przywrée n.l.l.l.l.z.;al.l.l.l.K:OI.I.I.I.P?OI.I.I.I.m:ml.l.l.l.llfml.l.la
& Zapisz Ctrl+S -
B zapiszjako.. Shifts Ctrl+5 T

Zapisz kopig... Shift+Ctrl+Alt+5
-D Importuj. Ctrl+I @
B* Eksportuj jake bitmape... Shift+ Ctrl+E _t
& Drukuj... Ctrl+P
G Wyczysé definigje Otwiera okno ustawien

programu = h);

@ Wiasciwosci dokumentu.., Shift+Ctrl+D
Metadane dokumentu... / #
“(’;‘iﬁ; Ustawienia Inkscape'a... Shif‘t+CtrI+ir ‘3»
Urzadzenia zewnetrzne... T
8 Zamknij Ctrl+W r
& Zskohcz Ctrl+Q &
- al

Rysunek 4.1.4 Inkscape: przejscie do ustawien programu

W oknie ustawien wybierz sekcje Interfejs. W niektérych Windows jezyk angielski moze figurowaé jako jezyk
Domysiny systemu (Rysunek 4.1.5) w innych znajdziesz go jako angielski (w kilku odmianach: amerykan-
skiej, kanadyjskiej, brytyjskiej):

(@ Ustawienia Inkscape'a. (ShiftaCtri< P Il

- Ustawienia Inkscape'a... (Shift+ Ctrl+P)

- I :
1. Przejdz do sekcji| [ > Interfejs

Interfejs

Bitmdny Jezyk interfejsu |po|ski (ol

Domyslny systemu
albariski (sq)

Zarzafizanie kolorem Wielkos¢ ikon w przyborniku

Siathi Wielkos¢ ikon na paskach kontrolek narzedzi
amharski (am)

1
|
|
arabski (ar) :
1
1

Zapisfw formacie SVG 2. Przelacz jezyk polski ych paskach

Zapis| na angielski
Impoft/Eksport

ania suwakow koloru

armeniski (hy)

Maksymalna liczba dokumentow azerski (az)
Mysz] . |
1Gdy nie widzisz na tej liscie pozy cjii
:angielski, to prawdopodobnie kryje:

:sie pod nazwg Dony$iny systenu :

Przewfijanie
Przyclaganie Wskaznik korekcji skali (%5)

Liczbhg krokow
v

bengalski (bn)

Interfejs
Okna

bretonski (br)

Sprawdzanie pisowni kataloriski (ca)

katalonski walonski (ca@valencia)
chifski/Chiny (zh_CM)

Ak (Tabsinem f=b TIAR

Rézne

Rysunek 4.1.5 Inkscape — zmiana jezyka programu

Przetgcz jezyk na angielski (lub, jezeli nie mozesz znalez¢ takiej pozycji na liscie — na Domysiny systemu). W
oknie Ustawienia Inkscape’a nie ma zadnego przycisku ,OK”. Wystarczy ze zamkniesz Inkscape i uruchomisz
go powtdrnie.
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Po powtédrnym uruchomieniu program wyswietla wszelkie opisy w jezyku angielskim (Rysunek 4.1.6):

Mew document 1 - Inkscap

Eile Ohbject  Path

[

Edit View Layer Text Filters Extensions Help

7'y
x|oooo [ v|oooo [H wlooor [H @& H|ooor fex [w]| Affect E
1

= |I|I||7TI|I|InlYllc:mlnlnlnlnllfmlnlnlulnE;Q D

1
Sadze, ze ten przybornik ze standardowy mi
poleceniami (New, Open, Save, Print, ...)
powinien sie znalez¢ u goéry ekranu

Dl:unl

B&EOl 9

oL
L YN Y[

+

B |
0y
A~
£
Q
[
Q
@)
&
©)
Y
N4
54
A

080

0:(100 |- | % 'E! -Layer 1 IZ| Ctrl: click to select in groups; drag to move hor/vert

Rysunek 4.1.6 Okno Inkscape (wyglad zaraz po instalacji)

Nie wiem dlaczego, ale domys$iny uktad ekranu Inkscape po instalacji wcale nie jest ,domys$iny”! Pasek z pole-
ceniami systemowymi jest umieszczony po prawej (Rysunek 4.1.6), zamiast — w sposoéb typowy dla Windows
— u goéry okna, pod menu rozwijalnym. Tych paskow narzedzi nie mozna przesuwaé myszkg. Zmien ich ukfad
wybierajgc opcje View2>Default (Rysunek 4.1.7):

(4@ New document 1 -1 <scap | @ New document 1 - Inkscap

File Edit View I:ayer iject Path Tedt Filters B Eile Edit View Layer Object Path Text .F\Iterg Extensions  Help ; —_ :
DEESE ABh ee | DxkD @ e @& BPTeE %P |
@ i Zoom 4
ks Display mode » Ej = | LE £ 83 E7 | xjoooo [ vioooo 3 wooor @ H|oom FHex Affect:
@ _ Grid =K [R] b PR BB P B BT PR R
f’“ - | I Guides 1B N - !
» T * ®© A 1
£ 8- | %, Snap % & 1
o’ Q 1
7 b Color-managed view 9 1
Q - O I
9 Show/Hide 4 @ N 1
D — | Fb Show/Hide Dialogs F12 . !
Q" O_ !
E fll Swatches.. SRS __ |Przetacz uktad ekranu na Default, by
O T | B Messages... przenies¢ pasek z poleceniami
A sy stemowy mi do géry okna
Q} 7 | [ Previous Window Shift+ Ctrl+Tab
7 ]
©) °- | @ NetWindow Ctrl+Tab % :
2@ g @ Icon Preview... -
N 3
E? 2_ Duplicate Wigldow -, I m ]
lg a__ ¢ Fullscreen F11 I Pl ——
- Fill: MN/A O X
N - | e | Sltrake: o 0100 || 6 @) | -Layer1 E(jlrl: click to select in groups; drag to move hor/vert B ;Z
__' Custom -
P e wide
3 € T -
Rysunek 4.1.7 Przeniesienie przybornika z poleceniami systemowymi pod nagtowek okna
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Wreszcie ostatni szczegét: wersja 64-bitowa z partha.com (por. str. 20) ma interfejs utrzymany w ciemniejszych
barwach niz w standardowym oknie Inkscape (Rysunek 4.1.8):

ew Layer Object Path Text Filters

BV

Kolor tta tego interfejsu jest tak ciemny, Ze znikajg w nim linie
niektéry ch ikon!

Rysunek 4.1.8 Okno 64-bitowego Inkscape (z partha.com)

W wersji 0.48 nie mozna jeszcze zmieniaé barw programu w oknie preferencji. Aby sobie z tym problemem po-
radzi¢, musimy uzy¢ metody nieco hakerskiej. Zacznij od pobrania z http://inkscape.org/en/download/ plikéw
oficjalnej wersji 32-bitowej, spakowanej w formacie 7z (Rysunek 4.1.9):

INKSCAPE

v Draw Freely.

Follow us on: ' G
Search ‘ Q ‘

ABOUT DOWNLOAD NEWS COMMUNITY LEARN CONTRIBUTE DEVELOP

Home » Download

Download

Download Inkscape For free and let your creativity fly!

Pobierz stad spakowany
folder wersji oficjalnej

(32-bitowej)

Official Release Packages

Stable release 0.48.4 intended for production use is avafable:

* Source Tarball —.gz See README to install, or Zompilinglnkscape for troubleshooting help.

* Source Tarball Bzip — .bz2 See README to inftall, or Compilinglnkscape for troubleshooting help.
e OpenSUSE 12.3 one-click install.

« Ubuntu Software Centre has a one-click/
e Mac 05X 10.6, Snow Leopard — Uni
« Windows —installer, portable %%

e 055-Marketplace.com
downloads.sourceforge.net/inkscape/inkscape-0.48.4-1-win32.7z

stall For Inkscape.
sal .dma (requires Apple's X11/Xquartz 2.3.4 or higher)
,|puilds of the 64-bit application are currently found on www.partha.com

Rysunek 4.1.9 Pobranie oficjalnej (32-bitowej) wersji Inkscape w postaci spakowanego folderu

© Witold Jaworski, 2009 - 2015.


http://www.partha.com/
http://www.partha.com/
http://inkscape.org/en/download/

94 Szczegdty obstugi programéw

e Format *7z to alternatywa popularnego formatu *zip. Jezeli do tej pory nigdy jeszcze takich plikéw nie
rozpakowywates, pobierz ze strony http://7-zip.org/ i zainstaluj program Open Source o tej samej nazwie.

Gdy zajrzysz do wnetrza pliku pobranego ze strony Inkscape, przekonasz sie ze zawiera pojedynczy folder o
nazwie inkscape (Rysunek 4.1.10):

File Edit View Favorites Tools Help

o= v o o= X A

Add  Extract Test Copy Move Delete Info

¥ L EAUsersime\Downloadsinstalkivinkscape-0.48.4-1-win32.7z\

MName Size Packed Size Modified Attributes

| Jinkscape | 204 842 659 32224428 2012-12-17 22:20 D

W tym folderze znajduje si¢ kompletny, 32-bitowy
program (gotowy do uzy cia po rozpakowaniu)

<

1 object(s) selected 204 842 659 204 842 659 2012-12-17 22:20

Rysunek 4.1.10 Zawartos¢ pliku *7z, pobranego z portalu Inkscape (okno programu 7-zip)

o  Gdybys$ chciat uzywac¢ wersji 32-bitowej, moégtbys po prostu rozpakowac ten folder gdziekolwiek na swoj
dysk twardy i uruchomi¢ umieszczony w srodku plik inkscape.exe.

My jednak chcemy uzywac zainstalowanej wersji 64-bitowej, dlatego wykorzystamy tylko niektére podkatalogi
folderu inkscape z pliku 7z.

Na ilustracji ponizej pliki 64-bitowego Inkscape znajdujg sie w folderze C:\Program Files\Inkscape-0.48\. Zacznij
od zmiany nazwy podkatalogu etc\ na etc.org\' (Rysunek 4.1.11):

SYSTEM (C:) » Program Files » Inkscape-0.48

*  Nazwa ilz_ol_dgl'_6_4fb_it5v;ega _Ir;k_sga_p_e_: File Edit View Favorites Tools Help
oo EE b owm v o = ¥ 1 1Zawartosé  folderu;

W cte. 9] \inkscape z pliku 7z !
| " lib \ _ ‘Add Extract Test Copy Move Delete Info A !

.. python :;IiTJe;Cnizw:t;z;]malnego C:\Users\me\Downloads\lnstalki\inkscape—O.JfBAJ—wini?..?z\in{scape\

. share Size Packed Size Modified Attributes
[#7 gspawn-wing4-helper.exe | 0 0 2012-12-17 22:00 ]
[2°] gspawn-winf4-helper-consg - i 90900 0 2012-12-1722:00 D
[m=] inkscape.exe i 2. Skopiuj folder etc z pliku 7z| 2012-12-17 22:02 D
0 inkscape.ico J locale do katalogu Inkscape 2012-12-17 22:00 D
[#] Inkscape s modules 0 0 2012-12-17 22:00 D
x Inkscapeuninst.exe J plugins 0 0 2012-12-17 22:00 D
[m2 inkview.exe | python 32 082 102 0 2012-12-17 22:02 D
4 libstk-1.0-0.dil J share 80945736 18790176 2012-12-17 22:01 D
%/ libatkmm-1.6-1.dll
] libcairo-2.dlI 1 object(s) selected 90 900 90 900 2012-12-17 22:00
% libcairemm-1.0-1.dll 2013-00-25 21:43

Rysunek 4.1.11 Podmiana podkatalogu etc\ na nowy, pobrany z pliku *7z.

Nastepnie skopiuj do folderu Inkscape katalog etc\ z pliku 7z (Rysunek 4.1.11). Najprosciej to zrobi¢ przeciaga-
jac ten folder z okna 7-zip do folderu Inkscape w oknie Eksploratora Windows.

' Robimy to po to, aby w razie czego odtworzyé oryginalny stan zmienianej aplikacji. Podczas uruchamiania Inkscape szuka w sw oim kata-
logu folderéw o $cisle okreslonych nazw ach. Taka zmiana nazw y pow oduje, ze ,nie bedzie zw racat uw agi” na etc.org. A gdyby co$ nie
dziatalo tak jak to ponizej opisatem — w ystarczy w ycofa¢ opisane dalej operacje i z pow rotem zmieni¢ nazw e folderu efc.org na etc.
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Nastepnie przejdz w obydwu oknach do podkatalogdw o nazwie share\ (w oknie Inkscape to /nkscape-
0.48\share, w pliku 7z to inkscape\share — por. Rysunek 4.1.12):

SYSTEM (C:) » Program Files » Inkscape-0.42 » [share] v O
« |1- Przejdz do podkatalogow
share

|| applications File Edit View Favorites Tools Help
. dlipart h =m v B = K i
| examples Add  Exract Test Copy Move Delete Info
| extensions || C:\Users\me\DownIoads\lnstalki\inkscape—ﬁ.-i&d—'l—winil.?z\inkscapem
b filters Name Size Packed Size Modified Attributes
i fonts | patterns 280516 0 2012-12-17 22:00 D
i gradients \ poppler 11647 744 18790176 2012-12-17 22:01 D
. icons | screens 857 940 2012-12-17 22:00 D
W keys . templates A7 332 2012-12-17 22:00 D
| locale @ j%— ziikik";’;‘” ;g'd‘:;é:zgggj 2012-12-17 22:01 D
. man . tutorial sharel 2012-12-17 22:00 D
| markers | ui e 2012-12-17 22:00 D
I palettes || README 17 2011-07-08 14:25 A
| patterns i
b screens 1 object(s) selected 5820 2012-12-17 22:1
. templates 2014-01-24 18:21

| . tuterials 2014-01-2418:2
i 2014-01-24 18:21

Rysunek 4.1.12 Skopiowanie folderu themes z pliku 7z do katalogu sharel\

Skopiuj z pliku 7z do katalogu share folder o nazwie themes (Rysunek 4.1.12). Po tych zmianach, gdy powtor-
nie wywotasz 64-bitowy Inkscape, okno bedzie maito jasniejszy odcien, i nie bedzie problemu z widocznoscig
jakichkolwiek ikon (Rysunek 4.1.13):

File Edit View Layer Object Path Text Filters Extensions Help

UBEE b ¢¢ Dwlid Q@@ DaE @R PTeEBEE®D

0 | 250 500 750 1000 1250
|I|I|I|I||I|I|I|I|%|I|I|I|I| |I|I|I|I|||I|I|I|I|||I|I|I|I@
-

cook
o0

Teraz nawet nieaktywne

ikony s wy raznie widoczne \

S
o0

| Doﬂ
o P N

Sk

Fill:

Stroke: Sk a ~Layer 1 |Z| Ctrl: click to select in groups; drag to move hor/vert

Rysunek 4.1.13 Poprawione barwy okna 64-bitowej wersji Inkscape
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4.2 Wprowadzenie

Rysunek 4.2.1 pokazuje, jak wyglada ekran Inkscape zaraz po pierwszym otwarciu:

Przy ciski, wy wotujace panele:
e Wiasciwosci obiektu,

* New document 1 - Inkscape e Wiasciwosci tekstu.
e  Zarzadzanie warstwami

Fle Edit Wiew Layer Object Path Text Fikers Extensions Help
L v . — = ae
NEEE Ak Dx0lQaa neE SH[PTeRE| %@
= 5 57| x|emooc? v[soooocd| wizzoooc s @ Hjswooc px v || affert:
a 250 500 & 000 S
‘*‘ |I|I|I|I|||I|I|I||-:I|I|I|I||-‘|I|I|I|I|JI|I|I|'|||I|I|I|I|I|@|
—— M
|l _
i - — .
i Potozenie Rozmiary
ﬁ 7] wy branego wy branego
- obiektu obiektu
LI f
o =
Q-
O Jl Przyborlnik. z
g - narzedziami
|
Y| Yoot
ié’ § ‘ |
i | : |
¥|: * ”
Al -
iy | " I 5
a
gF:
j Doktadna zmiana
[a, i
E“n powigkszenia
ol
nf N Aktualne barwy i
E:EI ] nieprzejrzy stos¢ Sterowanie Wspétrzedne
1 warstwami kursora R
2l S
Fill: Al ) ) . |l sEz.09 I
Shroke: hione Q|0 ':'# a ‘Layer 1 % ||Rectangle inlayer Layer 1, Click selection to toggle scale/rotatio) | 127, 5D 2| 3% o

Rysunek 4.2.1 Okno Inkscape

Okno programu jest tu jednoczesnie oknem obrazu. Wokét krawedzi sg rozmieszczone réznorodne przyborniki
z ikonami (Rysunek 4.2.1). Pionowo, po lewej — przybornik z narzedziami edycji. U géry — m.in. pola umozli-
wiajgce zmiane potozenia i rozmiarow wybranego obiektu.
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4.3 Otwieranie i zapisywanie do pliku

W zaleznosci od kompilacji Inkscape wykorzystuje rézne odmiany okna wyboru plikéw (otwieranych poleceniem
polecenia File»Open. Oficjalne, 32-bitowe wersje programu, wykorzystujg standardowe okno wyboru plikéw
Windows. Wersja 64-bitowa, pochodzgca spoza oficjalnego portalu (por. str. 20) ma takie same okna wyboru
plikdw, jak w Gimpie (Rysunek 4.3.1 — por. str. 60):

Tu mozesz
wpisa¢  recznie o :
nazwe pliku Aktualna $ciezka. Mozesz przej$é

Documents | Ksiazki (napisane) Exports || WM-pl-1 G do foI(_:Ieru_ nadrze_dnego, klikajac w
odpowiedni przy cisk

Places Mame ~ Size Modified A -
rj\ Search “L paged012.pdf 525.3 kB 2014-05-03
& Recently Used 2 pagelD12.svg 2941 kB 2014-05-03

nkscape “L pageD013.pdf 4229kB 2014-05-03
=) me = pagelD13.svg 138.2kB 2014-05-03
[ Desktop “L page014.pdf 3014 kB 2014-05-03
2 SYSTEM (C3) = pagedDidsvg Pliki w aktualnym| 34418 2014-05-02

folderze
o LENOVO (Dv) “L pageD015.pdf, 5153 kB 2014-05-03

Lista folderow/
dy skéw

8 Stacja dyskéw D... & pagel015.5vg 105.0 kB 2014-05-02 Podglad zaznaczonego
o USER (U) % paged016.pdf 4613 KB 2014-05-02 z'lijkz;)m ile nie jest zbyt
= : = paoeD016.5va 2293 kB 2014-05-03 ¥

All Inkscape Files El

Enable preview

Rysunek 4.3.1 Inkscape (64-bitowe) — okno wyboru plikéw
Inkscape umozliwia podglad zawartosci pliku, podswietlonego na liscie — ale tylko do pewnego rozmiaru. Po

nacisnieciu przycisku Open, w Inkscape pojawi sie zatadowany plik.

Podobnie w przypadku zapisu pliku (polecenie File->»Save As): 32-bitowa wersja Inkscape uzywa standardo-
wego okna Windows, a 64-bitowa — okna z tej samej biblioteki (komponentu) co GIMP (Rysunek 4.3.2):

Name: bcoversvg +—————— |Tu wpisz nowa nazwe pliku |

Save in folder |Z|‘|_"___"|me Documents || Ksiazki (napisane) WM?_H Exports stubHEPUB”pI”ﬁglres‘ Create Folder

Places Mame ~ Size Modified

':r:k Search A beover.svg 834 kB 2014-05-03

@ Recently Used = Figure_0_1_1s.svg 20.1 kB 2014-05-03
B Inkscape = Figure_0_1_2.svg 45kB 2014-05-03
=) e 2 Figure_0_1_3.svg 11.6kB 2014-05-03
=) Desktop 2 Figure_0_1_4.svg 21.9kB 2014-05-03
2. SYSTEM (C3) 2 Figure_0_1_5.svg 13.6kB 2014-05-03

irmieaes 2 titlesvg 855kB 2014-05-03

Append filename extension automatically
Enable preview

Za pomocg tych narzedz ustal folder,
do ktérego chcesz zapisaé plik

Inkscape 5VG (*.svg)

Rysunek 4.3.2 Inkscape (64-bitowe) — okno zapisu plikow
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4.4 Ustalenie rozmiaru obrazu

Wywotaj polecenia File=>Document Properties. (Rysunek 4.4.1):

" New document 1 - Inkscape _||'E|r5__<|
5= Edit Wiew Layer Object Path  Text Effects whiteboard Help
bew ' | D 0 LQGE ' ; 2 .
B open... Sl Ese= =57 " Document Properties (Shift-Ctr... [= |23 gEs -
Open Recent = —= = = - : —
- a @Document Properties (Shift+Ckrl+D) 125
Regert o, ||C{a
E Save Chrlas Page |Guides Gtids | Snap | Snap points 5
; General
[ savess.. Shift+Ctr+5
) Default units: | pax ﬂ
Save a Copy.. Shift+CtrH-alk+5
Background: Ry
—ﬁ Impott... Chrl+L
[B Export Bitmap... Shift-+CtrHE Format
Ad 210.0 x 297.0 mm
E k... CurkP US Letter 8.5x% 11.00n T
Page size: i
,é.; Wacuum Defs N 1S Legal 8.5 x 14.00n
U5 Executive 7.3x10.5in Tu sz mia
Document Propel voo Shifk+CE D ObraZ\?,Jp wy b
o' — Page orientation: C}l_o%rait @
Document Metadata,,. 1,
- 4 Custom size
‘é‘fé, Inkscape Preferences,..  Shift+Chrl4+P =
- Width: | 2390.00 il 3
Input Devices. ., LY
Height: | 1000 |2 | [Eit pige to selection |
3 dose Chrl+w \ Ustalenie ich w
) Border pikselach utatwi
sl quit Chr+Q eksportowanie do
E " Show page border pliku rastrowego
§ [] Border on top of drawing
AI ] |Obszar, ktéry ustalasz e
= Show border shadow
f‘:'! T Border color: NS |

Rysunek 4.4.1 Ustalenie rozmiaru dokumentu

W oknie dialogowym Document Properties, w pola Width, Height sekcji Custom size, wpisz wymiary dokumen-
tu. Sugerowatbym, aby — dla wygody — zatozyé¢, ze 1 jednostka Inkscape = 1 piksel weryfikowanego obrazu.

Okno Document Properties nie ma przycisku "OK." — zmiany zostajg wprowadzone, gdy tylko opuscisz to ok-
no.
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4.5 Wstawienie dodatkowego obrazu rastrowego

Wywotaj polecenie File=>Import. W oknie dialogowym wyboru plikéw, ktdre sie pojawi, wskaz jakis plik rastrowy
(Rysunek 4.5.1a):

a) lect file to import

Szukaj v | (T Fiwsunki w | Q F o
Y Mazwa Rozmiar Typ [ il
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Rysunek 4.5.1 Wybér pliku rastrowego (wersja 32-bitow a)

Gdy nacisniesz przycisk Otworz, Inkscape wyswietli jeszcze dodatkowe okno dialogowe (Rysunek 4.5.1b).
Wybierz na nim opcje link. Wéwczas wybrany obraz zostanie wstawiony do aktualnego rysunku (Rysunek
4.5.2):
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Rysunek 4.5.2 Kolejny obraz rastrowy, dodany do dokumentu Inkscape

e 64-bitowa wersja Inkscape uzywa okien dialogowych wyboru plikow w stylu GTK+ — takich jak te uzywane
w GIMP (por. str. 60).
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4.6 Eksport do obrazu rastrowego

Wywotaj File=>Export Bitmap. Inkscape otworzy od-
powiednie okno dialogowe (Rysunek 4.6.1):

W sekcji Export area nacisnij przycisk (przetacznik)
Page. W tym trybie eksportowany jest zadeklarowany
obszar rysunku (por. str. 98). W sekcji Bitmap size
ustal rozmiary obrazu rastrowego. Jezeli eksportowa-
ny plik ma by¢ uzyty jako tekstura, postaraj sig, by
miat takg samg wysoko$¢ i szerokos¢. Jeszcze lepiej,
gdy rozmiar obrazu w pikselach jest jakg$ potega licz-
by 2. Zazwyczaj stosuje sie rozmiary 512, 1024, 2048.
Jak wida¢ na ilustracji, ja wybratem 2048 (aby byto
wida¢ jak najwiecej szczegdtow) .

W polu Filename ustalamy nazwe pliku. Inkscape zapisuje (na razie?) bitmapy tylko w jednym formacie: *.png.
Nie jest to jednak duzy problem, mozemy jg pdzniej przeksztatci¢ na inny format za pomocg Gimpa. Zresztg

Blender akceptuje obrazy takze w formacie *.png.

" Export Bitmap (Shift+Ctrl+E)
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Filename

+ dpi

/_ nazwe pliku
wworskitMoje dokumentyPrywatne Wi R ysunkil P40C-ML-Combine, png
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Po naci$nieciu przycisku Export zostanie utworzony obraz, gotowy do uzycia w Blenderze.

Rysunek 4.6.1 Szcze goétly eksportu do bitmapy (obrazu rastro-
wego)

o Eksportowana jest tylko zawartos¢ tych warstw Inkscape, ktére sg aktualnie widoczne!

Wirtualne modelarstwo — wydanie trzecie
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Rozdziat 4 Inkscape — szczegdty obstugi

4.7

Obstuga zmiany powiekszenia (zoom)
GIMP.

Widok: powiekszanie, przesuwanie

Zmiany powiekszenia mozna dokona¢ na dwa sposoby:
- szybko i mniej doktadnie: trzymajgc wcisniety i obracajgc kotkiem myszki (M);

i przesuwania obrazu (pan) jest w Inkscape prawie taka sama jak w

- doktadnie: wpisujac Y%powiekszenia w pole Zoom, u dotu ekranu (Rysunek 4.7.1);
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Rysunek 4.7.1 Widok: dwie metody zmiany powigkszenia (Zoom)

Przesuniecie widoku to ruch myszki z wcisnigtym m (identycznie jak w GIMP — str. 65). Mozesz takze uzy¢ w

tym celu paskéw przewijania (scrollbars), umieszczonych z boku ekranu.

Dodatkowo, zgodnie ze standardem Windows, obrét @ powoduje przewijanie obrazu w gore i w dot. Juz poza

tym standardem, kombinacja - [ przesuwa widok w poziomie.
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4.8 Warstwy — zarzadzanie

W Inkscape, podobnie jak w GIMP, istniejg warstwy, za pomocg ktérych mozesz grupowac elementy rysunku.

Gdy wywolasz polecenie Layer->Layers ([snml—l&]—@), na ekranie pojawi sie dodatkowy panel (Rysunek
4.8.1):

" New document 1 - Inkscape [Z”E”‘_S_d

File Edit Wew Laver Object Path Text Effects ‘Whiteboard Help K“k.nij W.nazw'e WZFStWy
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l:‘ N ( . Wy) Qpacity, %
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Rysunek 4.8.1 Panel zarzagdzania warstwami

Panel sterowania warstwami zapewnia petng kontrole ich stanu. Zwrd¢ szczegdlng uwage na kontrolke Opacity
— zmienia przejrzystos¢ podswietlonej na liscie warstwy. Bedziesz jej czesto uzywat. Panel Layers (i wszystkie

P—n

inne) mozesz "schowac" lub przywota¢ z powrotem naciskajgc |F12| (View>Show/Hide Dialogs)

Oprécz paneli zarzadzania, Inkscape ma dodatkowg kontrolke u dotu ekranu (Rysunek 4.8.2). Za pomocg tej
listy rozwijalnej i dwéch przetacznikéw mozna:

- zmieni¢ aktualng warstwe;

- wlaczy¢ lub wytgczyé widocznos¢ warstwy;

- wiaczy¢ lub wytaczy¢ blokade zmian dla obiektéw umieszczonych na warstwie.
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Rysunek 4.8.2 Elementy szybkiego zarzadzania warstwami

Z kontrolki umieszczonej u dotu ekranu korzysta sie najczesciej, gdyz nie zajmuje tyle cennej przestrzeni ekra-
nu, co panel Layers.

Warto zwréci¢ uwage na pewne konwencje prezentowania nazwy warstw na liScie rozwijalnej:
- nazwa zablokowanej warstwy jest ujeta w nawiasy kwadratowe.
- nazwa warstwy ukrytej jest szare, a nie czarna.

W ten sposob, zaraz po rozwinieciu listy, mozesz sie szybko zorientowaé co do stanu kazdej z warstw.
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4.9 Warstwy — dodanie nowej

Otworz panel Layers (Layer—=>Layers). Na panelu nacisnij przycisk [(+]. Mozesz takze (alternatywnie) uzy¢ po-
lecenia z menu: Layer=>>Add Layer.... Pojawi sie okno dialogowe nowej warstwy (Rysunek 4.9.1):

File Edit ‘iew Layer ©Chbject Path Text Effects ‘Whiteboard Help
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& aj Image
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L
i KT=ziee
a- Domy $lnie: PositimLLQbove current ﬂ

wstaw ponad

Blend mode: | Motrnal
aktualng

@ . [ Cancel l [ add ] Cpacity, %

Rysunek 4.9.1 Dodaw anie nowej warstwy

W oknie Add Layer wpisz w pole Layer name nazwe nowej warstwy. W polu Position mozesz ustali¢, w ktorym
miejscu na liscie ma by¢ umieszczona (powyzej lub ponizej warstwy aktualnej).
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410 Warstwy — usuwanie

Otworz panel Layers (Layer>Layers). Na panelu podswietl warstwe do usuniecia i nacis$nij przycisk =]
(Rysunek 4.10.1). (Mozesz takze — alternatywnie — uzy¢ polecenia z menu: Layer—>Delete Current Layer..).

" New document 1 - Inkscape

File Edit iew Layer Object Path Text Effects  ‘Whiteboard Help
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ktérg chcesz usungé Second

& l,_:ﬂ Layer 1

(#]7) ¢ [)(2](=]

_— J B

1000 |y

2. Nacisnij

OPadt| ten przy cisk

Rysunek 4.10.1 Usunigcie warstwy
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4.11 Zmiana kolejnosci obiektow

W Inkscape kazdy obiekt jest umieszczony "ponad" albo "ponizej" innych. Przyjrzyjmy kwadratowi i elipsie,
umieszczonym na tej samej warstwie (Rysunek 4.11.1). Elipsa zastania kwadrat — jest obiektem pierwszopla-
nowym:

% (1742675 v |887.935% w [118.157% @

Obiekt pod
spodem

Obiekt pierwszoplanowy
(tzn. "na wierzchu")

Rysunek 4.11.1 Oryginalna kolejnos ¢ obrazow

Zaznacz elipse. Nastepnie wywolaj polecenie Object>Lower to Bottom. Sytuacja ulegnie zmianie (Rysunek
4.11.2):

T YR O .% 53 57 | ximzeds v serams wlusisds @
|\\Lower P —

i 4 Caw o
g i przemie$¢ "na spod

Teraz kwadrat stat sie

pierwszoplanowy ...
-
&
@
EE’ T ...a elipsa znalazta sie
E’, ' 3 na samym spodzie
ol

Rysunek 4.11.2 Kolejno$¢ obrazéw po przesunigciu pierwszoplanowego "na dno".

Sposrod czterech polecen, za pomocag ktérych mozna w Inkscape zmienia¢ kolejno$é obiektéw, w praktyce
uzywatem tylko dwéch:

|, ikona: =): umieszcza zaznaczony obiekt ponizej

- Object>Lower to Bottom (skrot klawiatury: ||En=d

wszystkich innych;

- Object>Raise to Top (skrot klawiatury: |Home|, ikona: T): umieszcza zaznaczony obiekt powyzej

wszystkich dotychczas narysowanych;
Kazdy nowy obiekt, ktéry tworzysz, jest umieszczany ponad wszystkimi narysowanymi do tej pory.

W Inkscape istniejg takze warstwy, petnigce podobng role jak w GIMP: podzielenia rysunku na fragmenty, ta-
twiejsze do zarzgdzania (patrz str. 102). W ogdlnej hierarchii Inkscape najwazniejsza jest kolejnos¢ warstw. To
ona okresla "zgrubnie", co jest widoczne, co nie widoczne, a takze co jest na wierzchu a co pod spodem. Oma-
wiane w tej sekcji operacje — "przesun na spdd", "przesun na wierzch" — zmieniajg kolejno$¢ obiektow tylko w
obrebie pojedynczej warstwy.
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4.12 Linie pomocnicze (guides)

W Inkscape mozesz uzy¢ linii pomocniczych (guides).

Stuzg do zaznaczania jakiegos istotnego miejsca, a

takze poréwnan. Tworzy sie je tak samo jak w GIMP: poprzez "wyciggniecie" z linijki z boku lub z géry ekranu

(Rysunek 4.12.1):

1
| =

. i trzymajgc wcisniety

B2 przesuwaj my szke w|

el i
| Przesuwana linia
pomocnicza

Rysunek 4.12.1 "Pobranie" linii pomocniczej
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Linia pomocnicza nie jest czescig obrazu — nie jest drukowana, ani nie pojawia sie w obrazach wyeksportowa-

nych do pliku rastrowego.

Istniejgce linie pomocnicze mozna przesuwacé. Gdy zblizasz do nich wskaznik myszki na odlegtos¢ kilkunastu

pikseli, linie zmieniajg kolor na czerwony. W ten sposéb Inkscape
52l i przesuniecie myszki przeniesie linie pomocniczg w nowe
zwolnisz [B].

sygnalizuje, ze wcisniecie w tym obszarze
miejsce. Zostanie umieszczona tam, gdzie

Aby usuna¢ linie pomocnicza — trzymajac weisniety [Ctri, kliknij w nig LPm]

Jezeli w oknie Document Properties ([Shift|{CtrI{D]) jest wiaczone
"przycigganie" do punktéw charakterystycznych (Rysunek 4.12.2)
— tworzone lub edytowane obiekty bedg sie dopasowywaé do linii
pomocniczych.

Wirtualne modelarstwo — wydanie trzecie
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Rysunek 4.12.2 Wiaczenie "przyciagania” do linii
pomocniczych
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4.13 Dokladnie okreslanie pozycji obiektu

Przesuniecie za pomocg myszki zawsze jest obarczone jakims btedem. Inkscape umozliwia — jako alternatywe
— wpisanie dokfadnych wartosci numerycznych dla potozenia i rozmiaru obiektu. Mozna to zrobi¢ w trybie wy-
boru obiektow. Stuzg do tego pola X, Y, W, H, umieszczone w przyborniku ponad rysunkiem (Rysunek 4.13.1):

" New document 1 - Inkscape

File Edit e Wiacz tryb ct  Path  Text Effects Whiteboard Help

wbou - B [ G @ | D 0 QQQ DEE SH BPTERE & B

& gy S| IE = = 57 |>< nooo |5 v 304.00c:||w|390.000|: A H |?20.00c|:”:x ﬂ Affect: =1 »
........ . . PR |.:|. LI I R Y Px.‘ [ B 4 B |II)):| [ IR I B II:J?] [ . . ‘. LI B |2:-'-.‘:|| ol Q
k i Tu wpisz doktadne[© |'F G ) Tu. mozesz tz?kie s
f—\ 0= wspotrzedne naroznika zmieni¢ jego
1 obrazu | . rozmiar
. i e
1) = ] \

Rysunek 4.13.1 Obraz: ustalenie doktadnego potozenia

Najczestsze zastosowanie tej funkcji, to doktadne pozycjonowanie obrazéw na rysunku. Aby ustali¢ ostateczng
pozycje, wpisz w pola X i Y wspotrzedne lewego gérnego naroznika obrazu (Rysunek 4.13.1).

e Inkscape dolicza do rozmiaru obiektu takze grubos¢ jego obrysu (jezeli ksztatt obiektu jest obrysowany —
tzn. ma wigczong opcje Stroke — por. str. 109).

© Witold Jaworski, 2009 - 2015.




108 Szczegdty obstugi programoéw

414 Rysowanie linii

Rysowanie linii zaczynamy od przetgczenia sie w odpowiedni tryb pracy — rysowania linii (Rysunek 4.14.1):

--------- 100 150 300 350 400
.I.I.|.I.I.I.I.|.I.I I.|.I.I.I.I.|.I.IYI.I..I.

B
el g
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4. Nacisnij lEnter by
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i W,
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\ 2. Kiliknij tutaj 3. Kiiknij () tu,
(LPM)} by aby zakonczy¢ seg-
rozpoczaé linig. ment linii...

1. Kliknij tu, by wigczy ¢
try b ry sowania linii.
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F

Rysunek 4.14.1 Rysowanie linii w Inkscape

Linie zaczynasz od klikniecia w punkt, ktory bedzie poczatkiem pierwszego odcinka. Od tej chwili za kurso-
rem myszki zaczyna sie "ciggna¢" czerwona kreska (mimo, ze nie naciskasz zadnego klawisza). Gdy po raz
drugi klikniesz — wskazesz koniec odcinka. Linia moze sie sktadaé z jednego lub wiecej takich segmen-
téw. Zwré¢ uwage, ze po wskazaniu drugiego punktu Inkscape "z wtasnej inicjatywy" rozpoczat "ciggngc" kolej-
ny odcinek linii. Musisz na koniec nacisng¢ @] aby zasygnalizowa¢ programowi, ze "na tym konczymy".

e  Aby usung¢ ostatnio narysowany odcinek linii — nacisnij “Backspace L

e Jezeli rysowany odcinek ma by¢ poziomy lub pionowy — podczas rysowania trzymaj wcisniety |Ctrll.

Inkscape stara sie utatwi¢ rysowanie linii jako figury zamknietej.
Stad, gdy podczas rysowania linii zblizysz koniec ostatniego od-

+
cinka do poczatku pierwszego — punkt poczatkowy ulegnie pod- N -
$wietleniu (Rysunek 4.14.2). Gdy umiescisz w nim punkt kocowy punkt “pocatkony Sioi
odcinka, ktéry rysujesz (kliknigcie [If]) — linia stanie sie za- Sl creriony
mknieta. Ostatni

segment
linii

Rysunek 4.14.2 "Zamykanie" obrysu
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415 Wilasciwosci ksztattu
Kazdy obiekt w dokumencie Inkscape — poza obrazem rastrowym — jest figurg geometryczng, ztozong z

dwdch elementow:
linii konturu (stroke);
wypetnienia (fill);

Dla obydwu mozna ustali¢ kolor, a w bardziej ztozonych przypadkach — gradient czy desen, jakim sg rysowane.

Linia konturu dodatkowo posiada takie wtasciwosci jak grubo$¢ i wzoér (ciggta, kreskowana, kropkowa,...)
Kontury otwarte takze mogg posiada¢ wypetnienie — cho¢ w takim przypadku wyglada nieco dziwnie.
Do zmiany wypetnienia i linii konturu obiektu stuzy panel Fill and Stroke (Rysunek 4.15.1):
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Rysunek 4.15.1 Okno wtasciwosci ksztaltu (Fill and Stroke)

W zaktadce Stroke style ustalasz grubos¢ i desen linii obrysu. W zaktadce Stroke paint ustalasz barwe (lub

gradient, lub desen) linii (Rysunek 4.15.2):

|2:.i.1

>

Pl

,\ul ':u."rulul
ol I I ol I I [
n

POCHLH

Dashes: | =——=—r=—- - =
érl Stark Markgrs: | Mone hd
Mid Markers: | Mone w
End Markers: | Mone v
Bilur:

J

Opacity, %

Jlmoa s

| 750 | 1000

50
| L [

IAFil and Stroke (Shift+Ctel-+

> £

Aktualnie wybrany sposoéb wy petnienia:
jednolity kolor (Flat color)

Lt

Tryb jednolitego koloru:
Aby zmieni¢ barwe, ztap il

inne opcje: gradienty:|.
liniowy i elipty czny

Fill | stroke paint/ =

inne
desen

opcje:

przesuwaj suwak.

Rysunek 4.15.2 Zmiana barwy linii — zakladka Stroke paint
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Zaktadka sterujgca wypetnieniem obiektu to Fill. Zawiera
identyczne kontrolki jak Stroke paint.

Sposréd mozliwych trybéw wypetnienia wyréznia sie pierw-

sza opcja od lewej — (Rysunek 4.15.3). Gdy jg wybie-
rzesz w zaktadce Fill, obiekt w ogdle nie bedzie miat wy-
petnienia. (Analogicznie, wybdr tej opcji w Stroke paint
spowoduje, ze obiekt w ogdle nie bedzie miat obrysu).

Mo

o paink

Wytgczone (w ogodle

nie jest ry sowane)

IAFil and Stroke (Shift+Ctr+F) =
Fil [ stroke paint | ==*Stroke style
x[OOOEH? oe

Rysunek 4.15.3 Wytacze nie wypetnienia wnetrza obiektu

Na zakonhczenie warto wspomnie¢ o jeszcze jednej wtasciwosci obiektu w Inkscape. Mozesz tu sterowaé nie-
przejrzystoscig pojedynczego obiektu dokfadnie tak samo, jak w GIMP steruje sie nieprzejrzystoscig catych
warstw. Stuzy do tego niewielka kontrolka O, umieszczona u dotu ekranu (Rysunek 4.15.4):

§Opacit‘y = 100%

— obiekt zupetnie
nieprzejrzy sty
»»

F
5

Rysunek 4.15.4 Zmiana nieprzejrzystosci obiektu (Opacity)
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4.16  Edycja linii

Linie (a wlasciwie — "Sciezki", bo Inkscape okresla je jako paths), ktore narysowates, mozesz pdzniej modyfi-
kowa¢. Stuzy do tego oddzielny tryb — edycji weztow (Rysunek 4.16.1). (Weztem linii jest kazdy z jej wierzchot-
kow):

Tryb edyciji |Wspo|rzedne ostatnio wskazanego wierzchotka |
weziow \

= f; A "&-—' S S N Ki|223.745 % Wi 839,945 3 |px

|'\'n
PR R I 2 RV

W

|-‘).]I.I.I

Wezly aktualnie wybranej linii.
Mozesz je przesuwac (l)

Rysunek 4.16.1 Edycja wierzchotkéw wybranej linii

W tym trybie kazdy punkt linii (wezet) jest oznaczony matym rombem. Mozesz za nie ,fapa¢” () i przesuwac
w nowe miejsca. Obowigzujg tu doktadnie te same reguty, co przy edycji catych obiektéw. Pojedyncze Klikniecie
w wezet oznacza go jako wybrany (Wezet wybrany zmienia swoj kolor na niebieski). Jezeli podczas wskazywa-
nia weztow bedziesz trzymaé wcisniety klawisz |E|| - mozesz zaznaczy¢ wiele punktéw naraz. Mozesz je takze

zaznaczac obszarem prostokgtnym.

e Aby doda¢ do linii nowy wierzchotek — kliknij dwukrotnie w segment, w miejscu w ktérym ma byc¢
wstawiony.

e  Aby usungé wybrany wezel/wezty — nacisnij klawisz [E] To zazwyczaj powoduje zmiane ksztattu linii.

© Witold Jaworski, 2009 - 2015.




112 Szczegdty obstugi programéw

4.17 Linie krzywe

Inkscape pozwala od razu rysowac linie krzywe — wystarczy w trakcie rysowania kolejnego segmentu trzymaé
przez caty czas wcisniety . Musze jednak przyznaé, ze dla doktadnego odwzorowania ksztattu ta metoda
jest troche nieodpowiednia. (A moze — nie przec¢wiczytem jej dostatecznie.) W kazdym razie pokaze tu sposéb,
ktérego uzywam "na co dzien".
Polega on na:

- pierwszym przyblizeniu obrysu za pomoca linii tamanej (patrz str. 108, 116);

- przeksztatceniu kolejnych segmentéw tamanej w odcinki krzywej.

Aby zmieni¢ ksztalt linii tamanej w krzywg, musisz sie przetgczy¢ w tryb edycji. Potem wystarczy "ztapac" za
segment linii | i wygig¢ w odpowiedni ksztatt (Rysunek 4.17.1):

?{t; +”+ VRO BfiE] s (252X RAIIVYRIASTSEIE] S

......... £ |Jn 100 |3_-._1

|~.‘!.1
el P TP T e .

T\
*\
=
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o
N
<
o
o
Q.
<
2 f
)
c
3
=
o
E
4
]
2

,“""}' > I: - AN
_ﬁ —_ _ﬁ ; |
n - ¥ |
0 e
O i Za jaki O ]

=] ...zap za jakikol- ]
@} i wiek punkt na linii... Q} o
= =

Rysunek 4.17.1 Linia krzywa uzyskana poprzez "w yciagnigcie"

Alternatywng metodg jest zamiana poszczegdlnych weztéw (wierzchotkdw) z "ostrych" na "gtadkie", poprzez

nacidniecie ikony - Rysunek 4.17.2 przedstawia, na czym to polega:

i = C K] PRl RSI VRIS GEIY
......... 400 50 pr 100 200 300 200 50
[ 1 1 1 | ol [ 1 | 1 o 1 | [N I AP B B | PR R BEE P | | . 1 1 1 | .
A
e L ittt - ~S it Wttt ittt 1 e a- Mo T A T T T T T T T TS TS msmsmmmm————-—---- 1
- B e
2 — . _| kliknij w ! f ! !
te ikone ' N ' |
ten viezel... Q 1 Wy gtadzony wezet !
I:‘ ik ||[| I:‘ a o___. (styczne sg symetryczne)\;
a-= ] a- '
O - o~ . |
@} g_ Q} g_ Mozesz przesuwac
—~ -~ o konce sty cznych

Rysunek 4.17.2 Linia krzywa uzyskana poprzez zmiane typu wezta na "gtadki, sym etryczny"

W wezle pojawity sie dwie styczne do krzywej. Mozesz sterowaé ksztattem linii zmieniajgc ich pochylenie i dtu-
gos¢. Przedstawiony na rysunku wezet jest "symetryczny", co oznacza ze zmiana jednej stycznej powoduje
identyczng zmiane drugiej. (Dzieki temu wygiecie bedzie bardziej "ptynne", gdyz krzywe z obydwu stron wezta
majg w tym miejscu taki sam promien krzywizny).
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Jezeli nie zalezy Ci na az tak "doktadnych" zaokragleniach — mozesz wezet przetagczyé w tryb = (Rysunek
4.17.3). Wtedy styczne z kazdej strony wezta bedg utrzymywaty wspotliniowosé. Moga sie jednak rézni¢ dtugo-
Scia.

FEIPURE VORI GEIL]

i daliag
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Rysunek 4.17.3 Wezet gtadki, niesymetryczny

e Krzywe, uzyskane w ten sposdb, "na oko" wygladajg na gtadkie. Gdy jednak styczne w wezle réznig sie
diugoscig, wystepuje w nich skokowa zmiana promienia krzywizny.

Gdy chcesz uzyska¢ w wezle ,naroznik” — przetgcz sie w tryb -\‘"". Wtedy mozesz manipulowa¢ kazdg ze
stycznych oddzielnie (Rysunek 4.17.4):

EEIYHRIVY RSO %[ s

: N 7
......... 100 ~ 30 430
P T R T T T Tk. [ P | .'| A T B A | A N N

B
(11 L4
i

| Sty czne sg niezalezne

1
e

DOPOLk

Rysunek 4.17.4 Wezet ostry

Ostateczny ksztatt krzywej uzyskujesz, przeksztatcajgc kolejne wezty na "gtadkie" i — zazwyczaj — symetrycz-
ne (Rysunek 4.17.5). Zaczynasz ten proces od jednego kranca linii tamanej. Sukcesywnie przeksztatcasz w
krzywa i nadajesz wlasciwy ksztatt kolejnym segmentom, dopoki nie dotrzesz do konca linii.

Ten wierzchotek
byt drugi

Ten wierzchotek
wy gtadzilismy jako
pierwszy

Styczng na krancu linii mozna |
"wy ciggnac" z wezta: !

] [shift} {30 S

Rysunek 4.17.5 Krzywa z wieloma wierzchotkami
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Podobnie jak podczas edycji linii tamanych:
- Aby dodaé¢ nowy wierzchotek, kliknij dwukrotnie w miejscu, gdzie ma powstac.

- Aby wierzchotek usung¢é — zaznacz go i nacisnij [Deletel;
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418 Odwzorowanie obrysu zawierajgcego tuk

tuk to specjalny przypadek krzywej. Operacje pokaze na przyktadzie formowania obrysu krawedzi natarcia
statecznika pionowego. Jest to odcinek prostej i fragment tuku. Zaczatem jednak od narysowania dwdéch pro-
stych odcinkéw (Rysunek 4.18.1a):

a + - aF a5 88 -2 YRR _" ey b Fa 48 a5 88 -8 ~ J a
) P B & & &'s o8 o & B o8 1 mr% p q:d ) : —E— = | & &8 % dao & e/ el d q:d
......... — - 2025 3
._Il .1 |2. Zmien wy brany odcinek I.“I PP AT T P “ [ | " I e
* = na segment krzy wej k i
e T U= P8 = oo
I 4 »

1. Kiiknij [BZ0] w srodek
odcinka, by stat sige wybrany.

L
P b '

, £
S i~ ] |
|:| ] i l:‘ Styczna \ .

T ] T Reguluj
@:- i @:_ j krzy wizne
O . E ({)‘;j‘t\:inek uchwytarlni
@}‘ - Promien : prostej 'i",\ .

i ~. /_Ik : _ ~ ;
©) \"-\ 7 : ©) - ~.

= 1 2’ ~ !

5 -,\' I~ Ny =

Rysunek 4.18.1 Obrys — wygtadzanie

Aby zmieni¢ drugi segment w fuk:
- przetacz sie w tryb edycji weztéw;
- kliknij w $rodek segmentu, ktéry ma by¢ zakrzywiony. (Jego obydwa wierzchotki powinny zabarwi¢ sie
na niebiesko);
- naci$nij przycisk w pasku narzedzi, zmieniajgcy odcinek w segment krzywej (Rysunek 4.18.1a);
- ustaw odpowiednio uchwyty stycznych na kohcu linii, aby nada¢ krzywiznie wtasciwy ksztatt (Rysunek
4.18.1b);

W Inkscape kazda krzywa to tzw. krzywa Beziera. Pojedynczy segment takiej linii potrafi catkiem doktadnie od-
wzorowac tuk o kgcie do 60°. W tym przypadku kat nie przekracza 45°, wiec nie dodawatem zadnego dodatk o-
wego wezta posrodku.

Gdy za pomocg krzywej Beziera masz zamodelowaé tuk, trzymaj sie nastepujgcych zasad:

- kierunki stycznych na koncach krzywej powinny by¢ takie same, jak styczne tuku;
- dtugosci obydwu odcinkéw stycznych powinny by¢ rowne.
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419 Odwzorowanie krzywizny

W tej sekcji pokaze, jak za pomoca krzywych odwzorowaé zadany kontur - na przykfadzie obrysu steru kierunku
P-40. (Odwzorowanie przedniej czesci — konturu krawedzi natarcia statecznika pionowego — jest opisane na
str. 115). Jezeli do tej pory w Inkscape rysowates tylko linie famane — zerknij na str. 112. Znajdziesz tam wpro-
wadzenie do tworzenia linii krzywych.

Najpierw obrysuj kontur linig tamang (Rysunek 4.19.1a). Wierzchotki linii wstawiaj w takich miejscach, by naj-
wieksze wybrzuszenie krzywej lezato w réwnej odlegtosci od poczatku i konca odcinka (Rysunek 4.19.1b).

k

cHES AR

1| Zasada rysowania
’| tamanej obry su:

o o R T
i T?’Maksymalne .
] wy brzuszenie — w|
$rodku segmentu

gl
| 544
‘|Obry suj ko
famang

nturu linig

Rysunek 4.19.1 Wstepny obrys steru kierunku — odcinkami prostych

Po narysowaniu linii, wiacz tryb edycji we- | ¥ ¥ & & | ¥ W(ed) 7 LA (3| o | x [zl v [0 a3

ztéw. Zamien tamang na krzywsg, wygtadza- ' e B R f-'-_'-z-»'J-'- v B R B R T

jac kolejne wierzchotki (p. str. 113).. Dla ;T_ ““““““““““““““““““““““““

kolejnych weztéw (poza krancowymi): ; ' AT

- zaznacz wezet jako "symetrycznie
gtadki" (Rysunek 4.19.2);

- dostosuj krzywizne za pomocg stycz-

wezta na

[ T 'sy metry cznie gtadki". f
. . = . 1% (Obydwie st i t t
nych. Czasami trzeba takze przesu- . b [11|(Obydwie styczne maja ten ]
. C=asam kierunek i dtugosc¢)
naé wezet. R § s 700 R

Podczas wygtadzania moze sie takze zda-
rzyé, ze zdecydujesz sie jakis wezet dodac
lub usunaé.

=
o~
i
|

e

Rysunek 4.19.2 Wygtadzanie linii tamanej
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4.20 Rysowanie prostokata

Przetgcz sie w tryb rysowania prostokagtéw (Rysunek 4.20.1):

New
1. Kliknij tu, by wiaczy ¢ E;:' N
rysowanie  prostokata/ @ 1
kwadratu

._,|

oo

P L

SOROX Jm|Pey

el
-

Rysunek 4.20.1 Rysowanie kwadratu

—

[ | ~

]
2. Weisnij [T tu jest

Ry
pierwszy naroznik... o

I |3:J.jl

0,000 |*|px ZI
b |

,—

3. Podczas tego ruchu trzy maj

F—

wciniety IlCtrl , aby uzyskaé
proporcje bokow 1:1...

4. Zwolnij [HZ)'l: tu jest

drugi naroznik.

Ia

O

Wcisnij w miejscu, gdzie ma sie znajdowac jeden z naroznikéw prostokata. Nastepnie, trzymajgc wcisniety

, przesuwaj kursor. Bedziesz "ciggnat" w ten sposéb przeciwlegty naroznik prostokata. Aby uzyskac ksztatt

kwadratu, trzymaj jednoczesnie wcisniety |Ctrl]. Miejsce, w ktérym zwolnisz , wyznaczy przeciwlegty naroz-

nik obiektu.
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4.21 Edycja prostokata

Zaznacz prostokat i przetacz sie w tryb "prostokata" (Rysunek 4.21.1):

-

Rt (0,000 |* Ry: 0,000 |*[pe

Tu mozna wpisa¢ doktadne wartosci

| Change: |w: |112.127% H: 112,127
“;-“,_'lll)-.ll-l-l-|.|I".'I|.|.I-Ml
—8 N
f\ 1 [
Wigcz tryb _
"prostokata” " N

wy sokosci (H) i szerokosci (W)

(=1=1 f_-.;l
1 1

©@LOoOCLLP

=

Te uchwyty stuzg do|
zZmiany pofozenia
naroznikéw

2y

Rysunek 4.21.1 Punkty sterujgce rozmiarem prostokata

Mozesz przeciggnaé kwadratowe uchwyty, umieszczone w naroznikach prostokata, w nowe miejsce. W ten

sposo6b zmieni¢ rozmiar tego obiektu. Alternatywnie — mozesz ustali¢ rozmiar w sposob doktadny — wpisujgc
wartosci numeryczne w pola W, H, umieszczone w przyborniku ponad obszarem rysunku (Rysunek 4.21.1).

Dodatkowo, prostokat ma w poblizu prawego gérnego naroznika widoczne jeden lub dwa okragte wezty. Gdy
widzisz jeden, oznacza to, ze sg na siebie natozone (por. Rysunek 4.21.1). Wezty okragte stuzg do ustalenia
promienia zaokraglenia naroznikow prostokata (Rysunek 4.21.2):

Change:

fc
el
] 1

1%, '.-.;l
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| I R '

©20PLLLH

o
&
|

Wi 112,127 H: (1120275
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e e e
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Gdy rozsuniesz te wezZly —
narozniki prostokgta stang sie
zaokraglone.

i

Rysunek 4.21.2 Prostokat - zaokraglanie

Rx: |15.000] (5 Ry: |15.000 #px w

B

L

Tu mozna wpisa¢ doktadne warto$ci promienia
zaokraglenia w kierunku X (Rx) i Y (Ry).

Jezeli przeciggniesz jeden okragty wezet do dotu, a drugi - w lewo (Rysunek 4.21.2) — narozniki prostokata
stang sie zaokraglone. Jezeli zsuniesz je w to samo miejsce — narozniki stang sie ostre. Mozesz ustali¢ do-

ktadne wartosci promieni zaokraglenia, wpisujgc je w pola Rx i Ry, umieszczone ponad obszarem rysunku.

Zwro¢ uwage, ze zaokraglenia moga by¢ eliptyczne (gdy Rx i Ry nie sg rowne).
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4.22 Rysowanie elipsy

W Inkscape okregi rysuje sie tak samo jak kwadraty (por. str. 117). Wybierasz tylko inny tryb rysowania: okre-
géw (oznaczony ikona: O ). Nastepnie naciskasz w miejscu, gdzie majg siegaé lewe, gorne granice elipsy.
Przeciggasz kursor z wcisnietym , i zwalniasz ten przycisk w miejscu, do ktérego majg siegac¢ prawe, dolne

granice elipsy (Rysunek 4.22.1):

2. weisnij [ tujest| | -

: New: Start, T ; - = (o L

: pierwszy naroznik...

......... ||._-.3 l;.,_q

k P e i T T I T T T T P T I . e

3. Podczas tego ruchu

Pl

trzy maj weisniety |Ctrl|, aby
uzyska¢ proporcje bokow,
1:1...

1. Kliknij tu, by
wigczy ¢ ry sowanie
elips/okregéw

4. ..zwolnij [HZ): tu

/ jest drugi naroznik.
+
)

Yelo) Jupers

=i
>
|

Rysunek 4.22.1 Rysowanie okregu

Podobnie jak w przypadku kwadratéow, wazne jest wcisniecie klawisza [@ podczas "przeciggania" drugiego

punktu, bo inaczej narysujesz elipse.

e Jezeli podczas tworzenia okregu bedziesz trzymat wcisniety klawisz IShift] — poczatkowe potozenie myszKi

stanie sie srodkiem okregu, a nie naroznikiem jego ,ramki”
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4.23  Edycja elipsy
Zaznacz okrag/elipse i przetgcz sie w tryb "okregu" (Rysunek 4.23.1):

Fa

Change: Stark: (0,000 |5 End: |0.000 |5

| 20 250

>
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el

Tymi punktami
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Wigcz tryb
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Rysunek 4.23.1 Wezly sterujace elipsy/tuku

Kwadratowe wezty sterujgce, umieszczone z lewej strony i u gory, stuzg do zmiany dtugosci promieni elipsy/
promienia okregu.

Okragte uchwyty stuzg do zmiany elipsy w tuk (eliptyczny) (Rysunek 4.23.2):

Fhange: Start: (0,000 |3 |End: 00,0003 (SRS

Tu mozna wpisaé
doktadne wartosci
kata poczatkowego i
koncowego

Nacis$nij tu, by z
powrotem
zamkng¢ tuk

Ty mi punktami okreslasz
rozwartos¢ kata tuku.

Rysunek 4.23.2 Przeksztalcenie w tuk

Doktadng warto$é kata poczatkowego mozna wpisaé w pole : Change: | starti oo [T end: [so00ocy | & (U ©

Start, a koncowego — w pole End, umieszczone w przybomniku y =
ponad obszarem rysunku (Rysunek 4.23.2). f;:“ |

@

lkona , umieszczona z lewej strony, stuzy do ponownego za-

Przetgcz sie w ten tryb, jezeli
a- |nie chcesz linii skierowanych
do $rodka elipsy

mkniecia elipsy (zmiany kata tuku na 360°).

Jezeli nie chcesz widzie¢ linii skierowanych od krancéw tuku do

= |

srodka elipsy — przetgcz sie na alternatywny tryb rysowania
(Rysunek 4.23.3).

=15
1

9OPLLh

Rysunek 4.23.3 Drugi spos6b rysowania tuku
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4.24 Przesuniecie

"Ztap" obiekt (tylko nie ramke zaznaczenia!) i przesuwaj. Punkt, gdzie zwolnisz , okresli nowe potoze-

nie obiektu. Na przyktad, ztap za obraz rzutu z gory i przesun, aby wyrowna¢ z rzutem z lewej (Rysunek

4.24.1).

% |606.2873 v [80.250 [ [w [z300.003 @

b |

P

Przesun () rzut z goéry, aby '

wy réwnaé do rzutu z boku

A

BRELSOLP0OCLLH

3

ANAoh -

Rysunek 4.24.1 Przesunigcie — dopasowywanie rzutu z géry do rzutu z boku

3500

»

@)

Zamiast
tu

mozesz
doktadne potozenie

przesuwac,
wpisac

£

Aby dobrze dopasowaé do siebie obydwa obrazy, czesto warto uzy¢ linii pomocniczych (Rysunek 4.24.2):

0 | 250 | 51 | 50 | 1000 1500
[ L Ledood ol

1750

(I R T, I

Linie pomocnicze — bardzo przydatne, gdy
doktadnie dopasowac¢ do siebie dwa obrazy

-

Rysunek 4.24.2 Linie pomocnicze — ulatwiajg dopasowanie dw6ch obrazow

750 |2& |22=.r.1
L e e L L L T T I i

Zamiast przesuwacC obiekt myszka, mozesz takze wpisa¢ doktadne wspodtrzedne jego nowego potozenia. Mo-

zesz to zrobi¢ w polach X, Y, w przyborniku ponad obszarem rysunku (Rysunek 4.24.1).
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4.25 Ramka selekgcji

W Inkscape, wokot kazdego zaznaczonego obiektu rysowana jest ramka. Nazwijmy jg ramka selekcji.
Poczatkowo ramka selekcji pojawia sie zawsze w trybie "zmiany rozmiaru" (Rysunek 4.25.1). Jezeli jednak
jeszcze raz klikniesz w zaznaczony obiekt , przetaczysz sie w tryb "obrotu/przekoszenia" (Rysunek 4.25.2):

~ ] o, * - »

Uchwyty, pozwa-
lajgce zmienié
rozmiar obiektu

Uchwy ty
przekoszenia

A R EEEEEEEEEE
-

Rysunek 4.25.1 Ramka zmiany rozmiaru Rysunek 4.25.2 Ramka obrotu/przekoszenia

Ramka obrotu zawiera bardzo wazny punkt — $rodek transformacji. Jest oznaczony niewielkim krzyzykiem
(Rysunek 4.25.2). (Gdy nie mozesz go od razu dostrzec, zmniejsz powiekszenie — wtedy fatwiej go znalez¢).

Srodek transformacji mozna "ztapad" i przesung¢ w
inne miejsce (Rysunek 4.25.3).
Srodek jest zawsze wykorzystywany przez Inkscape pod-

——

czas obrotu, oraz — gdy trzymasz wcisniety klawisz [Shift| —

podczas zmiany skali i przekoszenia.

Ztap B i
przesun $rodek
transformaciji

Rysunek 4.25.3 Przesuwanie srodka obiektu
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4.26 Skalowanie

Zaznacz obiekt, ktéry ma by¢ zmieniony. Nastepnie ztap | za uchwyt ramki selekciji i przeciggnij. Nowe roz-

miary obiektu bedg ustalone dla miejsca, w ktérym zwolnite$ (Rysunek 4.26.1):

Srodek transformacji

ten uchwyt...

Rysunek 4.26.1 Zmianarozmiaru (s kali) obiektu

Domys$inym Srodkiem skalowania jest przeciwlegty naroznik ramki.

Ztap zf . ... ™ ... T

.. |1 przesun w
nowe miejsce!

Aby zmienia¢ skale wzgledem sSrodka obiektu (patrz str. 122) — podczas przesuwania myszki dodatkowo trzy-

=

maj wcisniety klawisz ‘Shift|.

Aby zmieni¢ skale réwnomiernie we wszystkich kierunkach — podczas przesuwania myszki dodatkowo trzymaj

wcisnigty klawisz [Ctrl].

Jezeli chcesz dokona¢ zmiany skali o doktadnie ustalong wartos¢
— otworz panel Transform za pomoca polecenia
Object>Transform ([shift|{Ctril{M]) . Wybierz w niej zaktadke
Scale (Rysunek 4.26.2). W pola Width, Height mozesz wpisac
doktadne wartosci nowej skali.

I_f_\}_“'_':TransFDrm (ShiftHCErH-r) O]

Move | Scale | Rokate | Skew | Matrix

) width | 120.000 e R 2
2
v

@ Height |120.0

00

[] Apply to each object separately

Clear l [ apply

Rysunek 4.26.2 Panel transformacji — zaktadka

skalowania
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4.27 Przekoszenie (Skew)

Zaznacz obiekt, ktory ma by¢ przekoszony. Kliknij w niego jeszcze raz, aby przetgczy¢ ramke selekcji w tryb
przekoszenia (szczegodty - str. 122). Nastepnie ztap za jeden z uchwytéw na boku ramki, i przesun. Przeko-
szenie obiektu bedzie ustalone dla miejsca, w ktérym zwolnisz (Rysunek 4.27.1):

1

1

1

1

1

1

| Srodek
‘[“: i +A( transformacji

1

1

1

1

1

1

1

Ztap (B} za

.. | przesun
ten uchwyt...

nowe miejsce!

Rysunek 4.27.1 Obroét obiektu

Przed przekoszeniem mozesz przesung¢ srodek transformacji w inne miejsce. Wystarczy go "ztapac" i
przesungé (szczegoty — str. 122).

Aby przekoszenie nastepowato skokowo, dokfadnie co 15° — podczas przesuwania myszki dodatkowo trzymaj
wcisniety klawisz [Ctrl].

Jezeli chcesz dokona¢ przekoszenia o dokfadnie ustalong wartoS¢ —  [Tirransran fehirect i B ®

otworz panel Transform za pomocg polecenia Object=> Transform

i Move | Scale| Rokate| Skew | Matrix
(shift|{Ctri{m]) . Wybierz w niej zakladke Skew (Rysunek 4.27.2). W S, toronesl [20.000 8 B
pola Horizontal, Vertical mozesz wpisa¢ doktadne wartosci przeko- ﬂ Vertical | 0,000 £
szenia.

[] Apply ko each ohject separately

Clear l | apply

Rysunek 4.27.2 Panel transformacji — zaktadka
przekoszenia
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Dodatki

Czytajgc wczesniejsze rozdziaty, zapewne przekonate$ juz sie, ze uwielbiam umieszczaé u dotu strony przypisy
z dodatkowymi informacjami. Ta cze$¢ ksigzki to wtasciwie wybor takich "uwag na marginesie", ktére w trakcie

pisania urosty do rozmiaru catej sekcji ©.

Jak w kazdym dodatku, s3 to informacje, z ktérych nie musisz korzystac, aby stworzy¢ e-model samolotu. Cza-
sami jednak mogg sie przydac, by co$ wyjasni¢ lub utatwic. Mam jednak nadzieje, ze znajdziesz tu rozwiniecie
wielu zagadnien, ktére $wiadomie skracatem w gtéwnym tekscie ksigzki.
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Rozdziat 5. Szczegdéftowa weryfikacja planéw samolotu

Mozna powiedzie¢, ze jest to rozdziat dla prawdziwych modelarzy — istot, ktére chcg odtworzyé pierwowzor
najdokfadniej, jak to jest mozliwe. Efektem poréwnan, ktdre pokaze ponizej, bedzie poprawiona sylwetka P -40.
Szczerze moéwigc, metody, ktdére tu przedstawiam, pozwolityby opracowaé solidne plany modelarskie. Nie to
byto to jednak w tym przypadku moim celem.
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5.1 Poréwnanie z rysunkami fabrycznymi

Znalaztem w Internecie ([1] ) obrazy kilku rysunkéw fabrycznych P-40. Niestety, nie majg zbyt duzej rozdziel-
czosci, wiec wiekszosci wymiaréw nie mozna odczyta¢ (Rysunek 5.1.1). Mimo tego sie przydadzg. W tej sekc;ji
sprobujemy poréwnac¢ z nimi odpowiednie fragmenty planéw samolotu.

Wymiary sg
nieczy telne!

Rysunek 5.1.1 Przyktadowy, zeskanowany rysunek fabryczny (z www.p40warhawk.com)

To poréwnanie wykonamy w Inkscape (wprowadzenie — patrz str. 96), a nie w GIMP. Dlaczego? W Inkscape
wygodniej jest skalowa¢ i obraca¢ obrazy. GIMP na czas takiej operacji wytgcza wszelkie "przejrzystosci”
warstw. Inkscape podczas transformacji niczego nie przetagcza ani nie wytgcza - warstwy pozostajg przejrzyste.
Dzieki temu przez caly czas nie tracisz z oczu wzorca, do ktérego sie dopasowujesz. To ogromna réznica. Do-
poki nie chcemy ingerowa¢ we "wnetrze" poréwnywanych rysunkow, Inkscape jest lepszym narzedziem porow-
nawczym.

Zaczniemy od weryfikacji ksztattu usterzenia poziomego. Zmien nazwe pierwszej warstwy (utworzonej domys I-
nie w nowym rysunku przez Inkscape) z Layer 1 na Image (szczegdly — str. 102). Dodaj takze drugg warstwe
— nazwijmy jg Drawing.

W warstwe Image wstawimy obraz rzutu z lewej:
- wybierz warstwe Image jako aktualng;
- wezytaj (File=>Import, str. 99) plik P40C-ML-Left.tif (por.str. 47);
- dosun wczytany rysunek do lewego goérnego naroznika obrazu (Rysunek 5.1.2):

& = = 57 |><|n 263 |“ |224 4sh| |w|2390 uc|“ = Hm ’px_j Affect: |§|
. 1

.|Tu mozna wpisac e [ |zm
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wspotrzedne X

— Ztap .() |—_|
q przeciggnij TToTTToo
0 T . Ny

- —7TTE N
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Rysunek 5.1.2 Przesuwanie obrazu na docelowe miejsce
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Na koniec zablokuj warstwe Image przed zmianami (p. str. 102). Dzieki tej blokadzie nie bedziesz w stanie
omytkowo zaznaczy¢ i przesung¢ obrazu.

Teraz zatadujemy rysunek fabryczny steru kierunku na warstwe Drawing:
- wybierz warstwe Drawing jako aktualng;

- wczytaj Source\Curtiss\Tail-Rudder framework.gif (z pliku source.zip — por. str. 17)

Rysunek 5.1.3 pokazuje rezultat:

Rysunek 5.1.3 Rysunek steru kierunku, zaraz po wczytania

Jak wida¢ (Rysunek 5.1.3), wczytany obraz musimy nieco przygotowaé, nim zaczniemy przymierza¢ do planéw:
- wywolaj polecenie Object=>Rotate 90° CW (lub uzyjprzycisku z paska skrotéow);
- ukryj na razie warstwe Image (p. str. 102);
- zmniejsz nieprzejrzystos¢ warstwy Drawing do 60% (p. str. 102);

Rysunek 5.1.4 pokazuje rezultat:

?_! b5
l |.|?Q Slayers (Shift-+Ckrl+LY H =
k S $ P
RS- : :
I 2 ! .
fﬁ & Obrét o ——> v | Image
) o | il
90 ! 3 i Ukryj na razie|__
Q, ?— ! ! warstwe Image. |
) i 1 Blend mode: |Normal ZI
D § , | Opacity, %
© | | 3 00 [
O - -
N 1 1
- ! TR " Zmniejsz
Q} ] ! i A nieprzejrzy sto$¢
— ! e T C— warstwy
@ : ! i ! Drawing
3 | |
P : :
1 1
l_[; - " I ¥ L’

Rysunek 5.1.4 Wstepne przygotowanie rysunku
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Zbliz sie do obrazu steru kierunku (str. 101) i przyjrzyj mu sie uwaznie. Czy osie sg proste? Czy sg wzajemnie
prostopadte? (Rysunek 5.1.5):

Dodaj do rysunku kilka linii pomocniczych
(p. str. 106). Rozmies¢ je tak, by mozna

O$ steru jest tylko
byto sprawdzi¢, czy kluczowe linie rysun- |odrobing odchylona

ku sg pionowe lub poziome.

Linie pomocnicze —
“ |tworzenie i obstuga
= |jak w GIMP

W przyktadzie, ktéry pokazuje ilustracja
(Rysunek 5.1.5), wyglada na to, ze o$
steru ma odchylenie. Jednoczesnie linie
zeber sg poprawne, czyli poziome. Taka
sytuacja oznacza, ze rysunek ma drobne
przekoszenie. Bedzie to trzeba poprawi¢
przez transformacje odwrotng (por. Rysu-
nek 5.1.6¢c, szczegbty — str. 124). s

1

= SE

|Zebro jest poziome | _

Musimy jednak wcze$niej zadbaé o wia-
sciwe potozenie Srodka tego przekosze-
nia (p. str. 122). Przesun rysunek tak, by

Przesun stad $rodek|-
transformaciji nad
dolny zawias steru

dolny zawias steru znalazt sie tam, gdzie

przecinajg sie dwie linie pomocnicze.
Nastepnie przesun w to miejsce takze

srodek obrazu (Rysunek 5.1.5, Rysunek Rysunek 5.1.5 Wyszukiwanie deformacji w rysunku fabrycznym
5.1.6b).

Rysunek 5.1.6 pokazuje szczegéty przekoszenia (Skew), ktérym skorygujemy odchylenie osi na rysunku fa-
brycznym (Rysunek 5.1.6a). Srodkiem tej transformacji jest punkt, w ktérym o$ rysunku pokrywa sie z linig po-
mocniczg (Rysunek 5.1.6b):

e —— B e T NP

Kory gowane: -
odchylenie osif®=-[= ~
steru od linii

pomocniczej —

Odchy lenie skory gujemy
drobnym przekoszeniem

(Skew)

Srodek
transformaciji

[

Rysunek 5.1.6 Korygowanie przekoszenia obrazu

Tak niewielkie przesuniecia, jak przedstawiona powyzej, staraj sie wykona¢ w jak najwiekszym powiekszeniu.
(Wystarczy widzie¢ na ekranie uchwyt, ktéry masz ,ztapa¢” myszkg, i mie¢ troche miejsca na przesuniecie).
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Rysunek 5.1.7 pokazuje, w jakim powiekszeniu mozna wygodnie i doktadnie skorygowa¢ niewielkg deformacje
osi. Widzimy tu tylko fragment ramki obrotu (Rysunek 5.1.7a). To nic nie szkodzi, bo najwazniejszy element —
uchwyt przekoszenia — jest nadal dostepny do "ztapania". Na ekranie jest takze miejsce na jego przesuniecie.

i@ b) .a@

2250

2150
IIIIIIIII

2150
a) IIIIIIII

Lol “os steru, linia pomocnicza, i
g kory gowany dy stans sg duze

i widoczne

Er L]
1

Fragment ramki
] ;Jobrotu — uchwyt
; przekoszenia (Skew)
1 .=|: -""\-\..-\"-\.

:-+ ‘|Jest tu takze miejsce na
wy konanie przesuniecia.
_{(Poprawka jest mata, wiec i
=52 miejsca nie trzeba zbyt wiele)

. Po przesunieciu
S Ao < uchwytu w prawo o$
el L1 _|pokryta sie z linig
o (0 Rk pomocniczg

.

Rysunek 5.1.7 Przykiad powiekszenia, w ktorym koryguje os steru

Przeciagnij uchwyt w prawo tak, by os na obrazie pokryta sie z linig pomocnicza (Rysunek 5.1.7).

e Jezeli w czasie przeciggania drgnefa Ci reka - dopdki nie zwolnisz , mozesz nacisngé [z] To przerwie

calg operacje.

o Jezeli juz skonczytes$ - i skrzywite$ rysunek - zawsze mozesz wycofa¢ ostatnie polecenie (Edit >Undo, albo

|ctri{z)).

|

Wigcz z powrotem widocznos¢ warstwy Image, z sylwetkg samolotu. Nasun (por. str. 121) obraz steru na syl-
wetke tak, by w tym samym miejscu miaty dolny zawias. (Pamigtasz? tam umiescilismy srodek tego obrazu).
Zmniejsz rysunek steru, za pomocg naroznego uchwytu ramki (Rysunek 5.1.8). Zréb to, tak, by rozmiar zmienit
sig proporcjonalnie wzgledem ustalonego $rodka transformacji. (Trzymaj wcisnigte klawisze [Shift] i [Ctrl] — por.
str. 123)

2.  Zmniejszaj proporcjonalnie

obraz (trzy majgc wcisniete ||@“|

F [Shift"). Zrob to tak, by uzgodnié
’7 z planami potozenie goérnego
zawiasu

Il Jrr———
1. Nasun obraz na sylwetke tak, . .
by dolny zawias steru ($rodek |l Ml
transformacji) byt w tym samym [
miejscu co na planach |

Rysunek 5.1.8 Nanoszenie rysunku fabrycznego na sylwetke samolotu

Podobnie jak rysunek steru kierunku, wczytaj i dopasuj rysunek statecznika pionowego (plik Source\Curtiss\Tail-
Fin.gif, z pliku source.zip). Uwaga: rysunek jest nieco obrocony i przekoszony — popraw go nim ziozysz ze
obrazem steru. Statecznik dopasuj do steru tak, by pokrywaty sie ich osie oraz punkty zawiaséw. Obraz statecz-
nika umies¢ na tej samej warstwie, co obraz steru (Drawing).
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Rysunek 5.1.9 przedstawia ostateczny efekt natozenia rysunkéw fabrycznych na rzut z lewej. Widaé réznice
pomiedzy liniami planéw modelarskich i dokumentacji samolotu. To, ze sg niewielkie, dobrze swiadczy o auto-
rach planow.

- e Mniejszy |
promien s W

A :

. 1

krzywizny | =&

Roéznica: na rysunkach
fabrycznych krawedz
—|nieco bardziej w tyle

’ L Odrobine
LR inny  ksztatt

- ! ' obry su klapki
’ trymera
R, 2 | N

Rysunek 5.1.9 Efekt nalozenia rysunkow fabrycznych narzut z lewej

Gdy znalezlismy takie réznice — warto je uwzgledni¢ przy budowie modelu. Jednak korzystanie wprost z rysun-
kéw fabrycznych bywa troche nieporeczne. Jest ich duzo, i zawierajg sporo nieczytelnych wymiaréw. (Takie
wymiary sg zupetnie bezuzyteczne). Proponuje nanies¢ na rzut z lewej poprawiony obrys usterzenia pionowe-
go, odpowiadajgcy rysunkom fabrycznym. Linie tego obrysu narysujemy w Inkscape, na oddzielnej warstwie.
Nazwiemy jg — Correction. Aby nasze poprawki odrézniaty sie od reszty rysunku, wszystko na tej warstwie
bedzie w kolorze czerwonym. Ztozenie warstw Correction i Image wyeksportujemy jako rysunek rastrowy (por.
str. 100) P40C-ML-Right.png, ktory uzyjemy w Blenderze.

Zrobmy to. Zablokuj warstwe Drawing przed zmianami. Dodaj do rysunku nowag warstwe — Correction (str.
103).

Rysowanie poprawek zaczniemy od naniesienia osi i kilku linii pomocniczych. Narysujemy je w kolorze niebie-
skim, by zaznaczy¢ w ten sposob, Zze nie sg zadnym "namacalnym" elementem konstrukcji.

Narysuj linie osi steru (Rysunek 5.1.10). Po narysowaniu pierwszej linii przestaw (por. str. 109):
- grubos¢ na 0.5 px;
- wzor na linie kreskowang;
- barwe na kolor niebieski.

(Dopoki tych ustawien nie zmienisz, kazdy kolejny obiekt, ktéry narysujesz, bedzie miat wlasnie takg grubosé,
barwe i wzor).

Na rysunku statecznika pionowego znajduje sie takze o$ i zarys profilu statecznika poziomego. Teraz narysuj
samg o0$, potem skopiuj takze profil. (Na wszystkich planach modelarskich statecznik wydaje sie mie¢ zbyt zao-
kraglong krawedz natarcia. Dokumentacja fabryczna i zdjecia wskazujg raczej na zastosowanie profilu z ostrym
noskiem — p. str. 159).
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Ta czes$¢ obrysu
to fragment
okregu

0s statecznika
poziomego

(moze sie przydac
pozniej)

Rysunek 5.1.10 Naniesienie na rysunek osi steru i kilku pomocniczych obrysow

Rysunek 5.1.10 zawiera, oprdcz linii, takze okrag. Na planach fabrycznych jest zaznaczone, ze obrys zaokra-
glonej koncowki statecznika byt tukiem. Aby to sprawdzic¢, umiescitem w podanym przez plany srodku okrag, o
odpowiednim promieniu (rysowanie okregu — p. str. 119). Zgadza sie z zarysem statecznika!

Teraz narysuj wszystkie wazne linie wewnetrzne. Sg to linie proste, czasami sktadajace sie z kilku segmentéw.
Po narysowaniu pierwszej z nich zmien jej wtasciwosci: barwe linii na kolor czerwony, a wzér linii na linie ciagta.
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Rysunek 5.1.11 Poprawianie narysowanych linii
Podczas rysowania nie zapomnij trzymac¢ wcisniety klawisz , aby linie byty doktadnie pionowe lub poziome.

Gdy jednak zdarzy Ci sie popei¢ btad — mozesz to poprawi¢. Wystarczy przetaczy¢ sie w tryb edycji weztéw
(p. str. 111) (Rysunek 5.1.11).
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Linie krzywe, odwzorowujgce ksztatt samolotu, najlepiej jest tworzy¢ w dwdch etapach:
- najpierw obrysowac kontur przyblizong linig famang, o niezbyt duzej liczbie wierzchotkow;
- potem wygtadzi¢ te przyblizong linie tak, by doktadnie odda¢ ksztatt obrysu.

Na str. 112 znajdziesz ogdlne informacje o pracy z krzywymi w Inkscape. Na stronie 115 umiescitem sie opis,
jak odwzorowac krawedz natarcia statecznika pionowego (jest to ztozenie linii prostej i tuku). Na str. 116 znaj-
dziesz opis, jak odwzorowa¢ kontur steru kierunku (jest to "ogdlna" krzywa, a nie zadne ztozenie tukow).

Rysunek 5.1.12 przedstawia ostateczny efekt korekt. Wykorzystatem tu wszystko, czym dysponowatem, nawet
rysunek fabryczny owiewki wokét usterzenia i kadtuba. (Nie pokazatem, ani nie omawiatem go w tej sekcji.)

Zebra i detale sg
- | przesunigte w
stosunku do

planow JJ/ML

e Kontur ma mniejszy

J promien

Statecznik  poziomy |
jest nieco wiekszy!

—

Poprawna granica
owiewki!

O

Poprawna, przesunieta do przodu
krawedz kadtuba!

O$ steru kierunku

Rysunek 5.1.12 Korekty usterzenia pionowego

Szczegodlnie zaskakujgce na tym rysunku jest przesuniecie tylnej krawedzi kadtuba. (Chodzi o krawedz ostatniej
wregi kadluba, wzdtuz ktérej biegnie o$ steru kierunku — Rysunek 5.1.12.) Wedtug wszelkich zdje¢, o$ steru
lezata z tytu tej linii, a na rysunkach JJ/ML jest z przodu. Takze ksztatt dolnej krawedzi owiewki usterzenia jest
inny, niz na planach modelarskich.

Zachowaj to poréwnanie jako plik P40C-ML-Left.svg (por. str. 97). Wyeksportuj takze do bitmapy (File 2>Export
Bitmap) jako plik P40C-ML-Left.png.

Podsumowanie

o Jezeli dysponujemy rysunkami fabrycznymi, choéby fragmentéw samolotu — warto je natozy¢é na plany
modelarskie. Mozemy odkry¢ wiele roznic (str. 131)!

e Do poréwnania (poprzez natozenie) wielu obrazéw wygodniej jest uzywac¢ Inkscape, a nie GIMP. W Inks-
cape podczas kazdej transformacji (skalowania lub obracania) nie tracisz z oczu zadnej z warstw. To zde-
cydowanie utatwia wzajemne dopasowanie (str. 130).

e  Korekty oryginalnych rysunkéw nanosimy w Inkscape na oddzielng warstwe, w kontrastowym kolorze (np.
czerwonym — por. str. 133)
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5.2 Rzut z boku: poréwnanie ze zdjeciami

Poréwnanie planéw modelarskich z rysunkami fabrycznymi zmusito nas w poprzedniej sekcji do naniesienia
poprawek na plany. Mielismy do dyspozycji tylko rysunki fragmentéw ogona: statecznika pionowego, jego
owiewki, i steru kierunku. A co z resztg? Nie mamy juz wiecej fabrycznej dokumentacji kadtuba wersji P-40 B/C.
Czy nie czaja sie tam kolejne niespodziewane réznice? Pozostaje poréwna¢ naszg sylwetke z jakim$ wyraznym
zdjeciem (Rysunek 5.2.1):

Widoczny dystans pomiedzy topatami $migta

$wiadczy o tym, ze ten fragment jest juz
znacznie znieksztatcony perspekty wicznie

Natozenie na siebie goleni oznacza, ze
=1 gdzie$S na ten obszar skierowano centrum

ot obiekty wu aparatu fotograficznego

Rysunek 5.2.1 Tomahawk IIA (Hawk 81-A2, czyli P-40B) na lotnisku fabrycznym (Curtiss).

Wczytaj to zdjecie (Source\Photo\P40B-Left-Photo.png z pliku source.zip, por. str. 17) do Inkscape. Warstwe, na
ktérej je umiescisz, nazwij Image. Zawsze zaczynaj od sprawdzania, czy fotografia jest zdeformowana — nie-
proporcjonalnie rozciggnieta w pionie lub w poziomie. Wybierz w tym celu na obrazie cos, co powinno by¢ ko-
tem. W przypadku tego zdjecia (Rysunek 5.2.1) sg to piasty podwozia gtéwnego:

Deformacja
kota

___________________

Rysunek 5.2.2 Oryginalne zdjecie Rysunek 5.2.3 Zdjecie po przeskalowaniu (Y: -4%)

Narysuj ponad piastg okrag (rysuj z wcisnietym ﬁ@ by na pewno nie byt elipsg). Jezeli dostrzezesz odchylenia
w ksztatcie piasty (Rysunek 5.2.2) — przeskaluj zdjecie (tj. obraz), aby stata sie z powrotem kotem (Rysunek
5.2.3).
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e Podczas dopasowywania zdjecia, utatwisz sobie prace przesuwajac srodek transformaciji do srodka wzor-
cowego okregu. Pamietaj tylko, gdy bedziesz zmieniat skale obrazu, aby trzymac¢ wcisniety klawisz |Shift).

(W ten sposdb wymusisz przeskalowanie wzgledem $rodka transformacji obiektu).

Po sprawdzeniu i ewentualnym "wyprostowaniu" zdjecia, usun niepotrzebny juz okrag. Zablokuj takze przed
zmianami warstwe, na ktoérej znajduje sie ta fotografia.

e Uzywaj zdje¢ o jak najwiekszej rozdzielczosci. Na zdjeciach marnej jakosci poprawny okrgg moze sie wy-
dawaé odrobine sptaszczony, z powodu duzego rozmiaru rastra (pikseli). Kierujgc sie tg fatszywg przestan-
kg, mozesz sptaszczy¢ zdjecie. Potem bedziesz sadzit, ze caty rzut z lewej jest do poprawy, gdyz nie pas u-

je do fotografii.

Utworz nowa warstwe (o nazwie Drawing) i wczytaj na nig rzut z lewej (P40C-ML-Left.png). Nastepnie zwieksz

przejrzystosc¢ tej warstwy (Rysunek 5.2.4):

A B rC |D rE rF rG H

Rzut z lewej na warstwie
Drawing (na wierzchu)

% ."‘\Zdjecie na warstwie

Photo (pod spodem)

Rysunek 5.2.4 Nalozenie na fotografie rzutu z lewej

Dopasuj rzut z lewej do sylwetki na fotografii. Pochyl go w ten sam sposdb, co samolot na zdjeciu. Zmniejsz
skale tak, by wysokos$¢ kadtuba w okolicy najmniejszego znieksztatcenia byta zgodna z wysok o$cig na zdjeciu
(Rysunek 5.2.5):

W ty m miejscu uzgodnij
wy soko$é kadtuba C
sy lwetki i zdjecia /

Obszar, w ktérym kadtub ma
najmniejsze znieksztatcenie

Obszary o najwigkszym
|znieksztalceniu

______________________ S

Rysunek 5.2.5 Wstepne dopasowanie sylwetki do zdjecia
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Po wstepnym dopasowaniu sylwetki do zdjecia wida¢, Zze nie bedziemy ich w stanie od razu poréwnaé. Znie-
ksztatcenie geometryczne fotografii jest zbyt duze. Pomijam znieksztatcenie perspektywiczne skrzydta (jego
koncowka jest o wiele blizej obiektywu). Ksztattem ptata nie bedziemy przejmowac. Wazny jest tylko jego profil
przy kadtubie, w szczegdlnosci punkt na krawedzi sptywu.

W rzucie z boku najwazniejszy jest obrys kadtuba. Linia ta lezy na ptaszczyznie symetrii samolotu. Na analizo-
wanym zdjeciu (Rysunek 5.2.2) ulegta tzw. "znieksztatceniu beczkowatemu". Rysunek 5.2.6 i Rysunek 5.2.7
pokazujg, jak wyglada takie znieksztatcenie na przyktadzie fotografii regularnej, prostokatnej siatki.

Znieksztatcony | [ A | - Znieksztatcony
obraz » H#i Fﬁjﬁ; obraz
-1‘# g+#lr~

TN

Krzywa deformacii deformacii Wy gieta _/
(hiperbola) koncowka
Rysunek 5.2.6 Proste znieksztatcenie beczkowate Rysunek 5.2.7 Ztozone znieksztatcenie beczkowate

Gdyby soczewka obiektywu aparatu fotograficznego miata idealng ogniskowg — uzyskaliby$my znieksztatcenie
proste (Rysunek 5.2.6). Deformacja obrazu ma tu ksztatt hiperboli.

W realnym Swiecie nic nie jest jednak proste, a ogniskowe - idealne. Deformacja zdjecia wykonanego obiekty-
wem o ztozonej ogniskowej moze mie¢ skomplikowany ksztatt — przyktad pokazuje Rysunek 5.2.7. W okolicy
krawedzi tej fotografii krzywa deformacji obrazu ma koncowki wygiete do goéry. (Doktadniejsze wyjasnienie natu-
ry tej transformacji mozesz znalez¢ w dodatku 6.1, na str. 152).

Czy mozna jako$ zdeformowac¢ rzut z boku tak, by odpowiadat sylwetce na poréwnywanym zdjeciu? Ze wzgle-
du na pracochtonnosé¢, bez zastosowania komputera jest to niewykonalne. A to oznacza, ze wszelkie rysunki
samolotéw wykonywane metodg tradycyjng mogg zawiera¢ ré6znorodne btedy ksztattu. Autor takich rysunkéw na
pewno doktadat wszelkich staran, aby zrobi¢ je jak najdoktadniej. Zazwyczaj jednak (prawie zawsze) pods tawg
do opracowania nowych planéw modelarskich byty:

- rysunki samolotu opracowane przez innych autoréw;

- zdjecia, ktére byly porownywane z planami w duzej mierze "na oko". Deformacja perspektywiczna byta

kompensowana tylko w za pomocg bardzo zgrubnych poprawek.

Z kolei sam fakt opracowania rysunkéw na komputerze nie Swiadczy jeszcze o tym, ze sg bezbtedne. Jezeli

bazowaty wytgcznie na wczesniejszych opracowaniach - mogg tylko powtarza¢ popetnione wczesniej pomytki
innych autorow.
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Obecnie istniejg juz wyspecjalizowane programy, odwzorowujgce deformacje perspektywiczng — jednym z nich
jest np. Hugin (dostepny w ramach licencji Open Source). Ku mojemu zaskoczeniu, znalaztem jednak te funk-
cjonalnos¢ takze w Gimpie. (W kazdym razie oceniam, ze jest wystarczajgca do naszych celéw). Sprobujmy ja
zastosowac. W tym celu przygotuj w Gimpie odpowiednie zestawienie:

wyeksportuj (File >Export Bitmap) z Inkscape zawartos¢ warstwy z fotografig (por. Rysunek 5.2.5, str.
135) do pliku P40C-ML-Left-Photo.png;

wyeksportuj z Inkscape zawartos¢ warstwy Drawing (zawiera odp. pochylony rzut z lewej) do pliku
P40C-ML-Left-Drawing.png;

otwérz w GIMP utworzony przed chwilg plik P40C-ML-Left-Photo.png. Zmieh nazwe jego warstwy do-
mysinej na Photo;

dodaj do niego, jako dodatkowg warstwe, plik P40C-ML-Left-Drawing.png. Zmieh nazwe tej warstwy na
Drawing;

zapisz ztozenie tych dwoch rysunkéw jako plik GIMP o nazwie P40C-ML-Left. xcf;

ustaw jako aktualng warstwe Drawing (czyli rzut z boku), i zmniejsz jej nieprzejrzystos¢ (Opacity) do
50-60%. (Powinna sie pod nig pojawi¢ fotografia samolotu. Jako pierwsza z wczytanych, znajduje sie
,na dole” stosu warstw, na utworzonej przez GIMP warstwie Photo);

Rysunek 5.2.8 pokazuje efekt tych operacji - przeniesione do GIMP ztozenie z Inkscape (por. Rysunek 5.2.5,
str. 135):

P40C-ML-Left.xcf-22.0 (RGB, 2 layers) 2390x1024
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Rysunek 5.2.8 Ztozenie zdjecia i rzutu z lewej — przeniesione z Inkscape do GIMP

Moze, tak na marginesie, wyjasnie dlaczego nie zaczatem od razu od Gimpa: w Inkscape jest wygodniej skalo-
wac i obraca¢ obrazy. Do GIMP proponuje wczytaé tylko obrazy wyeksportowane z Inkscape. W ten sposéb
zawartos¢ obydwu warstw ma identyczne wymiary. Dzieki temu rzut z lewej znajdzie sie w GIMP dokfadnie w

tym samym potozeniu ponad zdjeciem, co w Inkscape.
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Dodatki

Teraz wywotaj polecenie Filters>Distorts>Lens Distortion. Spowoduje to pojawienie sie okna dialogowego,
z parametrami znieksztatcenia beczkowatego (Rysunek 5.2.9):

X

Podglad transformacji — niestety,
Y shift: -100% ty ko aktualnej warstwy

** Lens Distortion

Parametry
transformaciji

|
Preview Q

Main:

5.400 |3

Ll

-0.600 |3

(I

Edge:

0.000 |3

Ll

Zoam:

0.000 |3

EBrighten: -
-60,000|%

* shift:

(I

UHHEHE

0.000 |3

(.

i shift:

T W

Rysunek 5.2.9 GIMP — okno dialogowe transformaciji Lens Distortion.

Okno zawiera suwaki, odpowiadajgce nastepujgcym parametrom transformaciji:

X shift, Y shift. potozenie na fotografii Srodka obiektywu. (Chodzi o punkt, na ktéry skierowany byt apa-
rat w chwili wykonywania zdjecia). Potozenie jest okreslane w zakresie od -100% do +100%. Wartos¢
0% odpowiada Srodkowi obrazu (patrz Rysunek 5.2.9);

Main: gtéwny wspdtczynnik znieksztatcenia. Dodatni oznacza "skurczenie" obrazu wokdt krawedzi.
Ujemny — to oczywiscie efekt odwrotny. Przy dopasowywaniu do zdje¢ bedziesz uzywaé wartosci do-
datnich;

Edge: dodatkowa deformacja w okolicy krawedzi. Podobnie jak Main moze by¢ dodatnia (dodatkowe
"skurczenie" obrazu) lub ujemna.

Zoom: powiekszenie (zwykta zmiana skali, bez zadnej "magii") wzgledem punktu okreslonego przez X
shift, Y shift. Ten parametr warto uzy¢, gdy nie docenites deformac;ji zdjecia i np. nie mozesz osiggna¢
odpowiedniej wysoko$ci kadtuba w obszarze wokdét srodka obiektywu

Ustalanie transformacji zacznij zawsze od ustalenia punktu, na ktéry byta wycelowana kamera (X shift, Y shift).
W przypadku klasycznego zdjecia samolotu stojgcego na lotnisku, wspodtrzedna Y srodka obiektywu wypada
zazwyczaj na poziomie horyzontu/wzrostu cztowieka. Potozenia wspdhzednej X mozesz sie domysle¢, szukajac
obszaru, w ktérym nie wida¢é zadnego odchylenia ptaszczyzn poprzecznych. (Na przyktad — koncowki topat
Smigta, albo golenie podwozia, zastaniajgce sie wzajemnie).
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Po ustaleniu celu kamery staraj sie dopasowaé plany do zdjecia za pomocg zmiany gtownej krzywizny: Main.
Staraj sie jg dobra¢ w ten sposéb, by przynajmniej dlugo$é obydwu sylwetek stata sie taka sama. Jednoczesnie,
jak najwiecej "kluczowych" punktéw konstrukcji w okolicy "celu" kamery (jak nasada skrzydta, statecznika po-
ziomego, ramki kabiny...) powinno sie zgadzac.

W oknie Lens Distortion jest dostepny podglad efektu transformacji (Rysunek 5.2.9). Niestety, wida¢ w nim tylko
aktualng warstwe, wiec nie wiemy, czy "trafiliSmy" w zdjecie, czy nie. Pozostaje tylko taktyka "kolejnych przybli-
zen":

- ustaw parametry transformacji (zazwyczaj zmieniasz tylko Main);

- nacisnij przycisk OK;

- obejrzyj rezultat;

- gdy nie jest odpowiedni:

- cofnij efekt transformacii ([Ctri{Z] lub Edit >Undo Lens Distortion);

- wywotaj ponownie okno dialogowe Lens Distortion (Filters 2Re-Show "Lens Distortion™). Na szczgscie

okno "pamieta" ostatnio uzyte wartosci parametrow;
- popraw parametry transformaciji i sprébuj jeszcze raz.

Parametru Edge uzywaj dopiero wowczas, gdy w zaden sposob nie mozesz odwzorowaé zdjecia za pomocg
samego parametru Main. Moze to wygladac tak:
- dtugos¢ zdeformowanej sylwetki doktadnie zgadza sie z dtugoscig na zdjeciu, podobnie jak czes¢ klu-
czowych wymiarow;
- mimo to ksztalt usterzenia pionowego nie jest zgodny ze zdjeciem.

Rysunek 5.2.10 pokazuje efekt transformaciji dla X shift = -40%, Y shift = -10%, Main = 5.8 (pozostate parametry
sg pozostawione w pozycji neutralnej):

D
/ rE
Cel kamery:
Xshift=-60%, Yshift =-10%

=

Potozenie
statecznika
poziomego —
zgodne!

Potozenie  kabiny
— poprawne

Krawedz natarcia
— zgodna!

Krawedz sptywu u
. nasady skrzydta —
zgodna!

Rysunek 5.2.10 GIMP — Rzut z lewej, dopasowany do zdjecia (transformacja Lens Distortion)

Oprocz linii zgodnych, dostrzezemy szybko na ztozeniu wiele niedoktadnosci. Widac¢ nieco zbyt wygiety grzbiet
kadtuba za kabing, zbyt gteboka chtodnice pod silnikiem... Czy mozna w jaki$ tatwy sposéb przenies¢ te po-
prawki na niezdeformowany rzut z lewej?
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Oczywiscie! Wystarczy, ze poddamy odwrotnej deformacji nie plany modelarskie, a samo zdjecie:
- wycofaj (Edit>Undo Lens Distortion) ostatnig transformacije;
- zmieh aktywng warstwe na Photo (to ta, zawierajgca fotografie);
- wywolaj ponownie okno dialogowe Lens Distortion (Filters>»Re-Show "Lens Distortion"”) i zmieh zna-

ki parametrow Main i Edge (Rysunek 5.2.11):

X

| ens Distortion

W oknie podgladu powiniene$

/_ teraz  widzie¢  zawarto$é
warstwy z fotografig

i | 5 [«
Preview @‘
- Zmien znak x
- ) | —— 5.
Main - na przeciwny s.400] |2

Edge:

Loom:

{ I |

Brighten: -

(.

# shift:

(]

i shift:

(oo )= J[ o ]

Rysunek 5.2.11 Parametry odwrotnej transformacji — z fotografii do rzutu prostopaditego

Rysunek 5.2.12 pokazuje efekt odwrotnej transformacji - zdjecie dopasowane do rzutu z lewej!
(Main = -5.4, pozostate parametry transformacji — bez zmian.)

Rysunek 5.2.12 Fotografia, "rozciagnieta” za pomocg Lens Distortion do rzutu prostopadtego

Teraz wystarczy przenies¢ zawartos¢ warstwy Photo do Inkscape. W ten sposéb bedziemy mogli poréwnaé

rysunek z prawdziwym samolotem!
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Aby to zrobi¢:

- (w GIMP:) wytgcz widocznos$é warstwy Drawing (to ta z rzutem z lewej). Na ekranie powinna pozostac
tylko zdeformowana fotografia;

- zapisz widoczng warstwe (File >Export As) do pliku o nazwie P40C-Left-Photo.tif;

- otwérz (w Inkscape) plik P40C-ML-Left.svg (stworzyliSmy go w poprzedniej sekcji — zobacz str. 133);

- wylgcz w pliku P40C-ML-Left.svg (Inkscape) widoczno$¢ wszystkich warstw, oprécz warstwy Image;

- dodaj nowg warstwe: Photo. Umies¢ jg pod warstwg Image;

- wczytaj na warstwe Photo (File>Import...) plik P40C-Left-Photo.tif. (To ten utworzony przed chwilg w
Gimpie);

- przesun i obro¢ wczytany obraz, tak, by pasowat do rzutu z lewej (Rysunek 5.2.13):

File Edit Yiew Layer Object Path Text Effects Whiteboard Help
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Rysunek 5.2.13 Inkscape — zlozenie rzutu z lewej z "wyprostowanym" zdje ciem

Teraz pozostaje tylko obrysowac réznice ksztattu na warstwie Correction, tak jak to robiliSmy w poprzedniej
sekcji (por. str. 132). Na przyktad — ze zdjecia wynika, ze gormy zawias steru kierunku jest nieco wyzej. Czy
pamietasz, ze wlasnie do tych zawiaséw przykfadaliSmy rysunki fabryczne (por. Rysunek 5.1.8, str. 130)? Zato-
zylismy wéwczas, ze sg we wlasciwym miejscu. Teraz bedzie trzeba przesung¢ troche caty obrys.

e Jezeli nie poréwnasz rysunkow fabrycznych z odpowiednim zdjeciem, mozesz je zastosowaé w sposob
niepoprawny, i nie uzyskac¢ prawdziwego ksztattu samolotu

Podczas poréwnywania planéw z fotografia pamietaj takze o tym, ze nie wszystkie efekty znieksztatcenia per-
spektywicznego zniknety z rysunku. Przyjrzyj sie koncowkom topat $migta (Rysunek 5.2.13): nadal sg wygiete
wzgledem obserwatora. Ten efekt powoduje, ze np. luk akumulatora na planach powinien znajdowaé¢ sie nieco
bardziej z przodu, niz na zdjeciu. Jedynie elementy lezgce doktadnie w osi symetrii kadtuba nie bedg miaty ta-
kiego przesuniecia. Mozesz je oszacowaé, mierzac np. odchylenie przedniej krawedzi pokrywy kétka ogonowe-
go. Potem proporcjonalnie zmniejszaj te odlegtosé, jesli element jest blizej centrum deformacji. (No co6z, jak
wida¢, nawet tu odwzorowujemy co$ "na oko". Zapewniam jednak, ze ogdlna niedoktadnos¢ tego poréwnania
jest o niebo lepsza niz to, z czego moglismy korzysta¢ przed "erg komputerdw".")

' Wiele bym dat, aby mie¢ do dyspozycijitakie narzedzia, gdy w 1988 opracow yw atem rysunki McDonell Douglass F4E! (Opublikow ne péz-
niej w matej monografii tego samolotu, w styczniu 1990).
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Rysunek 5.2.14 pokazuje rezultat — korekty naniesione na rzut z lewej. Rysowatem je w kolorze czerwonym.
Dodatkowo na rzut naniostem wzorce profilu ptata - w osi symetrii i u nasady skrzydta. (Zgodnie z dokumenta-
cja, byt to NACA 2215. Jezeli chcesz dowiedzie¢ sie, w jaki sposdb na podstawie symbolu profilu narysowac
jego obrys — patrz ,Ksztatt profili lotniczych (metody odwzorowania)” na str.154.) Ksztalt przekroju skrzydta
bardzo sie przydaje w weryfikacji dolnej krawedzi kadtuba kazdego dolnoptata. Wiekszo$¢ autoréw rysuje ten
fragment do$¢ nieuwaznie, podobnie jak rzut z boku skrzydta. (Na przykfad - na rysunkach Jacka Jackiewicza i
Mariusza tukasika ztozone kota podwozia gtéwnego sg w rzucie z boku za szerokie. Wyglada to tak, jak gdyby
dotykaty kadtuba.)

0 I , I
i B "~ N

Poprawiony kontur
usterzenia pionowego T

v = Nieco mniejsza|

= o wy soko$¢ ogona
Plytsza osiona / Profil skrzydta w

okolicy kadtuba

chtodnicy

Rysunek 5.2.14 Korekty rzutu z boku, naniesione po poréwnaniu ze zdjeciem

Ogdlnie rzecz biorgc, nasza sylwetka wyszta z poréwnania ze zdjeciem "obronng rekg". Powaznych réznic nie
ma. Z wiekszych:
1. Chitodnica cieczy okazata sie na fotografii ptytsza, niz na rysunku.
2. Tylna krawedz kadtuba lezy bardziej z przodu, niz na planach.
3. Os$ obrotu steru pozostata w tym samym miejscu, wiec obecnie jest poza kadtubem. (I tak byto w praw-
dziwym samolocie).
4. Kotpak $migta okazat sie dtuzszy, niz na planach (patrz Rysunek 5.1.10 — weryfikowatem to takze z in-
nymi zdjeciami).

Ta ostatnia poprawka wydtuzyta catg sylwetke o ok. 0,3%. Jednoczes$nie niemal niezauwazalnie przesuneta sie
do przodu tylna krawedz steru kierunku. W sumie sylwetka wydtuzyta sie o 0,25%, co oznacza réznice w skali
rzeczywistej o ok. 2,5 cm. Moze jestem chorobliwie doktfadny, ale jest to zbyt drobna réznica, by powtdrnie ko-
rygowac cieciwe pfata. (W skali rzeczywistej, w najszerszym miejscu, réznica wynositaby ok. 8 mm. To zupetnie
niezauwazalne. Mimo to, jak pokaze w nastepnej sekcji, dopasowatem ptat do tego rozmiaru.)

Na koniec powiekszytem wysokos¢ tego obrazu z 720 do 1024 jednostek, tak, by obejmowat caty obrys dolnej
topaty $migta. (Nie po to sie meczytem sie nad jej obrysem, by teraz go obcina¢.) Uzyskany rysunek zapisz, na
wszelki wypadek, jako dokument Inkscape (P40C-ML-Left.svg). Stworz takze jego kopie rastrowag
(File=>Export Bitmap). Nadaj jej nazwe P40C-ML-Left.png.

Dzieki poréwnaniu ze zdjeciami uzyskaliS§my poprawiony rzut z boku. Oszczedzamy sobie w ten sposob p6z-
niejszego odkrywania tych wszystkich roznic. (Modelowanie w 3D bezbtednie wytapuje wszelkie niekonsekwen-
cje rysunku) Kazda z nich objawia sie tym, ze nagle co$ do czegos nie pasuje. Takie btedy znajdowalibysmy w
trakcie budowy modelu, jeden po drugim. Zapewniam, ze wtedy ich poprawianie wymaga wiekszego wysitku.
Oznaczatoby koniecznos¢ ciggtego poprawiania ukonczonych juz elementéw, a to hamowatoby caty postep
prac.
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Podsumowanie

e Za pomocg narzedzia GIMP — Lens Distortion — mozesz "rozwing¢" zdjecie, dopasowujac je do rzutu z
boku (str. 135 - 140). Otwiera to nowe mozliwosci weryfikacji planéw modelarskich.

e Zdjecie, ktérego uzyjesz do poréwnania z rzutem z boku, powinno mie¢ jak najwiekszg rozdzielczos¢. S a-
molot powinien by¢ na nim jak najmniej znieksztatcony (str. 135 - 136).

e  Staraj sie zawsze sprawdzi¢, czy zdjecie nie jest zdeformowane (zanadto wyciggniete w pionie lub pozio-
mie). W tym celu wybierz na fotografii ksztatt, o ktérym wiesz, Ze powinien by¢ doktadnym kotem. Poréwnaj
go z okregiem, narysowanym w Inkscape (str. 134).

e Uzyskane w GIMP "rozwiniete" zdjecie mozna wczyta¢ do Inkscape, aby wygodnie nanies¢ na plany po-
prawki (str. 141 - 142).
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5.3 Rzut z gory: poréwnanie ze zdjeciami i rysunkami fabrycznymi

Sprawdzilismy juz tak doktadnie, jak sie tylko dato, rzut z boku P-40. Pozostat nam jeszcze do sprawdzenia rzut
z gory. Z nieocenionego http://www.p40warhawk.com uzyskatem rysunki fabryczne dwéch elementow:

- kompletnego ptata (znajdziesz go pod nazwg Source\Curtiss\Wing-overall.gif w pliku source.zip);

- steru wysokosci (znajdziesz go pod nazwg Source\Curtiss\Tail-elevator.gif w pliku source.zip);

Jezeli chodzi o zdjecia, to niestety, metoda jakg zastosowali$my do "wyprostowania" rzutu z lewej (patrz str.
134), tu nie zdaje egzaminu. Problem polega na tym, ze rzut z gory nie ma jednej ptaszczyzny, nad ktérg mozna
by sie byto skoncentrowaé. Jest tu kilka waznych powierzchni: ptata, usterzenia poziomego, kadtuba. Niest ety,
kazda z nich jest w innej odlegtosci od obserwatora. W dodatku ptaty majg wznios, co jeszcze bardziej kompli-
kuje sprawe. Zresztg zdje¢ z géry samolotu jest o wiele mniej niz zdje¢ z boku. Wynika to z prostego faktu, ze te
z gory trzeba bylo zazwyczaj wykona¢ w powietrzu. Na taki "strzat" fotograf ma o wiele mniej okazji — aby go
zrobi¢, musi sie znalez¢ w innym samolocie.

Szukajgc w ogdle jakichkolwiek zdje¢ z gory, natknatem sie na nastepujgce (Rysunek 5.3.1):

Lewy ptat jest
ustawiony  niemal
prostopadle do|

kamery!

Ta linia ostrzegawcza
powinna by ¢ pionowa

R
5 '::l .

Krawedz steru wysokos$c
powinna by ¢ pozioma

S SRR L e e s G

Rysunek 5.3.1 P4ON — zdjecie z gory (USAAF)

To nic, ze fotografia przedstawia p6zng wersje P-40. Wszystkie — od pierwszych do ostatniej serii — miaty takie
same ksztatty skrzydet i usterzenia poziomego.
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Rysunek 5.3.1 zawiera unikalne ujecie. Ten P-40N jest przechylony na lewo — o 7-8°. Dzieki temu lewy ptat jest
ustawiony niemal prostopadle do obserwatora. Jednoczesnie znieksztatcenie perspektywiczne jest niewielkie.
Koto, w ktére wpisana jest gwiazda na lewym ptacie nie ma zadnych widocznych znieksztatcen. Takze mas zt
anteny na ogonie samolotu jest tylko odrobing odchylony od pionu. Kamera byta skierowana na okolice kabiny
pilota. Catej fotografii "rozwing¢" z perspektywy, tak jak to zrobilismy z rzutem z lewej, nie jesteSmy w stanie. Ale
pojedyncze obszary - to co innego! Uzyjemy tego zdjecia do weryfikacji dwoch elementéw. Rysunek 5.3.1 poka-
zuje je, obrysowane liniami przerywanymi. To:

- obrys ptata®;

- obrys usterzenia poziomego.

Ewentualne roznice naniesiemy jako poprawki na plany samolotu (tak samo, jak to zrobilismy z rzutem z lewej).

Zacznijmy od poréwnania ptata z fotografii i ptata z planéw. Otwérz w Inkscape plik P40C-ML-Top.tif. Utworz
nowg warstwe (pod spodem) i wczytaj na nig to zdjecie (Source\Photo\P40N- Top-Photo.png z pliku source.zip).
Dopasuj jak najdoktadniej do planéw lewe skrzydto samolotu z fotografii. W pierwszym kroku uzgodnij jego roz-
miary (szerokos¢ i wysoko$¢€). Nastepnie ustaw fotografie tak, by linia ostrzegawcza byta pionowa. Jednocze-
$nie ostony zasobnika z amunicjg powinny by¢ poziome (Rysunek 5.3.2). Osiggniecie tego efektu wymaga
drobnego obrotu i minimalnego przekoszenia fotografii. (Przekoszenie niweluje drobny efekt wzniosu ptata,
widzianego z gory, z tytu):

T
Spora réznica w ksztatcie
Linia  ostrzegawcza

na ptacie — jest Obrys krawedzi
pionowa (zgodna) splywu (wg planéw)

. e s Obrys krawedzi [ L
o - splywu (wg zdjecia) ! © -
" g .- .- . h.

3 .i '._': .

.| |Linia ostrzegawcza i zarys
-k |komér amunicyjnych —
poziome (zgodne)

|

-'“;Tlﬁ Doktadne koto —/ i
bk T R - .
=" s
: . GeRES S
P R B M i .y A -
- T = 3 Owiewka podwozia jest nieco |
L = - mniejsza od planéw! 1

Rysunek 5.3.2 Ksztalt ptata — poréw nanie fotografii z planami M. Lukasika (i J. Jackiewicza)

Efekt jest zaskakujgcy: krawedz sptywu i kocéwka ptata sg na planach zle narysowane! Pociggneto to za sobg
takze btedne potozenie osi lotki — jest za bardzo przesunieta do przodu.

e Na planach modelarskich samolotu, powierzchnie poziome — pfat, usterzenie — zawierajg czesciej btedy,
niz lepiej udokumentowane fotografiami powierzchnie pionowe

' Rysunek fabryczny to "potozony" plat. W zw igzku ze w zniosem piata o 6°, zmniejszytem proporcjonalnie rozpigto$é w rzucie z géry do
cos(6°) =99.5% oryginalnego rozmiaru.

© Witold Jaworski, 2009 - 2015.




146 Dodatki

Upewnijmy sie, czy mozemy zastosowaé posiadany fragment dokumentacji fabrycznej. Wczytaj na kolejng war-
stwe plik z ogdlnym zarysem ptata (Source\Curtiss\Wing-overall.gif z pliku source.zip). Rysunek 5.3.3 pokazuje

ztozenie tego rysunku ze zdjeciem:
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Rysunek 5.3.3 Poréow nanie fotografii z fabrycznymi rysunkami ptata

Jak mozna byto przypuszczaé, tym razem réznic nie ma. By¢ moze autorzy planéw (Jacek Jackiewicz, a potem

Mariusz tukasik) nie mieli okazji skorzysta¢ w odpowiednim czasie z tego rysunku.

Rysunek 5.3.4 przedstawia rzut z gory z naniesionymi poprawkami. O dziwo, poza tylnym dzwigarem, wszys tkie

taczenia blach i linie nitéw na planach pasujg do rysunkéw fabrycznych!

Owiewka podwozia
byta nieco mniejsza

Obrys koncowki ptata
to zZozenie trzech
tukow

e e =

taczenia blach i linie nitéw sg na planach poprawne!
(Od krawedzi natarcia do ty Inego dzwigara).

Rysunek 5.3.4 Rzut z gory — poprawiony obrys ptata
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W podobny sposdb zweryfikujmy obrys usterzenia poziomego. W tym obszarze rysunki Jacka Jackiewicza i
Mariusza tukasika roznig sie od siebie.

Na rysunku Jacka Jackiewicza ster wysokosci ma bardziej zaokraglong krawedz sptywu. Jego kompensacja
aerodynamiczna znajduje sie takze w innym miejscu, niz na zdjeciu — i nie jest to mata réznica (Rysunek
5.3.5). Ster na tym rysunku zawiera tyle roznic, ze nie ma co sie nim postugiwac’.

Zbyt duze zaokraglenie

| Nieprawidtowy obrys kom-
| pensacji aerody namiczne;j

r ="
11
=

Krawedz natarcia powinna a j - - " Krawedz natarcia powinna
by ¢ bardziej z przodu : SR by ¢ bardziej z przodu

Rysunek 5.3.5 Obrys usterzenia P-40 wg planéw Jacka Jac- Rysunek5.3.6 Obrys usterzenia P-40 wgplanéw Mariusza Luka-
kiewicza sika

Mariusz tukasik zauwazyt te réznice, i starat sie jg poprawi¢. Jego obrys usterzenia jest bardziej zblizony do
fotografii (Rysunek 5.3.6). Krawedz steru znajduje sie w poprawnym miejscu, a wywazenie masowe ma rozmiar
zblizony do rzeczywistego. Wyglada jedynie, ze w tym przypadku autor nie zauwazyt niewtasciwych proporcji
statecznika — jego krawedz natarcia jest nadal przesunieta do tylu. To w efekcie spowodowato zmniejszenie
promienia obrysu koncéwek usterzenia. (Ster musiat pasowa¢ do statecznika). Wyglada na to, ze Mariusz tuka-
sik starat sig zachowa¢ ksztalt krawedzi natarcia jak na rysunkach Jacka Jackiewicza. Czyli — jest lepiej, ale tez
nie za dobrze.

Co z tym fantem robi¢? Sprobowatem ztozyé catg posiadang dokumentacje fabryczng, ktéra dotyczy tego frag-
mentu (Rysunek 5.3.7).

Na zdjecie usterzenia natozytem rysunki fabryczne:
- steru wysokosci (Source\Curtiss\Tail-elevator.gif z pliku source.zip);
- oprofilowania usterzenia (Source\Curtiss\Tail-fairing.gif z pliku source.zip);

Na pierwszym z nich jest oznaczony Srodek okregu konturu kohcowki usterzenia. Przedtuzytem go znad steru
na statecznik, gdyz taki ksztalt jest zgodny ze zdjeciem.

Nastepnie narysowatem prostg linie krawedzi natarcia. Linia ta jest styczng do okregu koncowki, a z drugiej
strony — przechodzi przez punkt wskazany na rysunku oprofilowania usterzenia. Tak "wydedukowany" obrys
jest zgodny ze zdjeciem, a wiec — poprawny.

' Musze przyzna¢, ze zaciekaw iony tymbtedem na skadinad doktadnych planach, sprébow atem dociec ich przyczyny. W tymsamymcza-
sie, corysunki P-40, Jacek Jackiew icz opublikow attakze rysunki do innej monografii AJ Press: P-36. Samolot ten, znany takze pod nazw g
Curtiss "Haw k" 75, byt przodkiem P-40. P-40 "odziedziczyt" po nim praw ie wszystko, poza przodemkadtuba. | w fasnie tu moze tkw i¢ putap-
ka: usterzenia poziome P-36 i P-40 rdznig sie od siebie! Na rysunkach Jacka Jackiew icza sg identyczne. W rzeczyw istosci, w ygladaty
podobnie, ale w P-36 ster w ysoko$ci miat w zdtuz calej kraw edzi dodatkow e wywazenie aerodynamiczne. Oznacza to, ze blachy statecznika
konczyly sie niemal doktadnie na kraw edzitylnego dzwigara. W P-40 to zakonczenie byto o kilka centymetréw przesuniete do tytu. Rysunek
Jacka Jackiew icza wydaije sie by¢ "ztozeniem" tych dw éch podobnych, ale nie identycznych, usterzen. Stad btedna kraw edz podziatu sta-
tecznikai steru. Trudno jednak dociec, skad sie w zigt niepopraw ny obrys catego usterzenia. By¢ moze byt taki na rysunkach, na podstaw ie
ktérych Jacek Jackiew icz opracow yw at sw oje plany.
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Rysunek 5.3.7 Obrys usterzenia P-40 — zlozenie dostepnej dokumentacji fabrycznej
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Rysunek 5.3.8 przedstawia korekty naniesione na plan usterzenia poziomego (statecznika i steru).
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Rysunek 5.3.8 Korekty ksztaltu usterzenia poziomego

Laczenia blach poszycia statecznika poziomego biegng wzdtuz wzmocnionych podtuznic. Podobne podtuznice
biegng przez statecznik pionowy. Obydwa stateczniki byty, w miejscu styku tych podtuznic, skrecone srubami.
(Usterzenie pionowe "stato" na niedzielonym stateczniku poziomym, ktéry z kolei byt przykrecony do kadtuba).
Na rysunkach fabrycznych statecznika pionowego zaznaczone sg punkty potgczen z usterzeniem poziomym.
Pozwolito mi to wyznaczy¢ potozenie podtuznic u nasady statecznika poziomego. (Rysunek 5.3.8 zaznacza je
liniami przerywanymi.) Jak wida¢, roznig sie tylko nieznacznie od potozenia wg planéw. Potozenie tych podiuz-
nic i szwow blachy przy koncéwce statecznika wypada inaczej, gdyz skorygowana koncéwka jest duzo szersza.

Statecznik  pionowy
ma mniejszy promien
krawedzi natarcia
(inny profil)

il

Potozenie zeber steru wysokosci na rysunkach M. Lukasika jest zgodne z dokumentacjg fabryczna.

Wirtualne modelarstwo — wydanie trzecie

www.samoloty3d.pl

podtuznice
statecznika poziomego
taczg sie z podtuznicami




Rozdziat 5 Szczegdtowa weryfikacja planéw samolotu 149

Rysunek 5.3.9 przedstawia ostateczng postac¢ rzutu z gory, zawierajacg poprawiony obrys usterzenia poziome-

go i skrzydta:

Poprawiony ksztatt / T i W
usterzenia poziomego -

Poprawiony
ksztalt skrzy dial

Rysunek 5.3.9 Rzut z gory z naniesionymi popraw kami

Wyeksportuj ten rysunek Inkscape do pliku obrazu o nazwie P40C-ML-Top.png (File 2Export Bitmap). Aby za-
0szczedzi¢ czas, nie kopiuje tych poprawek na drugg, symetryczng strone samolotu, ani nie przenosze ich na
inne rzuty. Wystarczy, aby pamietac, ze ptat lub usterzenie nalezy wykonywac z rzutu z gory, wg czerwonych, a

nie czarnych (oryginalnych), linii.

Jak widzisz — kazdy popetnia btedy, nawet tworcy planéw modelarskich. Opierajac sie jednak na jak najlep-
szych planach, mozemy zidentyfikowac i poprawi¢ wigkszo$¢ pomyiek, ktore sie na nich znalazty. Jest to mozli-
we za pomocg odpowiedniego oprogramowania, ktére pozwala na poréwnanie wielu obrazéw naraz. W po-
przednich dekadach taka mozliwos$¢ jeszcze nie istniata’.

' Widziatem w w ielu recenzjach modeli plastikow ych nastepujaca weryfikacje: autor przykladatkadiub czy skrzydto do planéw . Gdy co$ sie
nie zgadzato — ogtaszat, ze model jest niepopraw ny wymiarow o, i sugerow at, jak to skorygow a¢. Z perspektyw y naszych dosw iadczen
planami P-40 (ktore sg napraw de niezte) takie postepow anie wyglada na dos¢ naiw ne. Autorzy recenzji modelarskich z aktadali, ze plany sg

nieomylne!
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Podsumowanie

e Zdjecia samolotu z gory nie poddajg sie tak tatwo rozwinieciu, jak rzut z boku. Zrezygnowatem z tej opera-
cji, bo mozliwos¢ btedu w rezultacie takiej pracy bytaby zbyt duza (str. 144).

e Liczba dostepnych, w przyblizeniu prostopadtych, zdje¢ samolotu z gory (lub z dotu) jest o wiele mniejsza
od zdje¢ "horyzontalnych". Dzieje sie tak dlatego, ze takie fotografie muszg by¢ robione wytacznie z powie-
trza (str. 144).

e Plany modelarskie mogg zawieraé wiecej btedéw ksztattu pfata i usterzenia poziomego, niz kadtuba i uste-
rzenia pionowego. Wynika to z mniejszej liczby dostepnych fotografii (str. 146, 148).

o Rysunki fabryczne skrzydta, statecznikéw i steréw sg w tej sytuacji wkasciwie jedyna metodg weryfikaciji.
(Chyba, ze uda Ci sie trafi¢ na jakies zdjecie, wykonane z duzej odlegtosci pod kgtem niemal 90°).
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Rozdziat 6. Dodatkowe wyjas$nienia

W tym rozdziale umiescitem informacje "dla dociekliwych". Znajdujg sie tu szczegoétowe wyjasnienia wybranych
zagadnien, nad ktorymi nie chciatem sie rozwodzi¢ w czesci gidwnej. (Aby nie zbaczac z tematu).
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6.1 "Znieksztatcenie beczkowate" fotografii

Fotografia utrwala rzeczywisty obiekt w $cisle okreslonym ujeciu perspektywicznym. Podstawowym parametrem
tego ujecia jest dtugos¢ ogniskowej obiektywu (patrz Rysunek 6.1.1). Powiedzmy, ze wynosi 50mm. Wymiary
kliszy sg zazwyczaj standardowe (wysoko$¢ 35mm, szerokos¢ 48mm). Obraz na odbitce 10x15cm wygladatby
"zupetnie jak prawdziwy", gdybys$ ogladat go z odlegtosci 30 cm, zamkngwszy przy tym jedno oko. Oczywiscie,
nigdy tak zdje¢ nie oglgdamy. Napotykajac je na co dzien, przyzwyczailismy sie nawet do takich drastycznych
deformaciji beczkowatych jak "rybie oko". (Mimo, ze nie mamy szans zobaczy¢ Swiata w ten sposéb — wyklucza
to budowa ludzkiego oka).

Wykonanie zdjecia Co widaé na zdjeciu:
Cc
B /
C B A ’\:_—/
\ Hiperbola | =]
Ptaszczyzna syme-
trii kadtuba
c b a b a
A i
Ptaszczyzna kliszy Wooh ol ] ) :
* u 1 | \
fotograficznej WL ogniskowa jd:iL-Hin-itt
WO ) —11 tj +Jq~
L obiekty wu T iR
pH g maEn| REES
: T Eua
T T
T
S

Rysunek 6.1.1 Znieksztalcenie beczkow ate na fotografii

Rysunek 6.1.1 pokazuje:

- po lewej: geometrie projekcji podczas wykonywania zdjecia. Linia z punktami A, B, C to np. o$ symetrii
prawdziwego samolotu. Linia z punktami a, b, ¢ to obraz tej osi na zdjeciu. Zwré¢ uwage, ze odcinek
|Cc| jest o wiele dtuzszy od |Aaj|;

- po prawej: sytuacje, gdybysmy odbitke tej fotografii obserwowali z nieskoriczonej odlegtosci (czyli nie
bytaby to w ogdle perspektywa, a techniczny rzut z lewej). Dlatego tu wszystkie odcinki |Aa|, |Bb|, |Cc|
sg rownolegte. R6zne odlegtosci pomiedzy obiektem a jego obrazem, wystepujgce w perspektywie,
zrobity jednak juz swoje. Jezeli wysokosci oryginatu (np. kadtuba) w punktach A i C sg identycznie, to
w punkcie ¢ (na zdjeciu) jest ona mniejsza niz w pkt. a.

Linie, demonstrujgcg stopien znieksztatcenia beczkowatego, mozna uzyskaé ustawiajgc linie |Cc|, |Bb|, |Aa|
pod katem 90° do ptaszczyzny zdjecia (Rysunek 6.1.1). Dlugo$¢ tych odcinkéw jest taka sama jak podczas
tworzenia zdjecia. Ich konce wyznaczajg teraz krzywa deformacji. Krzywa deformaciji ma w tym przypadku
ksztatt hiperboli.
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W rzeczywisto$ci soczewki obiektywu nie majg idealnych ogniskowych. Na wiekszosci zdje¢ krzywa deformaciji
nie jest idealng hiperbolg — moze by¢ dodatkowo wygieta na krancach. Rysunek 6.1.2 pokazuje, jak powstaje
taki efekt:

Wykonanie zdjecia Co wida¢ na zdjeciu:
C
7\8 /
C B A \,_:\/
Wy giegcie —/
Krétsza  odlegto$¢
do fotografii
c b a o b a
/O y i [ L]
Ptaszczy zna LR ;o - 5
fotografii Y i ;oS - :
WAL niedokfadnos¢
l'. E i ! .’) ogniskowe;j
A A
'S
11 L

Rysunek 6.1.2 Przyktad ztozonego znieksztatce nia beczkowatego
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6.2 Ksztatt profili lotniczych (metody odwzorowania)

Wsrod konstruktorow lotniczych funkcjonuje powiedzenie "the wing is the king". Ma to znaczy¢, ze geometria
ptata ma decydujgcy wptyw na wszelkie charakterystyki samolotu. Na przyktad — P-40E "Warhawk" i P-51A
"Mustang" miaty niemal identyczng powierzchnie ptata. Uzywaty takich samych silnikéw Allison, miaty bardzo
podobng powierzchnie czotowg — chtodnic, kadtuba, skrzydet. Roznity sie jednak drastycznie oporem, jaki sta-
wialy podczas lotu. Wspotczynnik oporu P-40E wynosit 0.0242'. Ten sam wspdiczynnik dla P-51A wynosit
0.0176. Co powodowato te réznice? Przede wszystkim profil ptata! W wyniku zastosowania skrzydta o profilu
laminarnym pierwsze "Mustangi" byt 0 45 km/h szybsze od "Warhawkow" 2.

Profil ptata jest odwzorowywany w lotnictwie bardzo doktadnie — nawet nieznaczne réznice ksztattu mogg w
znaczny sposob zmieni¢ np. charakterystyki przeciggniecia. Rysunek 6.2.1 wyjasnia podstawowe pojecia, uzy-
wane w opisie geometrii profili lotniczych:

A Maksy malne
y ugiecie linii

szkieletowej \
Linia szkieletowa

by ~ —K S e e e E s
— W W A A LA 100
Promien  zaokra- 1 \_

glenia noska profilu \—

. — .

o

Maksy malna
grubosé

Rysunek 6.2.1 Geometria profilu lotniczego

Tradycyjnie profile lotnicze rysuje sie w ptaszczyznie XY. Z lewej strony, w punkcie (X=0, Y=0), znajduje sie
zawsze tzw. nos profilu, okre$lajacy ksztatt krawedzi natarcia ptata. Nos jest zazwyczaj zaokraglony. Czas ami
jest podawany promien tego zaokraglenia. Profil jest zawsze zakonczony w punkcie (X=100, Y=0). Linia profilu
jest czesto dzielona na dwie czesci: obrys gérny i obrys dolny. Obrysy tgczg sie na krancach profilu (w X = 0 i
X=100).
Prosty odcinek, tgczacy nos z krawedzig sptywu nazywamy cieciwg. Druga linig charakterystyczng jest
szkieletowa. Punkty tej linii lezg w rownej odlegtosci od gornej i dolnej krawedzi profilu. Mozna jg sobie wyob-
razic¢ jako linie przechodzaca przez srodki okregoéw, wpisanych w obrys profilu (Rysunek 6.2.1).
Dla profilu podawana jest czesto takze:

- maksymalng grubos¢ (informacyjnie — chodzi tu o wysoko$¢, mierzong wzdtuz osi Y);

- punkt maksymalnego ugiecia linii szkieletowej (Rysunek 6.2.1).

Gdzie$ tak do lat dwudziestych XX wieku profile ptatéw opracowywali sami konstruktorzy. Robili to metodg prob
i bledéw. Na przyktad popularny profil Clark Y powstat wiasnie w tym czasie (opracowat go w 1922 r. Virginius A.
Clark). Uzyto go w dziesigtkach samolotéw z lat dwudziestych. Aby inzynierowie na catym swiecie byli w stanie
poprawnie odtworzy¢ ksztatt profili, zaczeto publikowa¢ wspétrzedne ich obryséw (Tabela 6.2.1, Rysunek 6.2.2):

' Wspdtczynnik "czystego oporu” mierzony w sytuacii, gdy ptat nie w ytwarza sity nosnej (samolot jest w éwczas pochylony o 2—3° do dotu).
2 7 predko$cig w znoszenia juz nie bylo tak dobrze: obydw a samoloty nie byly pod tym w zgledem najlepsze. Przy praktycznie takiej samej
masie catkow itej (poréow nyw any "Warhaw k" byt nieznacznie — o 120 kg — Izejszy) "Mustang" osiagat 610 nVmin, a "Warhaw k" — 670
m/min. (Profil laminarny "Mustanga" miat o w iele nizszy op¢r, ale takze w ytwarzatrelatyw nie nizszg site nosna.) Dla poréw nania — Messer-
schmitt Bf 109E miat predkos$¢ w znoszenia 1020 mymin, a Bf 109F — 1260 m/min (ta ostatnia byta jedng z najlepszychw ciggu catejw ojny).
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X 0] 1.25| 25 5 75 10 20 30 40 50 60 70 80 90| 100
Yg| 3.49] 553 6.50] 7.87| 8.86| 9.63| 11.35 11.73| 11.40( 10.52] 9.18| 7.72| 5.54| 3.32[ 0.25

Yd| 3.49] 194 1.46[ 0.94| 0.61] 0.40[ 0.04| 0.00] 0.00[ 0.00f 0.00] 0.00] 0.00( 0.00{ 0.00

Tabela 6.2.1 Wspoirzedne profilu Clark Y

A A, e o e e

ol |5 10 Y20 30 740 150 60 70 80

<

e d

90 100

Rysunek 6.2.2 Profil Clark Y, wykreslony na podstawie wspoétrzednych z Tabela 6.2.1

Gdzie$ w latach dwudziestych coraz szerzej zaczeto uzywaé profili, opracowanych przez placéwki naukowe. Na
przyktad publikowat je niemiecki uniwersytet w Getyndze. (Byly oznaczane np. "Goétingen - 623", albo "Gétingen
- 543".) W 1933 r. finansowana przez rzad USA NACA opublikowata istotny raport, zawierajgcy geometrie i cha-
rakterystyki 78 profili lotniczych. Byty to tak zwane "profile rodziny 4-cyfrowej". Od tamtej pory profile te byly
szeroko wykorzystywane w wielu konstrukcjach lotniczych, nie tylko amerykanskich'. Do rodziny tej nalezg tak-
ze profile ptata P-36 i P-40: NACA 2215 i NACA 2209.

Czy wiesz, ze numer profilu NACA nie jest wcale numerem kolejnym? Tak naprawde zawiera opis jego kluczo-
wych parametrow geometrycznych:
- 1 cyfra: najwigksze ugiecie szkieletowej (czyli warto$¢ Y max. ugigcia w %).
- 2 cyfra: odlegtos¢ punktu o najwiekszym ugieciu szkieletowej od nosa profilu, podzielona przez 10. Na
przyktad — "2" oznacza, ze max. ugiecie szkieletowej znajduje sie 20% od krawedzi natarcia.
- 34 cyfra: grubos¢ profilu (%).

Tak wiec symbol profilu P-40 — "NACA 2215" — oznacza profil o grubosci 15% i maksymalnym ugieciu szkiele-
towej 2%, w X = 20% cieciwy. W istocie ksztatty NACA 2215 i NACA 2209 rdznig sie tylko gruboscig. Gdy prze-
skalujesz rysunek NACA 2209, rozciggajac go w pionie, uzyskasz NACA 2215. (Na odwrét to takze dziatal)

Co wiecej — NACA opublikowato wzory matematyczne, ktére pozwalajg odwzorowa¢ ksztait profilu z dowolng
doktadnoscig. (Trzydziesci punktow, jakie Tabela 6.2.1 dla profilu Clark Y, pozostawia jeszcze pole do pewnej
dowolnosci).

e NACA opublikowata parametry takze tzw. "rodziny 5-cyfrowej", ale nie bedziemy sie nig tu zajmowaé. Poza
tym istniejg takze profile NACA, noszace inne oznaczenia. Na przyktad — laminarny profil ptata "Mustanga"
to NACA 45-100. A profil skrzydta Messerschmitta Bf 109 jest podany jako NACA 2R114.2 (to oznacza po-
dwojne zatamanie szkieletowe;).

' Skad tak w ielka popularno$¢? Sekret kryje sie w sposobie pomiaru. NACA dysponow alo wow czas jedynymw $w iecie pefnow ymiarow ym
tunelem aerodynamicznym, w ktérymmiescit sie caty mysliw iec. Charakterystyki opublikow anych profili byly zmierzone na duzych ptatach,
w warunkach zblizonych do rzeczywistego lotu. Wczes$niej wszyscy "dmuchali” (tak to sie méw iw lotnictw ie) ptaty o rozmiarze niew ie lkiego
modelu w matych tunelikach aerodynamicznych. Potem starano sie te "modelarskie" charakterystyki przeliczy¢ na praw dziw e w ar unki lotu.
Zdradze tuw szystkimtym, ktérzy nie zetkneli sie z praktyka inzynierskg, maly sekret: obliczenia aerodynamiczne, szczegolnie bez uzycia
komputeréw , sg strasznie niedoktadne! Profile NACA byly wiec w oczach konstrukiorow o w iele bardziej "pew ne", niz w szystkie inne.
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Gdy zaczniesz szuka¢ w Internecie hasta "NACA, airfoil", znajdziesz szybko kilka stron podajgcych wspétrzedne

wielu réznych profili lotniczych. Uwazam, ze godny polecenia jest w szczegdlnosci serwis dostepny pod adre-
sem http://www.ppart.de/programming/java/profiles/NA CA4.html:

NACA 4 Digits Series

Jens Trapp and Robert Zores

I

Airfoil:

Maximum Cambhber (0-8): 0

4

MACADDTZ

Dakota Ultrasonics
Ulrazonic Thickness gauges, Flaw Detectors, and Boling

eguipment

Max. Camber Pos. (0-8). 0

Thickness (0-99). 12

4

# Points (10-1000): 100

4

Puoint Distribution: 1

1

Point Size: 0

4

Zoorm: 400

4

®-Offset 0

1

Y-Offset 0

4

Reset Credits |

Show Points

vy, d akotaultrasonics. com

Airfoil Software For PC
Free Trial “ersion For Windows. DesignFOIL is your
analysis expert.

v, DesignFOIL.com

Thickness Measurement
Precizion optical gauging systems Unigue multi-layver film

and tuking

v, Lumetrics. com/

Make Vour dwn Wind Power
Full Instructions - Make Your Cwen Electricity & Sawve Your

doney |

v, efficientplanet.com

Rysunek 6.2.3 Serwis internetowy — generator wspoétrzednych 4-cyfrowych profili NACA

Gdy ustawisz na tej stronie odpowiednio parametry:
- Maximum Camber: ugiecie szkieletowej (1-

sza cyfra);

- Max. Camber Pos. pozycja ugiecia szkiele-

towej (2-ga cyfra);

- Thickness. grubos¢ profilu (dwie ostatnie cy-

fry).

i nacisniesz przycisk Show Points, w polu po prawej
stronie ekranu zobaczysz wspotrzedne. Wygenero-
wano je dla profilu o dtugosci cigciwy = 1.0. (Po 100

pkt na obrys).

Ads by Goog
Skopiuj do schowka catg
zawarto$¢ tego pola
Aol NACAZZ15 MACAZZ15 -~
) ) — 0.999834067617257 0.00
Maximum Camber (0-9): 2 4 * o 9991 005445882000 0.0
Max. Camber Pos. {0-9): 2 4 » [0.997878771184988 0.00
) ) 0.9961 698037602941 0.0
Thickness (0-9):15 4| | * [0.9930755165460636 0.0
# Points (10-1000): 100 4 y [0.991297 7018196363 0.0
o 0.5281 3809657225400 0.0
Foint Distribution: 1 4 P 0 9545022802261583 0.0
Point Siza: 04 J y 1098039106921 7146 0.00
0.975809207 4876676 0.0
Zoom: 4004 J Y 0.9707610179444421 0.0
VOffset 014 y [[0.965251 2690862581 0.0
' 0.9582851718311665 0.0
T-Offset 0 4 b 0.9528683761913087 0.0
Reset | Credits | Show Points (mmmmﬁmmwn 7

Rysunek 6.2.4 Wygenerowane wspotrzedne profilu NACA 2215

Zaznacz catg zawarto$¢ pola tekstowego ze wspotrzednymi ([Ctril{A]) i skopiuj j do schowka ([CtriH{C]).

Co dalej zrobi¢ z tymi wspoétrzednymi? Bedziemy pracowicie rysowac¢ w Inkscape ten profil, "punkcik po punkci-

ku"? Na szczescie nie — istnieje szybsza droga.
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Otworz arkusz kalkulacyjny, ktéry przygotowatem specjalnie tym celu (Source\Tools\airfoil.xIs z pliku source.zip,

por. str. 17 — Rysunek 6.2.5):

Microsoft Excel - Profil. xIs

Elik Edycja Widok Wstaw Format MNarzedzia Dane ©Okno Pomoc
Tu wkie] zawartosclg el & |0 (223 % =2 2w - B U = B & % @
pola ze wspéirzedny mi Foqq =] =|="L" & PODSTAWTEKST(C201,"#1.000";","" " & " &PODSTAWTEKST-D201,"#0.000";","".")
profilu, skopiowang z A [ B [ C [ D | E I 3 =
Internetu W cie ciwy: 100 Stad skopiuj obliczone

| 2 | / wy razenie SVG

| 3 |NACA2215 Separatol X A SVG

| 4 |0.999834067617257 0.0016285812016576529 15 99.953407  0.152555(M 58,583, 0.163

|5 |0.9931005446852009 0.0017950638430193067 15 99.910054 | 0.179506(L99.910,-0.180 |

|6 |0.99787577118459685 0.0020720146130770445 1899787677 | 02072010 99788 0. ¥ i

|7 |0.9961698937602941 D.00245565667 2358315 19 99 616385 02458660 99617 0. 5

| 8 |0.5939755168460636 0.002556390563530206654 1999357552 0.2953591|L 99,358 0. B Wkle'

| 9 |0.8912577018196363 0.003556352355415317 190 9912977 0.355639|L 99,130 -0 —] o

| 10 |0.9581383657825409 0.004264435921826124 19 95613097 | 0 426444)1 OB 8140, Wheispeciahie, .

|11 |0.9845022802281593 0.005076104302409857 19/95.450228 050761\ 984500,

12 |0.9803310659217 146 0.0055831697 01533561 18/ 98.039107 0.528917]L 980390,

|13 |0.97 5809207 4576676 0.007001 166231930256 19 97.580921 0.700117|L97.8810. = " ..

| 14 |0.9707610179444421 0.0051093804910779 1957 076102 0.810938|L 97 0760,  yeeyse zawartesc

| 15 |0.565251 25908625581 0.00931067 4156653851 19/ 96.525127 | 0.931057|L 98.525 0.5 yyerau komentarz

| 16 |0.553255171831 1665 0.0106024596564 355275 19 95928517 1.08025|L 959291, — — —

|17 |0.9528683761913097 0.01198089560962534 1995286838 1.193039|L 95.287 -1. B2 Formatuj kamérk...

|18 |0.946006567 3642276 0.01344255637 3775005 19 94 BO0BS7 | 1.344256|L 94601 -1, wvhierz 2 listy...

|19 |0.938707 4514566589 0.0145983775519441795 19 93.870746) 1.4983761L 93871 -1. @ ppertacze...

20 |0.53097RR007320597 0.0166007 25034573145 19 93.09768 1.6E0073|L95.098 1.

4w [piy dava |41

JRxsujv[}gc-j Agtokszta}tyv\\lzlo4|&'£'&'f ERg.

Gotowy [ | S

Rysunek 6.2.5 Arkusz kalkulacyjny — przygotow anie wyrazenia SVG

Teraz przetgcz sie do Inkscape, i: narysuj w nim dowolng linie prostg. Nastepnie przetgcz sie na tryb selekcji i

otwérz okno edytora XML (Edit>XML Editor...)

File Edit Yiew Layer Object Path Text Effects ‘Whiteboard Help

DBEE& BE | Beed QA TUaE SH BPTEHEI®B

& g 5= =57 ¢ |14.545 |C ¥ |36.084 |$ W |83.395 |$ @ H|D.SDD |C pi ﬂ Affect: 1 »
— [ |n. | IR B |2:J 1 [P 1 |:J:|. | P R R |:I:J. [/ I I B |II)E| | P B e |I2:J | P N T |Q
R a
]

iy

E

1
-le

@ E &

elementu (linii prostej)

Atrybuty pod$wietlonego

= <sygisvg id="svgz">

> <svgidefs id="defs4">
= <sodipodi:namedview id="base" >
[» <svgimetadata id="metadata?"=

SASSORIOX JIMPe)

= <svgigid="layerl"> Atrybut d linii to
— <svgipath id="path3207" > polecenia ry sowania
: odcinkow.

;shroke-width:0.5; stroke-lineca

Tu zawsze jest

pods$wietlony element
aktualnie wybrany na

-
=

d

M 14.79455,3.66559 L 97.659521,3.66559

Attribute d selected, Press Cerl+Enter when done editing to commit changes,

Tu mozna zmieni¢
zawarto$¢ atrybutu d

Rysunek 6.2.6 Linia narysunku i jej definicja w edytorze XML (SVG)
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Wklej zawartos¢ schowka (kopie obszaru SVG z arkusza airfoil.xls — por. Rysunek 6.2.5) jako nowg wartos¢
atrybutu d'(Rysunek 6.2.7):

" Profil2.svg: XML Editor, (Shift+Ctrl+-X)

SR -

W svgisvgid="svg2"> Attribute | Value
[+ <svgidefs id="defs4">
<sadipodiinamedview id="base" >
[» =svg:metadata id="metadata?">
=~ =svgigid="laverl"=

id path6303
style opacity: 1;fill:none;fil-opacity: 1;stroke;: #000000; stroke-width: 0,5 stroke-lineca

Tu wklej tekst z arku-

/_ sza airfoil. xIs... >
4/
4
M 99,983,-0, 163 —
L 99.910,-0.180 .. a potem nacisnij =
L 99.783,-0.207 ten przy cisk!

L 99.617,-0.246
| 0o =08 N Pas

Attribute d selected, Press Cerl+Enter when done editing to commit changes.

Rysunek 6.2.7 Wartos ¢ atrybutu d (wierzcholki linii) przeniesiona z arkusza airfoil.xls

Gdy nacisniesz przycisk Set, wprowadzisz nowe warto$ci do dokumentu Inkscape (Rysunek 6.2.8):

w1005263 @ H : px ZI affect: =1 »
PR P |I-l..|.l | IR R R B |I2:J | IR I P N | Q
-

T | £ 77\
) Prosta linia zmienita

sig w gotowy profil!

l."rul

FL

—
M
(NI =
- [ g =
_] = aewgisvg id="svg2" >
@ o [+ =svgidefs id="defs4"=
= <sodipodi:namedview id="base" = i
<syg:metadata id="metadata?"> ! pa
‘2@ - g, e:svg:g id="layer1"> skyle opacity: 1;fill:none;fil-opacity: 1; stroke: #000000; stroke-width: 0.5; strake-lineca
Eg’ | ‘path3z07" =
®:
AI ] >
i ’ =)
E\.ﬁ 1 M 99,953,-0,163 L 99.91,-0,15 L 99,755,-0,207 L 99.617,-0,246 L 99.395,-0,295 L 9
= 9,13,-0.356 L 958.514,-0,426 L 35.45,-0.505 L 98.033,-0,599 L 97.581,-0.7 L 97.076,-
e 0.511 L 96.525,-0,931 L 95.929,-1.06 L 95.257,-1.195 L 94.601,-1.344 L 93.571,-1.4
/ < 95 L 93.095,-1.66 L 92,282,-1.629 L 91,425,-2,005 L 90.527,-2,187 L §9,59,-2.374 L
F” - a8 A1 2 BEAR L AT BOA 2 FAAL A Edi 7 0RO AC dAB8 2 177 1 Ad 30 T T8 S
ill:
stroke: [ Attribute d selected, Press Ctrel+Enter when done editing to commit changes.

Rysunek 6.2.8 Uzyskany w Inkscape profil NACA 2215

! Inkscape zapisuje dokumenty w standardzie SV G (Scalable Vector Graphics). S to w istocie pliki tekstow e, przypominajgce troche spo-
sobem zapisu strony HTML. Mozesz je naw et otw orzy¢ w zw yklym Notatniku (notepad.exe) i cos w nich zmieni¢ — pod w arunkiem, ze
wiesz, co robisz. Do tego takze stuzy okno XML Editor. Za jego pomocg mozesz zmienia¢ w Inkscape "surow g" zaw artos¢ aktualnego
dokumentu. Jest to o tyle prostsze od uzycia notatnika, ze przed zapisem jest spraw dzana popraw nos¢ danych.
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W ten sposdb nasza linia nagle zmienita sie w gotowy rysunek profilu NACA 2215! P ozostaje teraz tylko zmieni¢
jego skale i przesung¢ w odpowiednie miejsce rysunku.

Na koniec warto wspomnie¢ o odmianie profili NACA, z koncéwkg "T". Sg to wersje o zmniejszonym promieniu
noska. Profile "T" majg o 75% zmniejszony promieh noska w stosunku do promienia uzytego w serii NACA 00xx
(bez koncowej litery). Odpowiednio do tego jest takze zmodyfikowany cata ksztalt przedniej sekcji - na "ostrzej-
szg". "T" w zamysle twdércéw mogto to znaczy¢ tyle, co angielskie "thinner", czyli "cienszy" (albo, réwnie dobrze,
"tapered"). Przyktadem profilu "T" jest NACA 0018T (Rysunek 6.2.9):

:

Rysunek 6.2.9 Profil NACA 0018T ("T" oznacza zmieniony przéd — zmniejszony promien noska)

Nigdzie nie znalaztem opisu, jaki przekrdj miato usterzenie P-40. Przymierzatem do rysunkéw fabrycznych (np.
owiewki usterzenia) wiele profili. Ostatecznie doszedtem do wniosku, ze byfa to wtasnie rodzina NACA 00xxT.
W P-40 wykorzystano "ciensze" wersje profilu, jaki pokazuje Rysunek 6.2.9:

- usterzenie pionowe, u nasady: NACA 0008T:;

- usterzenie poziome, u nasady: NACA 0010T;

- usterzenie poziome, u konca: NACA 0009T.

Tabela 6.2.2 okresla wspotrzedne obrysu profilu NACA 0018 T dla pietnastu punktow. Wykorzystatem je do wy-
znaczenia obrysu profilu. Aby uzyskac¢ z tych wspéitrzednych cienszg wersje, wystarczy przeskalowac je w kie-
runku pionowym. Na przykfad, po "scisnieciu” NACA 0018T o 50% uzyskamy NACA 0009T, wykorzystywany w
koncowce usterzenia poziomego.

X 0] 1.25| 25 5 75 10 20 30 40 50 60 70 80 90| 100
Yg| 0.00| 1.87| 2.83] 4.28| 5.41| 6.32| 8.46| 9.00| 8.62| 7.67| 6.44| 5.09] 3.65| 2.05| 0.00

Yd| 0.00| -1.87( -2.83| -4.28| -5.41| -6.32( -8.46| -9.00| -8.62( -7.67( -6.44| -5.09| -3.65( -2.05[ 0.00

Tabela 6.2.2 Wspotrzedne profilu NACA 0018T (ciensze wersje profilu sg uzywane w usterzeniach).
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Skorowidz

e Nazwy polecen, skréty klawiatury, podane w skorowidzu, dotyczg Blendera, o ile w hasle nie jest zazna-

czone inaczej: ,(GIMP)’, ,(Inkscape)

Add Layer

polecenie z menu Layer (Inkscape), 103
Add Tab

polecenie z menu przybornika (GIMP), 56
Alpha to Selection

polecenie z menu Layer (GIMP), 42, 81
Anchor Layer

polecenie z menu Layer (GIMP), 83, 84, 86, 88

B

barwa
linii (Inkscape), 109
blokowanie
zmian na warstwie (Inkscape), 102
bledny
ksztalt chlodnicy, 142
ksztalt kadluba, 133, 142
ksztalt kolpaka ($migta), 142
ksztalt ptata, 145
Brushes
zakladka (GIMP), 77
zakladka formy narzedzia (GIMP), 75

C

Canvas size

polecenie z menu Image (GIMP), 67
Change Foreground Color

okno edycji aktualnej barwy (GIMP), 75
chlodnica

blgdny ksztalt, 142
cieciwa

profilu lotniczego, 154, 155
Clark Y

profil (lotniczy), 154
Compression level

opcja eksportu obrazu PNG (GMP), 62
Crop to Selection

polecenie z menu Tools (GIMP), 63

Ctrl-H (GIMP), Patrz Anchor Layer, Patrz Anchor

Layer
Ctrl-Z (GIMP), Patrz Undo

Wirtualne modelarstwo — wydanie trzecie

Default

opcjaz menu View (Inkscape), 92
deformacja

zdje¢ (poprawianie), 134
Delete Current Layer

polecenie z menu Layer (Inkscape), 104
Delete Layer

polecenie z menu Layer (GIMP), 74
Document Properties

okno (Inkscape), 98
dodawanie

nowej warstwy (GIMP), 73

nowej warstwy (Inkscape), 103

zakladki w przyborniku GIMP, 56

E

edycja

elipsy (Inkscape), 120

linii (Inkscape), 111

linii krzywych (Inkscape), 112

prostokata (Inkscape), 118

punktow (tryb) (Inkscape), 111, 112
eksport

rysunku do pliku rastrowego (Inkscape), 100
elipsa

edycja (Inkscape), 120

rysowanie (Inkscape), 119
Eraser

polecenie z menu Tools (GIMP), 24, 77, 81
Export As

polecenie z menu File (GIMP), 61
Export Bitmap

polecenie z menu File (Inkscape), 100
Export Image

okno (GIMP), 61

F

F (GIMP), Patrz Free select

fill
wypehienie obrysu (Inkscape), 109

Fill and Stroke
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panel (Inkscape), 109
Flatten Image
polecenie z menu Image (GIMP), 62
Flip Horizontally
polecenie z menu Image (GIMP), 33
polecenie z menu Layer (GIMP), 28
Float
polecenie z menu Select (GIMP), 83, 84, 85, 87
Free Select
polecenie z menu Tools (GIMP), 32, 79

G

gabarytowy
rysunek (P-40B/C), 37
geometria
profilu lotniczego, 154
GIMP
scalenie okien programu, 53
zmiana j¢zyka programu, 52
gladki
wezet (Inkscape), 113
glowne
okno (GIMP), 55
okno (Inkscape), 96
Gotingen
profile (lotnicze), 155
Grayscale
polecenie z menu Image (GIMP), 71
grubos¢
linii (Inkscape), 109
grupa warstw
przyktad zastosowania (GIMP), 70
tworzenie (GIMP), 69
guides
linie (Inkscape), 106
linie pomocnicze (GIMP), Patrz linie,pomocnicze
linie pomocnicze (Inkscape), 106
gumka
narzedzie w GIMP, 24, 77, 81

Import

polecenie z menu File (Inkscape), 99, 127
Inkscape

wersja 64-bitowa, 19, 20, 93

zmiana barw okien programu, 93

zmiana jezyka programu, 91

zmiana ukfadu paskéw narzedzi, 92

Jackiewicz, Jacek
nazwy rysunkow, 24
pochodzenie rysunkow, 21
poréwnanie rysunkow, 47
Jezyk
przetaczanie (GIMP), 52
przetaczanie (Inkscape), 91

K

kadtub

bledny ksztalt, 133, 142
kadrowanie

obrazu, 63
kolejnos¢

zmiana dla obiektow (Inkscape), 105
kolor

zmiana aktualnego (GIMP), 75

zmiana trybu (GIMP), 71, 75, 80
kolory

wlaczenie (GIMP), 71, 75, 80
kolpak $migla

bledny ksztalt, 142
kontrolka

do ustalania zakresu (GIMP), 59
kreskowanie

linii (Inkscape), 109
krzywa

odwzorowanie luku (Inkscape), 115

styczne do (Inkscape), 112, 113

L

Layer to Image Size
polecenie z menu Layer (GIMP), 67
Layers
polecenie z menu Layer (Inkscape), 102
zakladka (GIMP), 68
zakladka okna glownego (GIMP), 41, 71
zakladka sterowania warstwami (GIMP), 56
Lens Distortion
filtr obrazu (GIMP), 138
linia
edycja wierzchotkow (Inkscape), 132
linie
barwa (Inkscape), 109
dodawanie wezta (Inkscape), 114
edycja (Inkscape), 111, 112

grubo$¢ — zmiana (Inkscape), 109
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kreskowane (Inkscape), 109
krzywe (Inkscape), 112
obrys (‘stroke’ - Inkscape), 109
obrysy zamkniete (Inkscape), 108
pomocnicze (GIMP), 23, 64
pomocnicze (Inkscape), 106
proste (GIMP), 76
proste (Inkscape), 108, 111
rysowanie prostych (Inkscape), 108
styczne do krzywej (Inkscape), 112, 113
usuwanie we¢zta (Inkscape), 114
zamykanie obrysu (Inkscape), 108
Lock Tab to Dock
opcja z menu paneli (GIMP), 57
Lower to Bottom
polecenie z menu Object (Inkscape), 105
LZw
metoda kompresji obrazu TIFF (GIMP), 62

L

uk
odwzorowanie krzywa (Inkscape), 115
rysowanie (Inkscape), 120
Fukasik, Mariusz
nazwy rysunkow, 24
pochodzenie rysunkow, 21

poréwnanie rysunkow, 47

M

menu
przybormnika (GIMP), 56
Tools (GIMP), 59
Move
polecenie z menu Tools (GIMP), 84

N

NACA
profile lotnicze, 155
NACA 2215
profil (lotniczy), 155
narzgdzia
pedzel (GIMP), 75
wybor ksztaltu (GIMP), 77
wybor rozmiaru (GIMP), 77
zakltadka opcji (GIMP), 77
nazwa
zmiana dla warstwy (GIMP), 69
zmiana dla warstwy (Inkscape), 102

nazwy

Wirtualne modelarstwo — wydanie trzecie

plikow rysunkow, 24
New Layer

polecenie z menu Layer (GIMP), 73, 80
New Layer Group

polecenie z menu Layer (GIMP), 69
New View

polecenie z menu View (GIMP), 58
None

polecenie z menu Select (GIMP), 78, 79
nowe

warstwa (GIMP), 80

obiekt
kolejno$¢ wewnatrz warstwy (Inkscape), 105
polozenie i rozmiar w Inkscape, 107
przesunigcie (Inkscape), 121
przesun na spod (Inkscape), 105
przesun na wierzch (Inkscape), 105
ramka selekeji (Inkscape), 122
wylaczenie wypemienia (Inkscape), 110
wypehienie — zmiana (Inkscape), 110
zmiana kolejno$ci (Inkscape), 105
zmiana przekoszenia (Inkscape), 124
zmiana skali (Inkscape), 123

obraz
domy$Ine parametry eksportu (GIMP), 62
eksport do pliku (Inkscape), 100
JPEG poziom kompresji (GIMP), 62
kadrowanie, 63
obrot (GIMP), 83
obréto 90° (GIMP), 34
otworz (rastrowy w Inkscape), 99
otworz jako warstwe (GIMP), 28, 39, 71
PNG poziom kompresji (GIMP), 62
pomocnicze kontrolki (GIMP), 58
przekoszenie (GIMP), 30, 85
przesunigcie (GIMP), 84
rastrowy w Inkscape, 127
skalowanie (GIMP), 87
TIFF, metoda kompresji (GIMP), 62
usuniecie przejrzystych obszaréw (GIMP), 62
usuwanie cz¢$ci (GIMP), 24, 77, 81
wiele r6znych widokéw (GIMP), 58
zmiana rozmiaru (GIMP), 67
zmiana rozmiaru (Inkscape), 98

obrét
dopasowanie obszaru obrazu (GIMP), 82
niepozadane obcinanie obrazu (GIMP), 82
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obiektu (Inkscape), 128
obrazu (GIMP), 83
obrazu o 90° (GIMP), 34
o$ (GIMP), 83

0§ (Inkscape), 122
prostowanie rysunku, 26

obrys

profilu lotniczego, 154
okna

scalenie (GIMP), 53
okno

dla wielu obrazow (GIMP), 58
glowne (GIMP), 55
gtowne (Inkscape), 96
obszar obrazu (GIMP), 58
Set Image Canvas Size (GIMP), 67
zapisywania obrazu (GIMP), 61
zarzadzanie (GIMP), 57
okrag
rysowanie (Inkscape), 119
Opacity
kontrolka z panelu Layers (Inkscape), 102
kontrolka z zaktadki Layers (GIMP), 68
nieprzejrzystos¢ (GIMP), 71
opcje podgladu transformacji (GIMP), 85, 87
Open
polecenie z menu File (GIMP), 60
polecenie z menu File (Inkscape), 97
Open as Layers
polecenie z menu File (GIMP), 28, 39, 71
ostry
wezet (Inkscape), 113
o$
obrotu (GIMP), 83
obrotu (Inksacpe), 122
przekoszenia (Inksacpe), 122
otwarcie
obrazu w GIMP, 60
obrazu w Inkscape, 97
Overwrite
polecenie z menu File (GIMP), 61

P

P (GIMP), Patrz Paintbrush
Paintbrush

polecenie z menu Tools (GIMP), 75
paleta

narzedzi (GIMP), 56

panele dialogowe

blokowanie przesunig¢ (GIMP), 57

zarzadzanie (GIMP), 57
paski narzedzi

zmiana ukladu (Inkscape), 92
pedzel

narzedzie (GIMP), 75
plany

unifikacja rozmiaréw, 46
pliki

nazwy rysunkow, 24
plat

blgdny ksztalt, 145

sprawdzanie prostopadto$ci, 35
polozenie

okreslanie dla obiektu Inkscape, 107
pomiar

proporcji rysunku, 38
pomocnicze

linie (GIMP), 23, 64

linie (Inkscape), 106
poréwnanie

rysunkow,nawzajem, 28
powickszanie

widoku (GIMP), 65

widoku (Inkscape), 101
pozostatosci

po transformacji (GIMP), 31
Preferences

okno opcji (GIMP), 52

okno opcji (Inkscape), 91
profil (lotniczy)

cieciwa, 154

Clark Y, 154

geometria, 154

Gotingen (Uniwersytet), 155

NACA, 155

NACA 2215, 155

obrys gory i dolny, 154

rysowanie, 156

szkieletowa, 154
prostokat

edycja (Inkscape), 118

rysowanie (Inkscape), 117

zaokraglenia naroznikéw (Inkscape), 118
prostopadtos$¢

sprawdzanie dla plata, 35
prostowanie

zdjecia, 139, 140, 141

przejrzystosé
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warstw (GIMP), 71
zmiana dla warstwy (GIMP), 68
zmiana dla warstwy (Inkscape), 102
przekoszenie
obiektu (Inksacpe), 124
obrazu (GIMP), 30, 85
0§ (Inkscape), 122
przeliczanie
wymiar6w samolotu, 38
przerzucenie
W poziomie, 28, 33
przesunigcie
obiektu (Inkscape), 121
obrazu (GIMP), 84
osiobrotu (GIMP), 83
osiobrotu (Inkscape), 122
osiprzekoszenia (Inkscape), 122
widoku (GIMP), 65
widoku (Inkscape), 101
przybornik
blokowanie przesuni¢¢ paneli (GIMP), 57
ikon narz¢dzi (GIMP), 55
ikon narzedzi (Inkscape), 96
menu (GIMP), 56
okno (GIMP), 56
punktow
tryb edycji (Inkscape), 111, 112

Q

Quality
parametr eksportu obrazu JPEG (GMP), 62

R

R (GIMP), Patrz Rectangle select, Patrz Rectangle select
Raise to Top

polecenie z menu Object (Inkscape), 105
ramka

selekeji (Inkscape), 122
Rectangle Select

polecenie z menu Tools (GIMP), 63, 78
Reverse Layer Order

polecenie z menu Layer (GIMP), 41
RGB

polecenie z menu Image (GIMP), 71, 75, 80
Rotate

linie pomocnicze (GIMP), 82

opcje narzedzia (GIMP), 82

polecenie z menu Tools (GIMP), 83
Rotate 90°

Wirtualne modelarstwo — wydanie trzecie

polecenie z menu Image (GIMP), 34

Rotate 90°CW

polecenie z menu Object (Inkscape), 128

rozmiar

okreslanie dla obiektu Inkscape, 107

zmiana dla obrazu (GIMP), 67

zmiana dla rysunku (Inkscape), 98
zmiana dla warstawy (GIMP), 67

rysowanie
elipsy (Inkscape), 119
krzywych (Inkscape), 115
linii (GIMP), 76
linii (Inkscape), 108
luku (Inkscape), 120

obrysow zamknigtych (Inkscape), 108

obszaru wyboru (GIMP), 80
okregu (Inkscape), 119
profilu lotniczego, 156
prostokata (Inkscape), 117
prostych (GIMP), 76
selekeji (GIMP), 81
rysunek
gabarytowy (P-40B/C), 37
prostowanie (obrot), 26
sprawdzanie, 23, 24
techniczny (tradycyjny), 24

wygigcie podczas skanowania, 28

rysunki
do przygotowania, 46

Jacek Jackiewicz (poréwnanie), 47
Mariusz Lukasik (porownanie), 47

poréwnanie,nawzajem, 28

S

Save As

polecenie z menu File (GIMP),

Save Defaults

61

przycisk z okna eksportu obrazu (GMP), 62

Scale
linie pomocnicze (GIMP), 87
opcje narzgdzia (GIMP), 87

polecenie z menu Tools (GIMP), 87

schemat barw
przetaczanie (Inkscape), 93
selekcji
ramka (Inkscape), 122
Set Image Canvas Size
okno (GIMP), 67
Shear
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linie pomocnicze (GIMP), 85

opcje narzgdzia (GIMP), 85

polecenie z menu Tools (GIMP), 30, 85
Shift-Ctrl-M (Inkscape), Patrz Transform
Shift-E (GIMP), Patrz Eraser
Shift-R (GIMP), Patrz Rotate
Shift-S (GIMP), Patrz Shear
Shift-T (GIMP), Patrz Scale
Show preview image

opcje narzgdzia (GIMP), 85, 87
Show preview in image window

opcja eksportu obrazu JPEG (GMP), 62
Single-Window Mode

opcja menu Windows (GIMP), 59

opcja z menu Windows (GIMP), 53
skalowanie

obiektu (Inksacpe), 123

obrazu (GIMP), 87

srodek (GIMP), 42
skanowanie

wygigcie rysunku, 28
sprawdzanie

rysunku, 23, 24
stroke

linia obrysu (Inkscape), 109
styczne

do krzywej (Inkscape), 112, 113
symetryczny

wezet (Inkscape), 112
szarosci

odcienie (GIMP), 71
szkieletowa

profilu lotniczego, 154

$rodek
skalowania (GIMP), 42

tekstura

optymalne wymiary obrazu, 100
Tools

menu (GIMP), 59
tradycyjny

rysunek (techniczny), 24

Transform

polecenie z menu Object (Inkscape), 123, 124

trans formacja
pozostatosci(GIMP), 31

zatwierdzenie (GIMP), 83, 84, 86, 88
trans formacje
podglad rezultatu (GIMP), 85, 87

U

ukrywanie

zawarto$ci warstwy (GIMP), 69

zawarto$ci warstwy (Inkscape), 102
Undo

polecenie z menu Edit (GIMP), 76, 77
unifikacja

rozmiardw plandw, 46
usuwanie

warstwy (GIMP), 74

warstwy (Inkscape), 104

z obrazu w GIMP, 24, 77, 81

W

warstwa

a kolejnos¢ obiektow (Inkscape), 105

blokowanie (Inkscape), 102

dodanie (GIMP), 80

laczenie w grupe (GIMP), 69

nowa (GIMP), 73

nowa (Inkscape), 103

osadzenie wyboru (GIMP), 83, 84, 86, 88

otworz obraz w nowej (GIMP), 28, 39, 71

przejrzystos¢ (GIMP), 71

ukrywanie (GIMP), 69

ukrywanie (Inkscape), 102

usuwanie (GIMP), 74

usuwanie (Inkscape), 104

zarzadzanie (GIMP), 41, 68, 71

zarzadzanie (Inkscape), 102

zastosowanie grup (GIMP), 70

zmiana nazwy (GIMP), 69

zmiana nazwy (Inkscape), 102

zmiana przejrzysto$ci (GIMP), 68

zmiana przejrzystosci (Inkscape), 102

zmiana rozmiaru (GIMP), 67

zmien kolejno$§¢ (GIMP), 41
wczytanie

obrazu rastrowego (Inkscape), 99
wezet

dodawanie (Inkscape), 114

gladki (Inkscape), 113

ostry (Inkscape), 113

symetryczny (Inkscape), 112

usuwanie (Inkscape), 114
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widok
powigkszanie (GIMP), 65
powigkszanie (Inkscape), 101
przesuwanie (GIMP), 65
przesuwanie (Inkscape), 101
wierzcholek, Patrz wezet (w Inkscape)
wierzchotki
edycja (Inkscape), 132
wybor

narysowanym obszarem (GIMP), 42, 81

obszarem dowolnym (GIMP), 32, 79

obszarem prostokatnym (GIMP), 63, 78
osadzenie w warstwie (GIMP), 83, 84, 86, 88

rysowanie obszaru (GIMP), 80
uzycie uchwytéow obszaru (GIMP), 43
wylaczenie (GIMP), 78, 79
wycofywanie
zmian (GIMP), 76, 77
wylaczenie
wypehienia (Inkscape), 110
wymiary
samolotu — przeliczanie (GIMP), 38
tekstury, 100
wypehienie
obiektu (Inkscape), 109, 110
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zaokraglenie
naroznikéw prostokata (Inkscape), 118
zapisywanie
obrazu (GIMP), 61
zarzadzanie

warstwami (GIMP), 41, 68, 71
warstwami (Inkscape), 102
zatwierdzenie
transformacji (GIMP), 83, 84, 86, 88
zdjecia
deformacja (poprawianie), 134
efekty uboczne prostowania, 141
problemy z analiza, 144
prostowanie deformacji, 138, 139, 140
uzycie po wyprostowaniu, 141
znieksztalcenie, 136
zmiana
przekoszenia obiektu (Inkscape), 124
skali obiektu (Inkscape), 123
zmiany
wycofywanie, 76, 77
znieksztalcenie
zdjecia, 136

www.samoloty3d.pl
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Stownik

GPL, licencja — General Public Licence, udostepniajgca produkt za darmo wszystkim odbiorcom. Licencja ta
jest sformutowana w ten sposdb, aby uniemozliwi¢ komercyjne rozpowszechnianie produktu.

rastrowy, obraz — popularna metoda reprezentacji, polegajgca na zapisie obrazu jako zbioru kolorowych lub
czarno-biatych punktéw (pikseli). Tak jest np. wyswietlany obraz na ekran telewizyjnym, monitorze komputera.
Wadg reprezentacji rastrowej jest pogorszenie jakosci obrazu w duzych powiekszeniach — gdy zaczynajg byc¢
wyraznie widoczne pojedyncze piksele. Zaletg jest stosunkowo prosty algorytm wyswietlania zawartosci. Istnieje
wiele réznorodnych sposobow zapisu (formatéw) przechowywania obrazéw rastrowych w plikach. Najpopular-
niejsze to *jpg, *.png, *.bmp, *tif.

shear (ang.) — przekoszenie (okre$lane takze jako "Scinanie"). Transformacja obrazu w GIMP. Przeksztatca
ksztalt prostokata w ragb (przeciwlegte boki zachowujg rownolegtosc).

wektorowy, obraz — metoda reprezentacji, polegajgca na zapisie obrazu jako zbioru kolorowych linii i obsza-
row. Kazdy element obrazu ma okres$lone wspoétrzedne i ksztatt (prosta, tuk, koto, krzywa Beziera, ...). W ten
sposOb sg zapisywane stworzone na komputerze rysunki techniczne. Zaletg reprezentacji wektorowej jest z a-
chowanie doktadnosci przy dowolnym powiekszeniu. Wadg jest ztozony algorytm wyswietlania (gdyz oznacza
przeksztatcenie na posta¢ rastrowg). Jednym ze sposobdéw zapisu danych wektorowych jest format *.svg, sto-
sowany m.in. przez Inkscape.

wireframe (pol.: siatka?) — oznacza sposéb reprezentacji modelu w ktérym nie rysowane sg zadne s$ciany,
tylko krawedzie tgczgce poszczegdlne wierzchotki. Jest ich zazwyczaj duzo i sg cienkimi liniami. Stad obrazowo
w literaturze anglojezycznej taka reprezentacja jest nazywana "druciang siatkg" czyli "wireframe".

© Witold Jaworski, 2009 - 2015.
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W XX wieku mozna byto robi¢ miniatury samolotéw z
kartonu i z plastiku. Na poczgtku wieku XXI przyszedt

czas na jeszcze jedng odmiane tego hobby: modele

komputerow e. Ta nowa gatgz modelarstw a redukcyjnego
rodzita sie ,po cichutku”. Mato kto kikanascie lat temu
mogt wyda¢ (prywatnie!) pare tysiecy dolaréw na

odpow iedni program. A tymi ,nieodpow iednimi” nie bylo

sie co chwali¢... Nieliczni zapalency siedzieli wigc przy

monitorach i tworzyli pierwsze modele, uczgc sie na
wfasnych btedach.

Teraz to sie =zaczyna zmienia¢, bo niezbedne

oprogramow anie jest dostepne za darmo (na licencii
Open Source). Jezeli wigc Tw 6] komputer ma mnigj niz 6
lat, to masz juz wszystko czego potrzeba, by zaczaé! Ta

ksigzka dostarcza niezbednego know how. Pokazuje

krok po kroku, jak zrobi¢ takie modele, jak na ilustracjach

obok. |, podobnie jak oprogramow anie kitére opisuje,

takze jest bezpfatnal

,Wirtualne modelarstw o”

jest kierowane nie tylko do
modelarzy. Moze zainteresow a¢ w szystkich tych, ktorzy

chca sie pozna¢ takie ogolnodostepne programy, jak
Blender, GIMP, czy Inkscape.
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